MAPublisher® 5.0

A Suite of Cartographic and Geographic Information System Xtras for Macromedia® Freehand® 10 and MX

User Guide
MAPublisher® 5.0
for Macromedia® FreeHand®

User Guide
WELCOME

Avenza welcomes you to mapmaking in the 21st century!

Combined with Macromedia FreeHand, MAPublisher has revolutionized the art of mapmaking by allowing spatial data files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to be performed where they should be done, in a powerful graphics environment.

MAPublisher 5.0 improves on the already powerful tools of previous versions by adding additional file support, additional tools and improvements to existing tools.

This manual assumes that the user is familiar with Macromedia FreeHand 10 or MX and has at least a basic understanding of geographic information systems (GIS) terminology and concepts. Please refer to your Macromedia FreeHand user guide for more information on using Macromedia FreeHand. A glossary of GIS terms is included at the back of this manual.

By following this manual you will learn how to create maps using the MAPublisher Xtras in Macromedia FreeHand. This manual covers the basic steps necessary to build a map and perform fundamental cartographic and GIS tasks. We have designed this guide to read like a tutorial so for best results, follow the examples step-by-step to begin with. A variety of GIS data has been provided on your MAPublisher 5.0 CD for use with this guide (see Appendix 3) however we encourage you to experiment with your own data to gain additional experience with MAPublisher 5.0’s tools and functions. Combined with a basic understanding of Macromedia FreeHand, MAPublisher becomes a totally integrated cartographic design software system with graphics tools and geographic functions present in the same work environment.

So join first class mapping organizations from around the world and experience modern day map-making by reading this user guide, going through the tutorials and experimenting with MAPublisher 5.0.
# CONTENTS

WELCOME .................................................................................................................. iv
CONTENTS .................................................................................................................. v

## GETTING STARTED

**SYSTEM REQUIREMENTS** ................................................................. 9
**INSTALLATION INSTRUCTIONS** ................................................. 10
- Macintosh ........................................................................................................ 10
- Windows .......................................................................................................... 11

**PREPARING YOUR WORKSPACE** .................................................. 12
- Setting up your Macromedia FreeHand Document ....................................... 12

**THE XTRAS** ......................................................................................... 13

**MAP DATA FILE FORMATS** .......................................................... 15
- ArcInfo Ungenerate and Export .................................................................. 15
- Arcview Shapefile ......................................................................................... 16
- AutoCAD .dxr .................................................................................................. 16
- MapInfo Interchange Format ........................................................................ 16
- MicroStation DGN Format ............................................................................. 17
- USGS Formats .............................................................................................. 17

**ADDITIONAL MAPUBLISHER CONSIDERATIONS** .................. 18
- Importing ...................................................................................................... 18
- Exporting ..................................................................................................... 18
- Macromedia FreeHand Compatibility ......................................................... 19
- Data Considerations .................................................................................... 19

## IMPORTING MAP DATA

**IMPORT MAP** ...................................................................................... 20
- The MAPublisher Import Map Dialog ............................................................ 20
- Importing a Single Map File (Basic Import) .................................................... 21
- Importing Multiple Map Files at Once ......................................................... 22
- Setting the FreeHand Layer Name for Imported Files .............................. 23
- Importing Map Files to Match an Existing Map Layer ............................ 24
- Importing Files to an Existing Layer ............................................................. 25
- Importing Map Files with a Grain ................................................................ 26

**IMPORTING POINTS** ........................................................................... 27
- Importing a Delimited ASCII File as Point Data ......................................... 28
- Creating a Delimited ASCII Point File ......................................................... 29

**POINT PLOTTER** .................................................................................... 30
- Plotting a Point Using the MAPublisher Point Plotter .................................. 31
- Converting Between Degrees, Minutes, Seconds and Decimal Degrees .... 32

**REPOSITIONING POINT SYMBOLS** .................................................. 33

## MAP LOCATION TOOL ........................................................................... 34

## MAP ATTRIBUTES .................................................................................. 35

**MAP ATTRIBUTES WINDOW** ............................................................. 35
- Viewing and Editing Map Attributes ............................................................ 36

**MAP COLUMNS** ....................................................................................... 37
- Adding a New Column to a Map Attribute Table ........................................ 37
- Changing an Existing Column’s Properties ................................................... 38
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing a Column from a Map Attribute Table</td>
<td>38</td>
</tr>
<tr>
<td>EDIT MAP COLUMN</td>
<td>38</td>
</tr>
<tr>
<td>Editing the Values of a Map Column</td>
<td>39</td>
</tr>
<tr>
<td>SELECT BY ATTRIBUTE</td>
<td>40</td>
</tr>
<tr>
<td>Making an Initial Selection</td>
<td>41</td>
</tr>
<tr>
<td>Adding to/Removing from/Selecting from an Existing Selection</td>
<td>42</td>
</tr>
<tr>
<td><strong>WORKING WITH IMAGES</strong></td>
<td>43</td>
</tr>
<tr>
<td>REGISTER IMAGE</td>
<td>43</td>
</tr>
<tr>
<td>Registering an Image with a Reference File</td>
<td>44</td>
</tr>
<tr>
<td>Registering an Image without a Reference File</td>
<td>45</td>
</tr>
<tr>
<td>EXPORT IMAGE</td>
<td>46</td>
</tr>
<tr>
<td>Exporting a Placed Image as a Geo-Referenced Raster File</td>
<td>46</td>
</tr>
<tr>
<td>Converting a FreeHand Vector Layout to a Geo-Image</td>
<td>48</td>
</tr>
<tr>
<td><strong>PROJECTIONS &amp; TRANSFORMATIONS</strong></td>
<td>49</td>
</tr>
<tr>
<td>PROJECTION EDITOR</td>
<td>49</td>
</tr>
<tr>
<td>Projecting an Unprojected Map</td>
<td>50</td>
</tr>
<tr>
<td>Changing a Map’s Projection</td>
<td>51</td>
</tr>
<tr>
<td>Storing a Map’s Projection</td>
<td>52</td>
</tr>
<tr>
<td>Copying a Projection From One Layer to Another</td>
<td>53</td>
</tr>
<tr>
<td>SCALE CONVERSION</td>
<td>54</td>
</tr>
<tr>
<td>Calculating a Scale</td>
<td>54</td>
</tr>
<tr>
<td>TRANSFORM SCALE</td>
<td>55</td>
</tr>
<tr>
<td>Transforming a Map’s Scale</td>
<td>56</td>
</tr>
<tr>
<td><strong>MAP LEGENDS</strong></td>
<td>57</td>
</tr>
<tr>
<td>ASSIGN LEGEND INFO</td>
<td>57</td>
</tr>
<tr>
<td>Building a Legend Using Assign Legend Info</td>
<td>58</td>
</tr>
<tr>
<td>AUTO ASSIGN LEGEND INFO</td>
<td>59</td>
</tr>
<tr>
<td>Building a Legend Using Auto Assign Legend Info - Unique Occurrences</td>
<td>60</td>
</tr>
<tr>
<td>Building a Legend Using Auto Assign Legend Info - Value Range</td>
<td>61</td>
</tr>
<tr>
<td>POINT LEGENDS</td>
<td>63</td>
</tr>
<tr>
<td>Changing Point Symbols (Creating a Point Legend)</td>
<td>63</td>
</tr>
<tr>
<td>LEGEND MATCHING FEATURES</td>
<td>64</td>
</tr>
<tr>
<td>Selecting Features Based on Legend Attributes</td>
<td>64</td>
</tr>
<tr>
<td>NORTH ARROW</td>
<td>64</td>
</tr>
<tr>
<td>Adding a North Arrow</td>
<td>64</td>
</tr>
<tr>
<td>SCALE BAR</td>
<td>65</td>
</tr>
<tr>
<td>Creating a Scale Bar</td>
<td>66</td>
</tr>
<tr>
<td><strong>LABELING</strong></td>
<td>67</td>
</tr>
<tr>
<td>FEATURE TEXT LABEL</td>
<td>67</td>
</tr>
<tr>
<td>Adding Labels to a Map Using Feature Text Label</td>
<td>68</td>
</tr>
<tr>
<td>MAP TAGGER TOOL</td>
<td>69</td>
</tr>
<tr>
<td>Adding Labels to a Map Using the MAP Tagger Tool</td>
<td>69</td>
</tr>
<tr>
<td><strong>GRIDS &amp; INDEXES</strong></td>
<td>70</td>
</tr>
<tr>
<td>GRID GENERATOR</td>
<td>70</td>
</tr>
<tr>
<td>Creating Grids</td>
<td>71</td>
</tr>
<tr>
<td>MAKE INDEX</td>
<td>74</td>
</tr>
<tr>
<td>Creating an Index</td>
<td>75</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>MAP CREATION</td>
<td>77</td>
</tr>
<tr>
<td>ADD MAP PARAMETERS</td>
<td>77</td>
</tr>
<tr>
<td>Adding Geo-Referencing Information to an Ungeo-Referenced Map</td>
<td>77</td>
</tr>
<tr>
<td>ASSIGN AREA, LINE, POINT OR TEXT DEFAULTS</td>
<td>78</td>
</tr>
<tr>
<td>Assigning Area, Line, Point or Text Defaults</td>
<td>78</td>
</tr>
<tr>
<td>SELSTATS</td>
<td>79</td>
</tr>
<tr>
<td>Using the SelStats Window</td>
<td>79</td>
</tr>
<tr>
<td>ARC FUNCTIONS</td>
<td>80</td>
</tr>
<tr>
<td>JOIN ARCS</td>
<td>80</td>
</tr>
<tr>
<td>Joining Arcs</td>
<td>80</td>
</tr>
<tr>
<td>SIMPLIFY ARCS</td>
<td>81</td>
</tr>
<tr>
<td>Simplifying Arcs</td>
<td>82</td>
</tr>
<tr>
<td>WORKING WITH TABLES</td>
<td>83</td>
</tr>
<tr>
<td>IMPORT A TABLE</td>
<td>83</td>
</tr>
<tr>
<td>Importing a Table</td>
<td>84</td>
</tr>
<tr>
<td>CREATE A TABLE</td>
<td>85</td>
</tr>
<tr>
<td>DELETE A TABLE</td>
<td>85</td>
</tr>
<tr>
<td>JOIN A TABLE</td>
<td>86</td>
</tr>
<tr>
<td>Joining an External or Created Table to a Map Attribute Table</td>
<td>86</td>
</tr>
<tr>
<td>Joining SDTS Tables</td>
<td>87</td>
</tr>
<tr>
<td>TABLE RECORDS</td>
<td>88</td>
</tr>
<tr>
<td>Viewing, Editing &amp; Deleting Table Records</td>
<td>88</td>
</tr>
<tr>
<td>TABLE COLUMNS</td>
<td>89</td>
</tr>
<tr>
<td>Adding a New Column to an Imported or Created Table</td>
<td>89</td>
</tr>
<tr>
<td>Deleting/Editing a Column in an Imported or Created Table</td>
<td>89</td>
</tr>
<tr>
<td>SELECT TABLE RECORDS</td>
<td>90</td>
</tr>
<tr>
<td>Selecting Records From an Imported or Created Table</td>
<td>90</td>
</tr>
<tr>
<td>OTHER TOOLS</td>
<td>91</td>
</tr>
<tr>
<td>MAP AREA TOOLS</td>
<td>91</td>
</tr>
<tr>
<td>Using the MAP Area Tools</td>
<td>91</td>
</tr>
<tr>
<td>MAP COPY/PASTE</td>
<td>92</td>
</tr>
<tr>
<td>Using MAP Copy/Paste</td>
<td>92</td>
</tr>
<tr>
<td>EXPORTING</td>
<td>93</td>
</tr>
<tr>
<td>EXPORT AS SHAPEFILE, MID/MIF OR ARCINFO EXPORT FORMAT</td>
<td>93</td>
</tr>
<tr>
<td>APPENDICES</td>
<td>97</td>
</tr>
<tr>
<td>APPENDIX 1 - TECHNICAL REFERENCE GUIDE</td>
<td>A1-1</td>
</tr>
<tr>
<td>APPENDIX 2 - UNIVERSAL TRANSVERSE MERCATOR (UTM) ZONE MAP</td>
<td>A2-1</td>
</tr>
<tr>
<td>APPENDIX 3 - DATA LIST</td>
<td>A3-1</td>
</tr>
<tr>
<td>APPENDIX 4 - UTILITIES LIST</td>
<td>A4-1</td>
</tr>
<tr>
<td>APPENDIX 5 - ACKNOWLEDGEMENTS</td>
<td>A5-1</td>
</tr>
<tr>
<td>APPENDIX 6 - GLOSSARY</td>
<td>A6-1</td>
</tr>
<tr>
<td>INDEX</td>
<td>153</td>
</tr>
</tbody>
</table>
GETTING STARTED

Before installing and using MAPublisher 5.0 please read this section to ensure that you have a suitable hardware environment, become familiar with the installation procedure and adequately prepare your system and workspace to make maps with Macromedia FreeHand and MAPublisher 5.0.

SYSTEM REQUIREMENTS

Macintosh
Casual User
- Macromedia FreeHand 10.x or MX
- Mac OS 9.1, 9.2 or Mac OS X 10.1
- Any G3 Processor
- 256 MB RAM
- 30MB hard disk space
- 800x600 colour display
- CD-ROM drive

Power User
- Macromedia FreeHand 10.x or MX
- Mac OS 9.1, 9.2 or Mac OS X 10.2.6
- Any G4 Processor
- 512 MB RAM
- 60MB hard disk space
- 1280x1024 colour display
- CD-ROM drive

Windows
Casual User
- Macromedia FreeHand 10.x or MX
- Pentium II or equivalent processor
- 256 MB RAM
- 30MB hard disk space
- 800x600 colour display
- CD-ROM drive

Power User
- Macromedia FreeHand 10.x or MX
- Pentium III or equivalent processor
- 512 MB RAM
- 60MB hard disk space
- 1280x1024 colour display
- CD-ROM drive
INSTALLATION INSTRUCTIONS

Macintosh

1. Make sure that you have Macromedia FreeHand 10 or MX installed on your computer.

2. If Macromedia FreeHand is running, exit the program.

3. Remove any previous versions of MAPublisher from your Macromedia FreeHand Xtras folder. This can be accomplished by selecting the MAPublisher folder from the FreeHand Xtras folder on your hard drive and dragging it to the trash.

4. Insert your MAPublisher 5.0 CD into your CD-ROM drive. Double-click on the CD icon on your desktop. When the MAPublisher 5.0 window appears, double-click on the Install MAPublisher icon.

5. Click Continue at the MAPublisher 5.0 splash screen.

6. Read the Software License Agreement, then click Continue.

7. Select the Macromedia FreeHand Xtras folder as the installation destination. You will have to specify the exact location of your FreeHand Xtras folder as no default has been assigned.

8. Click the Install button and wait for the Xtras to be installed.

9. Launch Macromedia FreeHand. The MAPublisher Xtras will now appear under the “Xtras” menu.

10. Complete the installation by running the Enter Security Code Xtra (Xtras ➔ 1. MAPublisher ➔ Enter Security Code...) and entering your MAPublisher keycode. Your MAPublisher keycode can be found on the card in your MAPublisher 5.0 box or in the email receipt you received with your download if you have purchased an e-commerce version. When entering the security code please ensure that all letters are entered in uppercase and that the “-” is included.

Note: It is EXTREMELY important that you install MAPublisher into the Macromedia FreeHand 10 or MX Xtras folder. MAPublisher will fail to appear in the Xtras menu if it is installed anywhere else. Non US English versions of Macromedia FreeHand may have the Xtras folder located differently than the US English version. You will have to determine where the Xtras folder resides on your system in order to correctly install MAPublisher.

Note: In order to ensure that all your MAPublisher Xtras appear under the Xtras menu (FreeHand 10 only) make sure that you have enabled them using the FreeHand Xtras Manager. The Xtras Manager can be found at Xtras ➔ Xtras Manager in FreeHand 10.
Windows

1. Make sure that you have Macromedia FreeHand 10 or MX installed on your computer.

2. If Macromedia FreeHand is running, exit the program.

3. Remove any previous versions of MAPublisher from your Macromedia FreeHand Xtras folder. This can be accomplished using Windows Explorer by selecting the MAPublisher folder from the FreeHand Xtras folder and pressing the delete key or dragging it to the recycle bin. You may also run the Add/Remove Programs utility from the Control Panel to uninstall any previous versions of MAPublisher.

4. Insert your MAPublisher 5.0 CD into your CD-ROM drive. When the MAPublisher 5.0 window appears, double-click on the Setup.exe file in the MAPublisher50 directory to start the installation. (Note: If Autorun is disabled on your system, you will have to access your CD-ROM though Windows Explorer and run the Setup.exe file from there.)

5. Click **Next** at the first screen.

6. Read the Software License Agreement, then click **Yes**.

7. Read the installation instructions, then click **Next**.

8. Select the Macromedia FreeHand 10 or MX Xtras folder. The default install path is C:\Program Files\Macromedia\FreeHand MX\English\Xtras. If you have installed FreeHand in another location or are using FreeHand 10 you will have to specify the location of your Xtras folder.

9. Check that you have set the correct install path and click **Next**. Wait for the files to be copied.

10. Launch Macromedia FreeHand. The MAPublisher Xtras will now appear under the “Xtras” menu.

11. Complete the installation by running the Enter Security Code Xtra (Xtras ➔ 1. MAPublisher ➔ Enter Security Code...) and entering your MAPublisher keycode. Your MAPublisher key code can be found on the card in your MAPublisher 5.0 box or in the email receipt you received with your download if you have purchased an e-commerce version. **When entering the security code please ensure that all letters are entered in uppercase and that the “-” is included.**

**Note:** It is EXTREMELY important that you install MAPublisher into the Macromedia FreeHand 10 or MX Xtras folder. MAPublisher will fail to appear in the Xtras menu if it is installed anywhere else. Non US English versions of Macromedia FreeHand may have the Xtras folder located differently than the US English version. You will have to determine where the Xtras folder resides on your system in order to correctly install MAPublisher.

**Note:** In order to ensure that all your MAPublisher Xtras appear under the Xtras menu (FreeHand 10 only) make sure that you have enabled them using the FreeHand Xtras Manager. The Xtras Manager can be found at Xtras ➔ Xtras Manager in FreeHand 10.
PREPARING YOUR WORKSPACE

Before you can start using MAPublisher, you must first set up your Macromedia FreeHand document. It is at this point that you define your page size and units, set your print orientation and generally prepare your Macromedia FreeHand workspace.

Setting up your Macromedia FreeHand Document


   - The Macromedia FreeHand Document Inspector appears

3. Select the size to use for your page. Letter (8.5”x11”) is the default size. You may wish to change the orientation to landscape for some files. For example, a map of Chile may be best displayed in portrait but a map of Indonesia may be best displayed in landscape.

4. If you have changed the page orientation in the previous step, you should also select File ➔ Printer Setup and change the print settings to landscape as well.

5. Select your desired page units. The default unit type is points. It is recommended that you keep points as your page unit type while working through this manual as all the examples in it are done using points.

6. Set the page origin to 0,0. To do this, select View ➔ Page Rulers ➔ Show. Click the top left corner of the workspace where the vertical and horizontal rulers intersect and drag the cursor to the bottom left corner of the page.

7. Set the Fill and Stroke as desired.

For more information and details regarding these operations please refer to your Macromedia FreeHand user guide.

Note: In step 2 the default page size of 8.5” x 11” is for North American versions of Macromedia FreeHand. European and other foreign language versions of Macromedia FreeHand may have different default page sizes. Consult your Macromedia FreeHand user guide for more information.
THE XTRAS

MAPublisher installs as a suite of Xtras under the Macromedia FreeHand Xtras menu. The individual Xtras are grouped into 11 categories under the Xtras menu.

List of MAPublisher Xtra categories found under the Macromedia FreeHand Xtras menu.
MAPublisher’s four Xtras tools are located in the Macromedia FreeHand Xtras toolbar. To display the Xtras toolbar select Window ➔ Toolbars ➔ Xtras Tools.
MAP DATA FILE FORMATS

The key to making maps with MAPublisher is the GIS data file formats it supports. GIS files are precise geographic data files that contain vector information and associated data attribute values. MAPublisher's ability to import such files into Macromedia FreeHand while retaining both geographic vector and attribute information make it very easy to produce high quality maps.

MAPublisher 5.0 imports several of the industry leading vector file formats:

- ArcInfo™ Export (.e00)
- ArcInfo™ Ungenerate (.lin, .pnt, or .pol)
- ArcView® Shapefile (.shp + .dbf + .shx)
- AutoCAD® (.dxf)
- MapInfo™ (.mid + .mif)
- MicroStation DGN (.dgn)
- USGS DLG – Optional (.opt, .do)
- USGS DLG – SDTS (????LE##.ddf)

**ArcInfo™ Export and Ungenerate**

ArcInfo files are created by ESRI's ArcInfo product. MAPublisher will import files with the extensions .lin, .pnt, .pol and .e00. ArcInfo Export files (.e00) are sometimes compressed. Your MAPublisher 5.0 CD contains a special decompression utility, AvzDecompress (Mac) and e00decompress.exe (Windows) which must be run prior to importing such files via the MAPublisher Import Xtra. Both files can be found in the utilities folder on your MAPublisher 5.0 CD. Please see below for details on running the decompression utility. MAPublisher 5.0 supports many of the most common projections used in .e00 files as well as text rotations during import.

New to MAPublisher 5.0 is import support for .e00 files that contain a combination of areas, lines, points and text in the same .e00 file. Previously in MAPublisher, area features superceded lines and points in this type of .e00 file. MAPublisher 5.0 will now create a separate FreeHand layer for each feature type contained in a single imported .e00 file.

**e00 Decompression (Mac)**

Run the AvzDecompress program by double-clicking on the program icon. Click **Input File** and navigate to the compressed .e00 file you wish to expand. Click **Save As** and name the new decompressed .e00 file you wish to import using MAPublisher.

**e00 Decompression (Windows)**

Run the e00decompress.exe program by double-clicking the program icon. Select the compressed .e00 file by clicking on the “●●●” next to the empty “Input Filename” box and navigate to the file you wish to decompress. Next, click on the “●●●” next to the “Output Filename” box, navigate to the location where you wish to save the decompressed file, and enter a name for the decompressed file. Click the **Go** button to complete the operation.
**ArcView® Shapefile**

Shape files are most commonly created by ESRI’s ArcView product although other products, including MAPublisher 5.0 are capable of generating files in this format. Shapefiles exist as triplets where each file has the same name but ends in one of the extensions .shp, .shx or .dbf. All three files are required in order to successfully import a shapefile into Macromedia FreeHand using MAPublisher. **The important thing to remember when importing shapefiles is that the .shp file must be the one that is selected through the MAPublisher import Xtra and that all 3 files must be in the same folder.** MAPublisher will automatically locate and deal with the .dbf and .shx files. At this time, projection information stored in .prj files as well as styles, fonts and colours are not supported.

ESRI shapefiles that contain 3D linear data have an attribute called “PolyLineZ” in the shape column of the attribute table. ShapePolyLineZ lines will not import with MAPublisher as MAPublisher only supports data that is constrained to an x,y Cartesian co-ordinate system. You can amend this problem by converting the data to 2D in ArcView. To do so open the shapefile in ArcView and run the xyz2xy.ave script. The xyz2xy.ave script is included in the samples that come with ArcView. See your ArcView user guide for further details on this procedure.

**AutoCAD® .dxf**

Drawing Exchange Format (dxf) files are most commonly created by Autodesk’s AutoCAD product however other software programs such as Bentley MicroStation and various other computer-aided design (CAD) programs are capable of creating files in this format. This version of MAPublisher will import .dxf files up to and including revision 14 format while preserving all layering, colours, line weights and text. Please note that text is imported using the currently selected FreeHand font however sizes, positions and angles are maintained in most cases. **It is very important to note that when exporting dxf files from AutoCAD for use in FreeHand with MAPublisher the “Explode Blocks” command must be run in AutoCAD prior to exporting the file.** DXF files are formatted in either ASCII text or binary format. MAPublisher only supports the ASCII format. Care must be taken when transferring such files on a mixed platform network. If you use ftp be sure to transfer the files with the text option selected.

**MapInfo Interchange Format**

Files of this type are most commonly created by MapInfo’s MapInfo Professional® product. Other products, including MAPublisher 5.0, are also capable of generating files in this format. These files exist in pairs where each file has the same name but ends in either .mif or .mid. Both files are required in order to successfully import a file of this format to Macromedia FreeHand using MAPublisher. **The important thing to remember when importing MapInfo files is that the .mif file must be the one that is selected through the MAPublisher import Xtra and that both files must be in the same folder.** MAPublisher will automatically locate and deal with the .mid file.

MAPublisher 5.0 supports the import of line weights (0-7), colours (24 bit RGB), pattern styles for fills (1-8 & 12-71) and strokes (1-71). It also supports fonts (family, style, justification) for text. Colours applied to area boundaries are not supported and will be imported as black. In order to use line patterns and fill patterns you must have opened or accessed the brush library equivalents. A library file has been created, “brush_template.fh10”, which provide support for all the standard MapInfo pen styles (stroke patterns) and brush styles (fill patterns). These files can be found in the utilities folder on your MAPublisher CD. Please refer to your Macromedia FreeHand user guide for details about how to add these libraries to your Macromedia FreeHand panels. MAPublisher will not apply both a colour and pattern to an object. If both exist for a
particular object only the pattern will be applied. MAPublisher 5.0 does not support the MapInfo SYMBOL clause and due to a proprietary MapInfo font naming convention, you may experience inconsistencies when re-importing files exported from MAPublisher. MAPublisher also supports projection information contained in MapInfo mid/mif files. Please note that not all mid/mif files contain projection information.

MicroStation® DGN Format

MicroStation Design Files or DGN (.dgn) are the native files created by Bentley Systems Inc.’s MicroStation product. MAPublisher 5.0 supports the import of MicroStation J, SE and 95 version DGN files. This version of MAPublisher does not support MicroStation V8 DGN files. Users of MicroStation V8 who wish to use their files in MAPublisher must save them in dxf format as MicroStation V8 does not support export of earlier version DGN files.

MAPublisher 5.0 supports the import of 2D MicroStation DGNs, with line weights, fills, and colours maintained. DGN files are imported in their master co-ordinate systems. Colour index numbers (0-255) are translated into FreeHand colours during the import process, where the first primary colour table used in the DGN file is the one utilized in the import to FreeHand. Line weights (0-31) are translated to stroke width on import. Text is imported at the currently selected FreeHand font and size, with any assigned DGN text rotations applied.

DGN files will be imported to a single Macromedia FreeHand layer. However, all MicroStation level information is retained as an attribute on the resultant map layer in a MAPublisher attribute column called “level”. MAPublisher’s Select by Attribute and Map Copy/Paste functions can be used to easily separate features into individual FreeHand layers based on MicroStation levels.

In MicroStation, an “active angle” can be set for a given document. This is a rotational value that is applied to the entire geographic co-ordinate setup for the DGN document. MAPublisher 5.0 will recognize the active angle in a DGN file upon import and draw the resulting FreeHand artwork relative to the active angle.

Caution should be used when importing files containing complex shapes. Complex shapes that exist in a DGN file may be imported with a stroke colour only. If problems are encountered with scaling to fit the page you may be required to place a bounding box (rectangle) in the DGN file which will ultimately represent the page extents.

USGS Formats (optional & SDTS)

The United States Geological Survey (USGS) maintains and disseminates vector map data in two major formats, optional and SDTS. Files in the optional format have the extensions .opt and .do and files in the SDTS format have the extension .ddf. MAPublisher 5.0 imports SDTS files that have the characters “LE” in the fifth and sixth positions of the file name (ex.TR01LE06.ddf). The LE stands for line entities and it is files of this nomenclature that contain the actual lines and vertices. They are usually the largest file of a given data set. MAPublisher supports projection information contained in SDTS files. When downloading and decompressing dlg files from the USGS websites you may encounter files that have two periods (.) in their file name (ex. 506875.HY.opt). In order to import such files with MAPublisher all periods except the last one must be removed by renaming the file (ex. 506875HY.opt). Also, when decompressing DLG files, check the decompression settings. Some decompression utilities automatically default to “Smart TAR CR/LT translation”. This setting must NOT be used as it may introduce errors errors to the data. Prior to decompressing the archive you should disable the “Smart TAR CR/LT translation” option.
ADDITIONAL MAPUBLISHER CONSIDERATIONS

The following items are additional important data and file considerations when working with MAPublisher. Please read the following recommendations carefully in order to get the most out of MAPublisher and improve your overall mapmaking experience.

Importing

It is advisable to import GIS files from your local hard drive or removable media source such as a CD-ROM, DVD or ZIP disk, etc. If your data resides on a LAN or other data network, you should copy the files to a folder on a local drive before importing. When moving or copying data remember to move or copy all the file components that comprise the GIS data file type that MAPublisher requires for a successful import (see pages 15-17). In addition you should ensure that each file name does not contain any spaces, extra periods (beyond the one that preceeds the file extension) or other illegal characters.

MAPublisher does not support three-dimensional GIS data. Many GIS applications that support 3D data offer export support in 2D formats. Please consult your GIS application's documentation or product vendor for details on facilitating a conversion from 3D to 2D prior to attempting an import operation with MAPublisher. See also ArcView Shapefile, page 16, for more information.

Many GIS data files come in compressed archive formats such as .zip, .sit or .tar. Be sure to decompress such files before attempting an import with MAPublisher. Care should be taken when data is decompressed. Decompression utilities may generate extra periods in filenames. For example some files may contain two periods (ex. “123456.HY.opt”). Rename these files so that the only period in the filename is the one immediately preceding the file extension (ex. “123456HY.opt”). If you download DLG files from the USGS, you must check your decompression settings. Some decompression utilities, such as WinZip, automatically default to “Smart TAR CR/LF translation”. This setting must not be used as it will introduce errors in the data. In WinZip, navigate to Options ➔ Configuration, click the “Miscellaneous” tab, and switch off “TAR file smart CR/LF conversion”, to unzipping your files.

Exporting

It is advisable to export or save files to your local hard drive or removable media source. When using Windows 2000 or XP it is further advisable to avoid exporting or saving directly to the desktop. Do not export or save to folders which contain periods or spaces. In addition you should ensure that each file name does not contain any spaces, extra periods (beyond the one that preceeds the file extension) or other illegal characters.

When saving or exporting files that contain map attribute information make sure that the width of each attribute column is sufficient to hold all the attribute information (ie. ensure that the width of each column is at least as wide as the longest string of data contained in that column). If a character string exceeds the width of the column in which it is contained, the attribute value will be truncated.
Macromedia FreeHand Compatibility

This version of MAPublisher has been specially engineered to operate with Macromedia FreeHand 10 and MX only. FreeHand10 files that contain MAPublisher information are backwards compatible with FreeHand 9 format only. Saving to a version of Macromedia FreeHand prior to version 9.0 may result in the loss of geo-referencing information from your FreeHand/MAPublisher 5.0 file. Always make a backup copy in FreeHand 10 or MX format before saving to an earlier version of Macromedia FreeHand. MAPublisher files created in FreeHand 9 or 10 with MAPublisher 4.0 are compatible with this version of MAPublisher and will open correctly.

Data Considerations

When obtaining GIS data for use with MAPublisher, whether from an online source, commercial vendor, government office or from an internal source within your organization, there are a number of important considerations to keep in mind.

First and foremost you should always endeavour to obtain data in one of the formats supported by the MAPublisher Import Map Xtra (see pages 15-17). In cases where the file format native to a particular mapping application is not supported by the Import Map Xtra you can often request the data provider to export a file in one of the supported formats.

When receiving data it is especially important to obtain as much meta-data about the files as possible, especially concerning projections. You must first determine if the data is projected. The majority of the data you receive will be unprojected (ie. in lat/long). Unprojected data will be imported by MAPublisher with latitude and longitude map anchors, which will therefore range from (x) -180 to 180, (y) -90 to 90. Unprojected data will also import with a non-earth scale.

If you receive projected data you must be aware of the following. MAPublisher will import projected data with a true scale and appropriate map anchors only. Unlike unprojected data, these map anchors will not be in lat/long, but rather in a co-ordinate system appropriate for the particular projection. When importing projected data you should select the same units as were used in the reprojection process. Therefore a key piece of information you obtain from your data supplier is the units that were used when the data was reprojected (ie. meters, km, miles etc.). In the Import Map dialog select your file, select your units, then click Defaults. This will ensure correct area and perimeter values in MAPublisher. In order to optimize the use of MAPublisher’s tools, such as Point Plot, you will be required to enter all the projection parameters of the file after the file has been imported. For most file formats the name of the projection will not be automatically recognized by MAPublisher. In order to enter projection details accurately you must be supplied with the projection name, and the additional parameters which are necessary for the projection in question. This information should be entered in the ‘Store Proj Info’ section of the Projection Editor (see Page 52).

In summary, when obtaining map data the following information should accompany the data files:

- units of measure (ie. meters, kilometers, miles etc.)
- projection name
- state plane*
- ellipsoid (named or custom parameters)
- central meridian & central parallel
- UTM zone*
- 1st & 2nd latitudes*
- latitude of true scale*
- false northing & easting*

* if appropriate
IMPORTING MAP DATA

IMPORT MAP

The Import Map Xtra is the main starting point for most users wanting to work with GIS map data in Macromedia FreeHand. This is the Xtra that must be used to import GIS data files, set the initial map scale and define your cartographic workspace to start making maps.

The MAPublisher Import Map Dialog

Below is a diagram of the MAPublisher Import dialog along with an explanation of each of its controls and boxes. Please familiarize yourself with this diagram before continuing to the examples on the following pages.

Tip: Avoid importing files over a network connection on the Macintosh platform. Occasionally shape files and mid/mif files may fail to import correctly under such conditions. If you are in a network environment we advise you to copy the desired files to a local drive before using the MAPublisher Import Map dialog.

Tip: Avoid using the period character (.) in folder names as the MAPublisher Import Map dialog may fail to correctly interpret the map attribute file name and as such will not be able to import the file correctly.
Importing a Single Map File (Basic Import)

The following steps will acquaint you with the method of importing single map files by using sample data which can be found on your MAPublisher 5.0 CD in the tutorial_data folder. Please locate that folder on your CD before proceeding.

1. Start by creating a new FreeHand page in landscape orientation. Be sure to reset the rulers so that the 0,0 point is at lower left corner of the page (see page 12).

2. Select Xtras ➔ 1. MAPublisher ➔ Import Map. 
   - The MAPublisher Import Map dialog appears.

3. Click the Select Files button. 
   - The file selection dialog appears.

4. Locate and select the world.mif file from the tutorial_data folder on your MAPublisher CD and click Open. 
   - The dialog closes and the selected file appears in the file list in the MAPublisher import window.

5. Click Defaults to automatically calculate the map anchors and the map scale that will best fit the map to your page. The scale is automatically based on meters. If you want to base the map on another set of units (ie. kilometers, miles etc.), select the new units from the “Units” drop-down list and click Defaults. 
   - The Map Anchors and Scale are calculated and displayed in the appropriate text boxes in the MAPublisher Import window.

6. If desired, set the Page Anchors and Angle values. The Page Anchors are based on the page units and identify the page location that corresponds to the Map Anchor location. These will offset the map from the page origin by the values entered. The Angle value will rotate the map around the map’s origin. A positive value will rotate the map counter-clockwise; a negative value will rotate the map clockwise. After checking all of your values to see that they are correct, click the Import button. 
   - The Import Map dialog closes and the selected map file is imported based on the specifications entered in the dialog box.

![Macromedia FreeHand after import of world.mif file.](image-url)
Importing Multiple Map Files at Once

The MAPublisher 5.0 import Xtra allows for the import of multiple map files at a single time. Mixed formats (ex. shape and mid/mif at the same time) are not supported however mixed feature types (ex. areas and lines) are supported. **When importing multiple files, all files must be in the same projection.**

1. Select Xtras ➔ 1. MAPublisher ➔ Import Map.
   - The MAPublisher Import Map window appears.

2. Click on the Select Files button.
   - The File Selection dialog appears.

3. Locate and select the fsatoronto.mif and torontostreets.mif files from the tutorial_data folder on your MAPublisher CD and click Open. Use the Apple key (Mac) or the Control key (Windows) to select the two files. Files may also be added to the import list one at a time by clicking on the Select File button again and selecting additional files. Files may be removed from the list by selecting them and clicking Clear Files.
   - The selected files are added/removed from the import list.

4. Click on the Defaults button to automatically calculate the map anchors and the scale that will best fit the map to your page. The values will be calculated based on all the files in the list so that they will all fit onto the page and tile or overlap correctly with each other.
   - The Map Anchors and Scale are calculated and displayed in the appropriate text boxes.

5. If desired, set the Page Anchors and Angle values. After checking all of your values to see that they are correct, click on the Import button.
   - The Import Map dialog closes and the selected map files are imported.
Setting the FreeHand Layer Name for Imported Files

With MAPublisher 5.0 you can pre-name the FreeHand layer to which one or more of your map files will be imported. The default layer name that MAPublisher uses is based upon the actual map file name but this is not always appropriate. For example, you may wish to have a road file called ou812.mif imported to a layer called “roads” rather than a layer called “ou812”.

After selecting the file or files you wish to import and having them appear in the import list you can name the import layer or layers as follows:

Change the import layer name by double-clicking directly in the box in the “Layer” column associated with the map file for which you want to change the layer name. Enter the desired layer name accordingly just as one would do with a common spreadsheet application.

- The “Layer” column of the selected file now displays the specified layer name.

After the desired layer names have been applied, click on the Defaults button or use “same as” to calculate the scale and map anchors. The values will be calculated based on all the files in the list so that they will all fit onto the page.

- The Map Anchors and Scale are calculated and displayed in the appropriate text boxes.

If desired, set the Page Anchors and Angle values. After checking all of your values to see that they are correct, click on the Import button.

- The Import Map dialog closes and the selected map file is imported based on the specifications entered in the dialog box. The layers that are created will reflect the layer names specified in the Import Map dialog.
Importing Map Files to Match an Existing Map Layer

It is often necessary to import map data files to pre-existing map documents so that a common scale is maintained. With MAPublisher it is possible to import new map files with a scale and map anchors as defined by an existing map layer. This is done to ensure that common geography is maintained and that the layers tile or overlap properly. The following example illustrates how to import map data based on the parameters of an existing layer.

1. Follow the example on page 21 to import the fsatoronto.mif file to a new FreeHand document.

2. Select Xtras ➔ 1. MAPublisher ➔ Import Map.
   - The MAPublisher Import Map dialog appears.

3. Select the torontostreets.mif file from the tutorial_data folder on your MAPublisher CD.
   - The selected file is placed in the import list.

4. Click the “or same as” dropdown list and select the “fsatoronto” layer you imported in step 1.
   - All page scaling information is updated to reflect that of the selected layer. The Defaults button is also disabled.

5. Check that all values are correct and click on the Import button.
   - The Import Map dialog closes and the selected map file is imported based on the specifications entered in the dialog box. In this case, the two layers will geographically match up on the page.

Note: This process produces the exact same result as the Importing Multiple Map Files at Once process described on page 22.

Note: When importing map files to match an existing map layer, both the file being imported and the existing map layer must be in the same geographic projection.
Importing Files to an Existing Layer

MAPublisher 5.0 allows for GIS map data to be imported to a pre-existing map layer. This can be very useful if, for example, roads from neighbouring areas are contained in separate data files but you want them to appear on the same FreeHand layer.

**Note:** When importing GIS data to an existing layer the attribute tables of the file to be imported and of the existing layer must match (ie. they must have the same number of attribute columns and the same column names). In addition, the file being imported must be in the same projection as the existing map layer.

**Note:** DXF files and e00 files cannot be imported to an existing FreeHand layer as these two formats often contain multiple layers themselves with different topologies and attribute structures. A warning will appear if you attempt such an operation.

1. Follow the example on page 21 to import the world_west.mif file to a new FreeHand document.

2. Select Xtras ➔ 1. MAPublisher ➔ Import Map.
   - The MAPublisher Import Map dialog appears.

3. Locate and select the world_east.mif file in the tutorial_data folder on your MAPublisher CD.
   - The selected file is placed in the import list.

4. Select the world_east.mif file in the import list by clicking on the number to the very left of the file name in the import file list. Click on the “Import to Layer:” dropdown list and select the “world_west” layer you just imported to in step 1.
   - The Page Scaling information is updated to reflect the layer being imported to and the “Layer” column of the file to be imported in the import list is updated to match the layer name you are importing to.

5. Check that all values are correct and click the **Import** button.
   - The Import Map dialog closes and the selected map file is imported to the selected layer.

![Macromedia FreeHand after importing to an existing layer. Note that although 2 different files were imported individually, only one layer name appears in the layers panel.](image)
Importing Map Files with a Grain

When importing a very complex map file with a large number of points or vertices you may wish, or find it necessary, to simplify the file by culling some of these features. MAPublisher accomplishes this with the Grain function. The MAPublisher import engine automatically calculates minimum and maximum values for the grain, or “file thinner”, and displays them in the import map dialog table. When using the grain function it is a good idea to experiment with different values in order to obtain the desired results. The basic idea is to enter as low a value as possible while still retaining the accuracy of the view.

1. Select Xtras ➔ 1. MAPublisher ➔ Import Map.
   - The MAPublisher Import Map dialog appears.

2. Locate and select the greenland.mif file from the tutorial_data folder on your MAPublisher CD and click Open.
   - The selected file is added to the list. Suggested Min/Max grain values are calculated and displayed in the file import table. Suggested Min/Max grain values will vary depending on the complexity and the scale of the file.

3. Mac: Select the desired file in the import list and click the Set Grain button. Enter a value into the text box (for best results use a value between the Suggested Min/Max in the file list, such as 0.01) and click OK.

   Windows: Double-click on the cell in the Grain column of the import list of the file to which you want a grain value applied. The desired grain value may be entered directly into the cell just as one would do with a spreadsheet program. Enter a value into the text box (for best results use a value between the Suggested Min/Max in the file list, such as 0.01).

   Different grain values can be added to different files and not every file in the list must have a grain value assigned to it.
   - The “Grain” column in the File List is updated as you enter grain values for the selected files.

4. Click on the Defaults button to calculate the Scale and Map Anchors and click Import.
   - The Import Map dialog closes and the file is imported based on the Page Scaling information. It is also simplified based on the assigned grain values.

The images below show how grain values of .01 and .45, as well as no grain, affect the greenland.mif file. The file is originally 1,372KB in size. Importing it with a grain of .01 and then exporting it back to mid/mif format will produce a file of size 662KB with little reduction in detail.
IMPORTING POINTS

The MAPublisher Import Points Xtra allows the import of delimited ASCII text files as point data provided they contain co-ordinate values. The Import Points Xtra can be found at Xtras ➔ 1. MAPublisher ➔ Import Points.

A typical file of this nature might be set up as follows:

```
"X value","Y value","Name","Population"
"3.4","5.4","Metropolis","2345000"
"6.54","21.4","Gotham City","1234000"
"6.32","66.6","Smallville","54"
```

Notice how the first row contains column headers. MAPublisher can usually determine whether the first line of the file contains column headers. If the file does not appear to contain column headers, MAPublisher will assign the default headers “Column1”, “Column2” and so on.

Select File - Allows you to select the file you wish to import.

New Layer - The new layer name is placed here. The default is the name of the file but it can be changed if you wish.

Use First Line as Header - If the first line of the text file you are importing contains column headings, check this box.

X/Y coords from column - These two dropdown lists hold the names of all the columns in the selected file. Select the columns from which the X values and Y values for each point will be read.

Multiply X/Y coords by - You may enter a value by which all X values or all Y values for each point will be multiplied before they are imported.

Scaling 1 to - This is the scale of your map in map units. It can be calculated using the Defaults button or “same as” or you can specify a scale yourself.

Map Anchors X/Y - The “real world” co-ordinates as defined by the bottom left hand corner of the map extents. It is recommended that you use the Map Anchor values calculated using the Defaults button.

The MAPublisher Import Points Xtra supports the import of delimited ASCII files that contain any of the following delimiters between data values: comma, return, end of line and tab.

Note: **Point data is imported as text when using either Import MAP or Import Points.** The default font and font size used to display point data immediately after import is whichever font and size are currently selected when the import operation is performed. The default symbol used is the plus sign (+). Although the symbol can be changed prior to import when using Import Points, this is not possible when importing using the Import MAP. The symbols particular to any set of points can be changed using the MAPublisher legend Xtras (see Point Legends, page 63).

Note: **When point data is imported, each point symbol will be placed centred over the geographic co-ordinate location.** Subsequent changes to the font symbol or size may cause the geographic co-ordinate to no longer be under the centre of the symbol. Adjustments can be made using the steps for Repositioning Point Symbols on page 33.
Importing a Delimited ASCII File as Point Data

1. Select Xtras ➔ 1. MAPublisher ➔ Import Points.
   - The Import Points dialog box appears.

2. Click on the Select File button.
   - The File Selection dialog appears.

3. Select the az_deci(partial).txt file from the tutorial_data folder on your MAPublisher 5.0 CD and click on the Open button.
   - The file's name appears next to the Select File button and a layer name is placed in the “New Layer” box. You may change the layer name if desired.

4. Select the column of the file to be used as the points' X co-ordinates and Y co-ordinates using the “X/Y Coords from column:” dropdown lists. The dropdown lists are filled with all of the column names found in your ASCII file. For this file, use “Column 10” for the X co-ordinates and “Column 9” for the Y co-ordinates.

5. Choose the symbol that will be used to represent your points on the page using the “Use Symbol” dropdown list.

6. (Optional) Set the values by which the X and Y co-ordinates will be multiplied by before they are imported by entering values in the “Multiply X/Y coords by” text boxes. You can multiply the X co-ordinates by a different value than the Y co-ordinates if you want. The default for each is 1, which will not change your values at all.

7. To set the Scale and Map Anchors, click on the Defaults button to calculate values based on the points' co-ordinates. Enter Page Anchors and Angle values as desired and click OK.
   OR
   You can also use the “Same as Layer:” dropdown list to set the Page Scaling information to that of another layer and then click OK.
   OR
   Enter all values manually and click OK.
   - The Import Points dialog closes and the points are placed on the page as specified. All columns that were in the file are imported as attribute data for the created points.
Creating a Delimited ASCII Point File

There may be times when you wish to add a point or a series of points to your map but you do not have a GIS or ASCII file containing these points ready for import. Provided you have the real-world co-ordinates for the locations you wish to plot, you can manually create a delimited ASCII file using a text editor (ex. Notepad, BBEdit, SimpleText, Ultra Edit etc.) or a spreadsheet program (ex. Excel, Lotus 123 etc.). One column in the file must contain the X co-ordinates of the points and another must contain the Y co-ordinates. You can add as many additional columns as you wish containing additional information to be imported as attribute data.

If you are using a text editor, you can simply type in your data in the following format:

```
"Column 1 Header","Column 2 Header","Column 3 Header"...etc
"Column 1 Value 1","Column 2 Value 1","Column 3 Value 1"...etc
"Column 1 Value 2","Column 2 Value 2","Column 3 Value 2"...etc
```

*Note: Negative values for the X and Y co-ordinates denote west longitudes and south latitudes, respectively.*

*Note: Make sure to enter a carriage return using the “enter” key on your keyboard after the last line of data otherwise the last line will be ignored by the MAPublisher Import Points Xtra.*

If you are using a spreadsheet application you can enter your point information as a table and save the file in a text format, preferably .csv or .txt, choosing either comma or tab delimiting. The spreadsheet application will format the text automatically. The screenshot below illustrates an example of such a table in Microsoft Excel prior to exporting as a .csv or .txt for import into Macromedia FreeHand using MAPublisher 5.0.

![Microsoft Excel window showing user-created point file for use in Macromedia FreeHand with MAPublisher 5.0](image)
POINT PLOTTER

There may be times when you wish to quickly add a point or a small group of points to your map but you do not have a GIS or ASCII file containing these points ready for import. Or your map may in be a projection such as UTM or Albers and the co-ordinates for your point locations are in a lat/long format such as degrees, minutes, seconds (DMS) or decimal degrees.

Provided you have the real-world co-ordinates, in either DMS or decimal degrees, for the locations you wish to plot, you can use the MAPublisher Point Plotter to have your points automatically plotted at their correct locations on your map. The MAPublisher Point Plotter supports the input of co-ordinates in either DMS or decimal degrees and will create a point for each entered co-ordinate pair using the selected symbol. If your map layers are already projected, the MAPublisher Point Plotter will convert your entered DMS or decimal degrees co-ordinates into the co-ordinates of your projected map layer and plot the points in their correct locations.

Note: The MAPublisher Point Plotter will only create a point on a projected layer if the layer is recognized by MAPublisher as being in a particular projection. If the layer was originally projected using MAPublisher then the projection will be automatically recognized. If the data file was projected outside of MAPublisher prior to import to FreeHand the projection may not be recognized. You can determine if the projection is recognized by referencing the top section of the MAPublisher Point Plotter dialog window. If the projection is not recognized by MAPublisher you can use the MAPublisher Projection Editor (see page 52) to assign the known projection, after which the MAPublisher Point Plotter may be used.

The MAPublisher Point Plotter may also be used as a DMS to decimal degrees and decimal degrees to DMS conversion calculator for quickly determining the equivalent values for co-ordinates in one expression format or the other.

Note: Points created using the MAPublisher Point Plot function will have the centre of the text symbol placed at the actual geographic co-ordinate location of the point. Subsequent changes to a symbol's presentation may result in the symbol being no longer positioned with its centre over the geographic co-ordinate. Adjustments can be made by following the procedure for Repositioning Point Symbols found on page 33.
Plotting a Point Using the MAPublisher Point Plotter

1. Open the USA.FH10 file from the tutorial_data folder on your MAPublisher 5.0 CD.

*Follow steps 2-4 if you wish to plot your points on a new layer. If you wish to plot the points on the existing USA layer proceed to step 5.*

2. Create a new FreeHand layer and rename it “cities”.

3. Add MAP Parameters to the “cities” layer by following the steps on page 77 using the “or same as” option and referencing the “USA” layer.

4. Set the projection for the “cities” layer by following steps 4 and 5 on page 53 using the “or same as” option and referencing the “USA” layer.

5. Select the desired font and font size for the point you will plot using the FreeHand text tools. For this example we used an 8pt font size.

6. Select the desired layer for the points to be plotted and open the MAPublisher Point Plot window by selecting Xtras ➔ 8. MAP Windows ➔ Show/Hide MAP Point Plot.

7. Click the “Enter degrees, minutes, seconds” radio button to signify that you want to enter the point co-ordinates in DMS. To plot a point for New York City, enter 40, 40 & 14 in the LAT (latitude) boxes and click the “North” radio button and then enter 73, 56 & 39 in the LONG (longitude) boxes and click the “West” radio button. Select a desired symbol from the “Symbol” dropdown menu and click Create.

   - A point will be plotted at the location of New York City (40°41’14"N, 73°56’39"W).

8. Click on the “Clear” button to remove the previous entries.

9. Click the “Enter decimal degrees” radio button to signify that you want to enter the next point co-ordinates in decimal degrees. To plot a point for Los Angeles, enter 34.1151 in the LAT (latitude) box and -118.4183 in the LONG (longitude) box. Select a desired symbol from the “Symbol” dropdown menu and click Create.

   - A point will be plotted at the location of Los Angeles (34.1151 degrees, -118.4183 degrees).

*Note: When entering co-ordinate values in decimal degrees, positive values indicate north and east locations and negative values indicate south and west locations.*

Results of using the MAPublisher Point Plotter to create points for New York City and Los Angeles.
Converting Between Degrees, Minutes, Seconds and Decimal Degrees

Using MAPublisher’s Point Plotter you can easily convert between degrees, minutes, seconds and decimal degrees formats and also retain the ability to plot points in either format.

1. Follow steps 1 through 6 of the example on the previous page for Plotting a Point Using the MAPublisher Point Plotter.

2. Click on the “Enter decimal degrees” radio button and enter 41.8392 in the LAT box and -87.6883 in the LONG box.
   - These figures represent the decimal degrees co-ordinates for Chicago.

3. Click on the “Convert to deg/min/sec” button.
   - The values entered in the previous step will now be converted to DMS and the converted values will be displayed in the DMS value boxes.

4. To plot the point for Chicago using the entered decimal degrees values click the Create button.

5. To plot the point for Chicago using the converted DMS values click the “Enter degrees, minutes, seconds” radio button and then click the “Create” button.

Note: Steps 4 and 5 will yield the same result.

Note: To use the Point Plotter as a simple DMS to decimal degrees or decimal degrees to DMS conversion calculator omit steps 4 and 5.

Note: If a layer is reprojected while the Point Plotter window is open, the Point Plotter dialog must be closed and reopened before any points are plotted to that layer in order to allow the new projection to be recognized by the Point Plotter.
REPOSITIONING POINT SYMBOLS

As mentioned throughout this manual when discussing point data and point symbols, points that have been imported using either the Import Map or Import Points Xtras or created using the Point Plotter, will be automatically positioned with the centre of the default symbol (“+”) directly over the geographic location of the point. However, any subsequent change made to these symbols such as increasing or decreasing the size or altering the font or symbol will result in the new symbol no longer being positioned with its centre over the geographic point. We have therefore provided a simple calculation utility (MAPublisherTexts.xls) in Microsoft Excel format which will help you determine how to recentre your symbols after changes have been applied. This file may be found in the utilities folder on your MAPublisher 5.0 CD.

Please follow the example below to gain some understanding on how to use this utility.

1. Import a file using the MAPublisher Import MAP or Import Points Xtras.
2. Using the FreeHand Object Inspector, record the width and height of the points to be recentred. The numbers will be displayed in the inspector in the page units you have defined for your document (points, pixels, centimeters, inches etc).
3. Adjust the points’ font and size as desired. Once complete, record the new width and height of the points using the Object Inspector. Make sure you are using the same page units as in step 2.
4. Open the MAPublisherTexts.xls file in Microsoft Excel.
5. Enter the initial width and height and the new width and height of your points into the appropriate cells in the spreadsheet. The First Indent and Baseline Shift values needed to properly offset the point to its correct geographical location will be calculated based on these values.

**Note:** The First Indent and Baseline Shift values must be ADDED to any existing First Indent and/or Baseline Shift values the point has assigned to it prior to the conversion. Do not simply replace the existing values with the values calculated using this algorithm. MAPublisher often assigns Baseline Shift values to points upon import.

**Note:** If you create a point legend, the above steps will have to be repeated for each set of points that correspond to a specific legend element UNLESS each legend element has the exact same dimensions (which is unlikely). Text of the same point size will always share the same height, but the widths will often vary considerably.

If you do not have Microsoft Excel and are thus unable to use the MAPublisherTexts.xls utility, please take note of the following formulae which you may manually apply to achieve the same results.

\[ W_i = \text{initial width} \]
\[ H_i = \text{initial height} \]
\[ W_n = \text{new width} \]
\[ H_n = \text{new height} \]
\[ \text{New First Indent} = - \left( \frac{W_n - W_i}{2} \right) \]
\[ \text{New Baseline Shift} = \left( \frac{H_n - H_i}{2} \right) \]
The MAPublisher Location Tool displays the co-ordinates of the mouse cursor in map units. When no map units are present (i.e., the layer has no geo-referencing information) the window will display the co-ordinates in page units. The window will also display the map and page anchors, the scale, and the angle of rotation of the map.

Please familiarize yourself with the elements of the MAPublisher Location Tool dialog by reviewing the diagram below.

The MAPublisher Location Tool can be accessed by clicking on the Location Tool icon in the FreeHand Xtras toolbar.

**Determining the Co-ordinates of a Specific Location**

1. Import any map file from the tutorial_data folder on your MAPublisher CD.

2. Click on the MAP Location Tool button in the FreeHand Xtras toolbar.
   - The MAP Location Tool window appears.

3. Move the mouse cursor to the location whose geographic co-ordinates you wish to see and click the left mouse button.
MAP ATTRIBUTES

The attribute table that forms part of a GIS map file is one of the most important parts of any data set. It is in the attribute table that we find important information such as street names for lines, zoning or zip code numbers for areas and elevations for points to go along with our vector line, area or point data. Along with vector line, area and point data imported as explained in the previous sections, MAPublisher also imports the attribute data table associated with any vector map file that it supports.

MAPublisher is able to use map attribute data to search for and select items, create and place labels and create map legends based upon attribute values or value ranges. MAPublisher also provides tools and dialogs for accessing, viewing, editing and adding to map attribute tables.

MAP ATTRIBUTES WINDOW

The MAP Attributes window lets you display the attribute records for your map layer or for selected parts of it. These attribute records are linked to the map’s graphic elements. Only the attributes of selected map features will be displayed in the window at a given time. Also, only one type of feature from a single layer can be displayed at once (ie. you cannot view attributes for lines and areas at the same time).

The MAP Attributes window can be accessed by selecting Xtras ➔ 8. MAP Windows ➔ Show/Hide MAP Attributes.

Note: The attribute values displayed in the MAP Attributes window may be sorted by column value by double-clicking on the column heading.
**Viewing Map Attributes**

1. Import the world.mif file from the tutorial_data folder on your MAPublisher CD (see Import Map, page 20).

2. Select all or some of the map's features.

3. Select Xtras ➔ 8. MAP Windows ➔ Show/Hide MAP Attributes. - The Map Attributes window appears.

**Editing Map Attributes**

MAPublisher's MAP Attributes window is a fully editable “spreadsheet-like” environment. All attribute values, except for those created by MAPublisher (Area, Perimeter, Length) can be edited by the user.

To change the value of a cell double-click on the cell and enter the new value such as you would in a spreadsheet program. Keep in mind that you must enter values that correspond with a column's type (ie. only enter numbers into a column of type "Real").

After making the changes click the Apply button to set the edits permanently into the map file's database record. Closing the window without clicking Apply will discard any changes you have made.

*Note: The widths of the columns in the MAP Attributes window may be changed by clicking on the column separator and dragging it left or right as desired.*
MAP COLUMNS

The MAP Columns window allows you to view, edit, and create new map attribute columns.

Adding a New Column to a Map Attribute Table

1. Import the world.mif file from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras ➔ 8. MAP Windows ➔ Show/Hide MAP Columns.
   - The Map Columns window appears displaying the columns associated with your map attribute records.

3. Click on the Options button and select New Column.
   - The Map Column window appears.

4. Enter a column name, such as “Head_of_State”, as well as a type and a maximum width. In this case, Head_of_State, the type should be ‘character’.

   Note: Column names cannot include spaces. Use the underscore ( _) instead.

5. Click OK.
   - The new column is created and can be given values using the Map Attributes Xtra (see Map Attributes, page 35).

MAP Columns window before (left) and after adding the “Head_of_State” column.
Changing an Existing Column’s Properties

1. Open the MAP Columns window and select the column name of the column whose properties you wish to edit. Click the Options button and select “Edit Column”.

2. Change the Name and Width fields as desired. You cannot change the column type once it has been created.

3. Click OK.
   - *The column now has a new name and width.*

Removing a Column from a Map Attribute Table

To remove a column from a map attribute table open the MAP Columns window and select the column name of the column you wish to delete. Click the Options button and select “Delete Column”. Only one column may be deleted at a time.

EDIT MAP COLUMNS

The MAPublisher Edit MAP Column Xtra provides for the editing of attributes for multiple features in a single step and for the creation of attribute values for a column based upon values in other columns. Editing attribute data using this Xtra can be done by building an expression that accesses and manipulates values from other columns. Only numeric columns can be edited using this Xtra.

The Edit MAP Columns Xtra is located at Xtras → 5. MAP Attributes → Edit MAP Columns.

Please familiarize yourself with the MAPublisher Edit MAP Column dialog by reviewing the following diagram.

*Note:* When using the Edit MAP Columns Xtra to populate a new column with values based upon calculations using existing columns, the new column must be created before running the Edit MAP Columns Xtra.

*Note:* The expression MUST be created using the buttons in the Edit MAP Columns dialog and not your keyboard.
Editing the Values of a Map Column

1. Import the world.mif file from the tutorial_data folder on your MAPublisher CD.

2. Using the Map Columns Xtra, add a new column, “Annual_Increase”, to the world.mif attribute table. Make the width of the column 10 and set the type to Integer (see Map Columns, page 37).

3. Select the “world” layer from the Macromedia FreeHand layers panel.

4. Select the countries for which you wish to calculate the annual population increase.

5. Select Xtras ➔ 5. MAP Attributes ➔ Edit MAP Columns.
   - The Edit MAP Columns window appears.

6. Set the Layer to “world” and Feature Type to “Area”.

7. Select the Result Column to be updated/edited. In this case, use Annual_Increase.

8. Start building the expression using the calculator buttons and Expression Column list. Using the Expression Column dropdown list, select the Population column, Click the “*” button and then the “(“ button. Using the Expression Column dropdown list again, select the Pop_Grw_Rt column. Click “/”, then enter 100 using the numeric buttons. Finally, click “)”.  
   - The expression in the Edit Expression box should now look like this: Population * (Pop_Grw_Rt / 100)

9. Click OK.
   - The selected features’ attributes will be updated. Use the Map Attributes window to view the changes (see Map Attributes Window, page 35).

Your new column’s values should look something like those above. Of course they will vary depending on which countries you chose. Also, in the illustration above, a number of the attribute columns have been resized so that only 5 columns are visible.
SELECT BY ATTRIBUTE

The MAPublisher Select By Attribute Xtra allows you to select map features based upon their attribute information. A particular column is selected and then a logical expression is built defining the desired features for selection. For example, ‘select all roads that have 2 lanes and are more than 5 kilometers long’. The kinds of queries you can make depends upon the attribute data associated with your map layer.

This Xtra has four options: Initial Selection, Add to Selection, Remove from Selection and Select from Selection. Initial Selection is intended to be used when nothing has been selected. Add to Selection will add the results of the query to any currently selected features. Remove from selection will remove the results of the query from the current selection and Select from Selection will only query those features that have already been selected.

Please familiarize yourself with the MAPublisher Select by Attribute dialog by reviewing the following diagram.

Note: The MAPublisher Select by Attribute dialog will remember the feature type and column selections from the previous selection when performing additional selections on the same layer. It will not do so across multiple layers.
Making an Initial Selection

1. Import the burl_roads.lin file from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras ➔ 5. MAP Attributes ➔ Select by Attribute.
   - The MAPublisher Select by Attribute window appears.

3. Click the “Initial Selection” radio button.

4. Set the “Feature Type” dropdown list to “Line”.

5. Set the “Column” dropdown list to “code”.

6. Set the “Comparison” dropdown list to “Equal to”.

7. Set the Value A to 2 from the drop down list near the entry field for “Value A:”. You can also type 2 into the entry field. Code 2 represents all roads that are classified as highways.

8. Click Insert to set the selection expression. If you realize you made an error after clicking Insert, just click on the Clear Expression button.
   - The Build Expression is moved into the Expression box.

9. Click OK.
   - The features that match the expression are selected.

Result of Select by Attribute for lines with a code value equal to 2 in the burl_roads.lin file.
Adding to/Removing from/Selecting from an Existing Selection

1. Perform all the steps from the previous example and leave all resultant features selected.

2. Select Xtras ➔ 5. MAP Attributes ➔ Select by Attribute.
   - The MAPublisher Select by Attribute window appears.

3. Click the “Add to Selection” radio button.

4. Set the “Feature Type” dropdown list to Line.

5. Set the “Column” dropdown list to code.

6. Set the “Comparison” dropdown list to Equal to.

7. Set the Value A to 3 from the drop down list near the entry field for “Value A:”. You can also type 3 into the entry field. Lines with this code value are railways.

8. Click Insert to set the selection expression. If you realize you made an error after clicking Insert, just click on the Clear Expression button.
   - The Build Expression is moved into the Expression box.

9. Click OK.
   - The features that match the expression are selected.

Using the Remove from/Select from Selection options can be done the same way as Add to Selection.

Result of Select by Attribute for lines with a code value equal to 3 added to previous selection for lines with a code value equal to 2 in the burl_roads.lin file.
WORKING WITH IMAGES

MAPublisher 5.0 contains tools for working with geographic raster images such as aerial photographs and satellite imagery. This section describes the functions that MAPublisher provides for these purposes.

REGISTER IMAGE

The Register Image Xtra allows you to accurately position or register geo-referenced raster images with your vector map data. The geo-referencing information for such images is often stored in a separate text file that can be read by the MAPublisher Register Image Xtra.

Common geo-reference file types include:
- .irp - Image Report File
- .tfw/.jfw - TIFF/JPEG World File
- .tab - Table File
- .lgo - Listgeo File
- .tif - GeoTIFF File (contains both image and reference data)

MAPublisher can read the geo-referencing information from GeoTIFF files which are files that contain both the geo-referencing data and actual image in a single file. Reading the data from such a file is done the same way as with an external referencing file except that the .tif file is used as both the image and the reference files.

Please familiarize yourself with the elements of the MAPublisher Register Image dialog by reviewing the diagram below.

Note: When registering an image with MAPublisher it is important to remember that in order for an image to register correctly with a set of vector data, both the image and the vector data must be in the same geographic projection.
Registering an Image with a Reference File

1. Import the regional_south_china_sea.shp file from the tutorial_data folder on your MAPublisher CD.

2. Create a new FreeHand layer called “image” in the Layers panel.

3. Make sure the new “image” layer is highlighted in the FreeHand layers panel and select File ➔ Import.
   - The Import dialog box appears.

4. Select the sample raster image file, borneo.tif, from the tutorial_data folder on your MAPublisher CD.

5. Click Open (Windows) or Choose (Mac) to bring the file into your Macromedia FreeHand workspace.
   - The raster image is brought in at a default position and scale in the centre of the screen.

6. With the image selected, Select Xtras ➔ 10. MAP Images ➔ Register Image.
   - The Register Image dialog appears.

7. Use the “Select Layer” (Windows) or the “same as” (Mac) dropdown list to select the layer that the image will be registered to. In this case choose the layer called regional_south_china_sea.
   - The Page Scaling information is updated to match the selected layer.

8. Click on the Select Reference Info button and select the borneo.tfw file from the tutorial_data folder on your MAPublisher CD.
   - The fields are all updated to reflect the data contained in the reference info file.

9. Click OK.
   - The image is registered to the selected layer.

---

Note: When working with GeoTIFF files remember to use the same file (ie. the .tif itself) in steps 4 and 8.
Registering an Image without a Reference File

1. Import the regional_south_china_sea.shp file from the tutorial_data folder on your MAPublisher CD.

2. Create a new layer called “image” in the Layers panel and add map parameters to that layer (see page 77).

3. Make sure the new “image” layer is highlighted in the FreeHand layers panel and select File ➔ Import.
   - The Place File dialog box appears.

4. Select the sample raster image file, borneo.tif, from the tutorial_data folder on your MAPublisher CD.

5. Click Open (Windows) or Choose (Mac) to bring the file into your Macromedia FreeHand workspace.
   - The raster image is brought in at a default position and scale in the centre of the screen.

6. With the image selected, Select Xtras ➔ 10. MAP Images ➔ Register Image.
   - The Register Image dialog appears.

7. Use the “Select Layer” (Windows) or the “same as” (Mac) dropdown list to select the regional_south_china_sea layer. This is the layer that the image will be registered to.

8. Click the radio button beside the map extent that you want MAPublisher to use as your image’s anchor point (Upper Left X/Y, Lower Left X/Y or Upper Right X/Y).

9. Enter the appropriate values into the selected textboxes, leaving the others empty. The registration values for the borneo.tif image are: Upper Left = (108.337561, 7.781662), Upper Right = (119.245702, 7.781662), Lower Left = (108.337561, -4.442099).

10. Enter 0.012773 for the Pixel Size.

11. Click the Calculate button to automatically calculate the two remaining co-ordinate values.
   - The anchor point and pixel size are used to calculate the values for the other co-ordinates.

12. Click OK to register the image.
   - The image is registered to the selected layer.
MAPublisher 5.0 offers the ability to export previously placed raster files as geo-referenced images for use in other programs and/or for archival purposes. This can be useful in a number of ways. For example, when working with an image file for which there is no geo-referencing file you can use the MAPublisher Export Image function to create a GeoTiff or other geo-referenced image file based upon the MAPublisher scale and co-ordinate system for vector data of the same area.

Note: The MAPublisher Export Image function only allows the export of previously placed image files. It will not directly convert vector layers into geo-referenced raster images. To turn vector mapwork into a geo-raster file see page 48.

Exporting a Placed Image as a Geo-Referenced Raster File

1. Import the italy.mif file from the tutorial_data folder on your MAPublisher CD.

2. Apply a fill of “none” to the data and change the stroke colour to red with a line weight of “hairline”.

3. Create a new FreeHand layer called “image” and add Map Parameters to that layer by following the steps on page 77 using the “same as” option and referencing the “italy” layer.

4. Move the “image” layer below the “italy” layer in the layers hierarchy.

5. Select the “image” layer in the FreeHand layers panel and select File ➔ Import to open the FreeHand Import dialog.

6. Browse to the sicily.tif file in the tutorial_data folder of your MAPublisher CD and click Open or Choose.

- The image of the Italian island of Sicily appears on the ‘image’ layer of your document.
7. Manually drag the image of Sicily until it fits inside the box around the vector outline of Sicily on the “italy” layer.

**Note:** The box around the vector outline of Sicily is meant to be a guide for the purpose of this example only. It is not a normal part of the vector layer. If you do not have the parameters required to position the image using the Register Image Xtra it will be necessary to manually position the image until the correct location is achieved. In most cases it will also be necessary to scale the image to fit the vector layer. When scaling an image it is imperative that the X:Y proportions be maintained in order to preserve the integrity of the exported copy.

8. With the image selected, select Xtras ➦ 10. MAP Images ➦ Export Image.
   - The MAPublisher Export Image dialog appears.

9. Select the desired geo-referencing output format from the “Store GeoInfo as” dropdown menu. For this example we used “GeoTiff”. Leave the “Byte Order” at the default value.

   **Note:** It is advisable to leave the Export Image settings at the default values when exporting. Exporting as GeoTiff will result in the creation of a single .tif file containing both the image and the geo-referencing data. Other GeoInfo formats create separate image and geo-referencing files. See page 43 for more details.

10. Click **Save as** to name the exported image and complete the operation.
   - The image of Sicily has been exported as a GeoTiff file using the geo-parameters of the “image” layer. This image can be used in other GIS applications or in other FreeHand documents using MAPublisher.
Converting a FreeHand Vector Layout to a Geo-Image

The MAPublisher Export Image Xtra can be used to easily create a geo-referenced raster image such as a geotiff or .tif with .tfw from any FreeHand map document. In simple terms the procedure involves first exporting your document to a .tif or other raster file format using the native FreeHand export options and then placing and re-exporting your image using the steps in the previous section.

1. Complete the FreeHand map document you wish to use to create the geo-image

2. In your FreeHand document, make all the layers visible that you wish to be present in your raster image and turn off any unwanted layers.

3. Marque select all the objects you wish to have included in the exported image. Do not perform a “select-all”. Use the FreeHand selection tool instead.

4. Select File ➔ Export and choose the desired raster export format (.tif, .gif, .jpg etc.) as well as a filename and destination directory. If appropriate enter additional raster options you desire, such as resolution and compression settings. Ensure that the “Selected objects only” box is checked.

   Note: Be sure to disable the alpha channel option in the FreeHand Export Setup dialog. The MAPublisher Export Image Xtra works in the RGB colour space and as such does not support the alpha channel option.

5. Click OK to export your map as a standard, non-geo-referenced raster image.

6. While your original vector document is still open, create a new layer called “image”.

7. With the “image” layer selected, go to Xtras ➔ 4. Map Creation ➔ Add Map Parameters and choose a geo-referenced layer from the “or same as” dropdown list. This will be the geo-referencing used during the creation of the geo-image.

8. With the “image” layer selected in the layers panel, go to File ➔ Import and select the image you exported in steps 3 to 5 and click Open or Choose.

   - The image will be placed at a default position on the “image” layer.

9. Manually reposition the image so that it is coincident with your vector linework as in step 7 of the previous section.

10. With the image selected, select Xtras ➔ 10. MAP Images ➔ Export Image.

    - The MAPublisher Export Image dialog appears.

11. Select the desired geo-referencing output format from the “Store GeoInfo as” dropdown menu. Leave the “Byte Order” at the default value.

12. Click Save as to name the exported image and complete the operation.

   - The visible vector artwork has now been exported as a geo-referenced raster image suitable for use in other geographic software. You can check alignment by using the MAPublisher Register Image Xtra.
PROJECTIONS & TRANSFORMATIONS

PROJECTION EDITOR

Map projections are a way of visually presenting the world globe on a flat surface. There are literally hundreds of projections in use today all of which are based upon complex mathematical formulae that convert the spatial relationships between points on the globe to points on a flat page. The MAPublisher Projection Editor Xtra lets you easily convert maps from one projection to another using simple dialogs and menus. MAPublisher currently supports over 120 projections.

Three parameters are common to all geographic projections. These are the Central Meridian and the Cartesian offsets for the respective X and Y axis (False Easting and Northing). The Central Meridian is a simple translation of the longitude axis which is normally used to center a projection at a particular longitude. A fourth parameter, latitude, is used to designate a central parallel and associated Y axis for some projections. Unless you specify a value for any of these parameters, MAPublisher will assume a value of “0”.

When specifying a Central Meridian or parallel use the following syntax. To specify 45 degrees, 25 minutes, 30 seconds North, use 45d25'30"N. If the latitude value is in the Southern hemisphere then either -45d25'15.22" or 45d25'15.22"S are acceptable. West longitude and South latitude are expressed as negative values. For example: 120W = -120 = 120d0'0"W and 50S = -50 = 50d0'0"S

Before proceeding to the examples on the following pages please familiarize yourself with the MAPublisher Projection Editor dialog.

Tip: Not all projections are valid for all areas of the globe so make sure that the projection you wish to output is appropriate for the area of the world you are working with.
Projecting an Unprojected Map (ex. Lat/Long to UTM)

1. Import the fsatoronto.mif file from the tutorial_data folder on your MAPublisher CD.

2. Select the “fsatoronto” layer and select Xtras \(\rightarrow\) 2. MAP Scale \(\rightarrow\) Projection Editor.
   - The MAPublisher Projection Editor window appears.

3. Click the “Output” radio button. Input parameters are not required in this case because the map is initially in latitude/longitude (ie. unprojected or no projection).

4. Set the “Projection” dropdown list to Universal Transverse Mercator (UTM).
   - The MAPublisher Projection Editor Window now displays additional input boxes reflecting the requirement of additional input data for the UTM projection.

5. fsatoronto.mif is a postal zones map of Toronto. Toronto falls in UTM zone 17 so choose 17 from the UTM Zone selection list. (See Appendix 2 for the UTM zones map). As Toronto is not in the southern hemisphere, the “Southern Hemisphere” check box should be left unchecked.
   - The Central Meridian is automatically updated.

6. Click Defaults in the Page Scaling Information section to calculate a new scale for the map in this projection and round the scale to 35000. (It is not necessary to round the scale but in many cases it is more desirable to work with rounded scale values)
   - The Map Anchors and Scale are updated.

7. Click OK.
   - The map layer you have just projected is redrawn UTM.

Tip: The same projection transformation can be applied to additional map layers by selecting the desired layer in the FreeHand layers panel and choosing the "same as" option in the MAPublisher Projection Editor.
Changing a Map’s Projection (ex. Robinson to Albers Equal Area)

1. Import the states.mif file from the tutorial_data folder on your MAPublisher CD.

2. Select the states layer and select Xtras ➔ 2. MAP Scale ➔ Projection Editor.
   - *The MAPublisher Projection editor dialog appears.*

3. Check the top section of the Projection Editor dialog. If the current projection is recognized by MAPublisher it will be displayed there and you can skip to step 7. If the current projection is not recognized by MAPublisher you must first enter it as the input projection by continuing to step 4.

4. Click the “Input Parameters” radio button.

5. As the states.mif file is known to be already in Robinson projection set the “Projection” dropdown list to Robinson to identify the existing projection of the file.

6. Set the “Central Meridian” to 96W or 96d0’0”W or -96, to represent 96 degrees west longitude.

7. Click the “Output Parameters” radio button.

8. Set the “Projection” dropdown list to Albers Equal Area.
   - *The MAPublisher Projection Editor Window now displays additional input boxes reflecting the requirement of additional input data for the Albers Equal Area projection.*

9. Set the “Central Meridian” to 96W or 96d0’0”W or -96. “Central Parallel” to 37d30’0”N, “1st Latitude” to 29d30’0”N and “2nd latitude” to 45d30’0”N.

10. In the Page Scaling Information section click **Defaults**.
    - *You will see the Map anchors and the Scale values update.*

11. Round off the scale and set the page anchors as desired.

12. Click **OK**.
    - *The projection of your map will change to Albers Equal Area.*

![states layer in Robinson Projection.](image1.png) ![states layer after projecting to Albers Equal Area.](image2.png)
Storing a Map’s Projection

In many cases map data may have already been projected prior to being imported into FreeHand with MAPublisher. In some of these cases MAPublisher will recognize the projection on import of the file but in other cases it may not, such as shapefiles (shp) which do not natively store projection data unless accompanied by a .prj file. In instances where MAPublisher does not recognize the existing projection of an imported file it may be desireable to be able to tell MAPublisher what projection a layer is in. In order to use some of MAPublisher’s functions, such as Point Plot, it is mandatory that the existing projection be recognized by MAPublisher. In other cases you may simply want to embed the projection information into the FreeHand file as a record should you want to reuse an existing map file at a later date and may need to project it.

New in MAPublisher 5.0 is the ability to enter projection information for an existing FreeHand layer, without actually performing a projection operation, so that the layer’s projection is henceforth recognized by MAPublisher.

**Note:** In order to correctly and accurately use the Store Projection function you must be aware of ALL the projection parameters of your map file including the map units used in the creation of the data file. If you are unsure of the parameters of your file check with your data provider as incomplete and incorrect entries can damage the geo-integrity of your map.

Using the MAPublisher Projection Editor to Store a Map’s Projection

1. Import the canada.shp file from the tutorial_data folder on your MAPublisher CD.

2. Select the “canada” layer and select Xtras ➔ 2. MAP Scale ➔ Projection Editor.

   - The MAPublisher Projection Editor dialog appears. Notice that the area at the top of the dialog does not display any recognized projection information for this layer.

3. Click the “Store Proj Info” radio button.

   - The “Store Proj Info” button will only be available when the existing projection is unknown.

4. As the canada.shp file is known to be in Albers Equal Area projection set the “Projection” dropdown list to “Albers Equal Area”. In this case the ellipsoid is the default Albers Equal Area ellipsoid, Clarke 1866, so leave the “Ellipsoid” dropdown at “Clarke 1866”.

5. Set the “Central Meridian” to 96W or 96d0’0”W or -96 to represent 96 degrees west longitude and set the “Central Parallel” to 60N or 60d0’0”N or 60 to represent 60 degrees north latitude.

6. Set the “First Latitude” and “Second Latitude” to values representing 42 degrees north latitude and 80 degrees north latitude, respectively.

7. Check all the entered values carefully and click OK to embed the projection information.

   - The projection of the canada layer is now set at Albers Equal Area and will be recognized by all appropriate MAPublisher functions.

**Tip:** Once a projection has been incorrectly stored the only way to correct it is to perform an actual projection from the incorrect one to the correct one.

8. Re-open the MAPublisher Projection Editor and notice that the Albers Equal Area projection is now recognized and appears at the top of the dialog with the appropriate values displayed in the “Input” section.
Copy a Projection From One Layer to Another

In some cases you may have a projected map layer in FreeHand, wherein the projection is recognized by MAPublisher, and you want to copy the projection parameters of that layer to another FreeHand layer.

In order to achieve exact duplication of projection parameters between layers, the MAPublisher Projection Editor provides a “or same as” function which allows a layer to have projection information assigned to it by referencing an already projected layer.

1. Open the USA.FH10 file from the tutorial_data folder on your MAPublisher 5.0 CD.
   - The single layer, “USA”, in this file is already in Albers Equal Area projection.

2. Create a new FreeHand layer and rename it “cities”.
   - At this point, the “cities” layer is a basic FreeHand layer without any geographic parameters or projection details.

3. Add MAP Parameters to the cities layer by following the steps on page 77 using the “same as” option and referencing the “USA” layer.
   - The scaling information from the “USA” layer has now been applied to the “cities” layer.

4. Select the “cities” layer and open the MAPublisher Projection Editor (Xtras ➔ 2. MAP Scale ➔ Projection Editor).

5. Apply the “USA” layer’s projection to the “cities” layer by clicking the “Output” radio button and selecting the “USA” layer from the “or same as” dropdown list.
   - The Albers Equal Area projection information from the “USA” layer has been successfully applied to the new “cities” layer.

   Tip: The same projection transformation can be applied to additional map layers by selecting the desired layer in the FreeHand layers panel and choosing the "same as" option in the output portion of the MAPublisher Projection Editor.

   Note: In order to copy a projection from an existing layer to a layer that already has projection information assigned to it you must enter the existing projection input projection between steps 4 and 5 (see Changing a Map’s Projection, page 51).
SCALE CONVERSION

The Scale Conversion Xtra is a scale conversion calculator, that allows you to perform conversion calculations to use with other MAPublisher Xtras and dialogs.

Calculating a Scale

1. Select Xtras ➔ 2. MAP Scale ➔ Scale Conversion
   - The Scale Conversion window appears.

2. Enter the number of units and unit types to be used in the conversion.
   - The scale conversion is calculated.

The above example shows how to calculate a scale of 1:1000 in order work between meters and kilometers.
TRANSFORM SCALE

The Transform Scale Xtra allows a map’s page anchors, map anchors, scale, map units or rotation angle to be changed while accurately maintaining the cartographic grid of the workspace. The Transform Scale Xtra can also be used to change the scaling parameters of a layer to match those of an existing layer. The MAPublisher Transform Scale Xtra can be accessed by selecting Xtras ➔ 2. MAP Scale ➔ Transform Scale.

Please familiarize yourself with the layout of the Transform Scale dialog by reviewing the following diagram.

Tip: If you are ever unsure about the scaling parameters of a particular map layer you can always query it by selecting the layer and opening the Transform Scale window. The current parameters will be shown in the Input Page Scaling Information section.

Note: The angle of rotation is absolute. For example, rotating a map with a 10 degree rotation by 15 degrees will result in a 15 degree rotation not a combined 25 degree rotation.

Note: When the “or same as” option is used to copy scaling information from one layer to another the MAPublisher Transform Scale Xtra will not copy projection information. Only page scaling parameters (scale, units, angle and anchors) are copied between layers using this Xtra. To copy projection information between layers see Copying a Projection From One Layer to Another, page 53.

Note: MAPublisher does not apply rotation transformations to point symbols. It will however reposition the symbol’s anchor point during a projection or scale transformation. In order to apply a rotation to point symbols use the FreeHand transform function (Modify ➔ Transform ➔ Rotate) and enter the designed rotation angle.
Transforming a Map’s Scale

1. Import the eastUS.shp file from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras ➔ 2. MAP Scale ➔ Transform Scale.
   - The MAPublisher Transform Scale window appears. Note that the present scale as calculated on import is 1:9,220,957.019015, which is not desirable as it does not allow room for the map legend. We will therefore transform the scale and move the map anchors to accommodate the legend.

4. Ensure that your page units are set at “points” and enter “50 pt” in the “Page Anchor X” text box, “100 pt” in the “Page Anchor Y” text box and “11000000” in the “Scale” text box. This will move the page anchors to the right and up by 50 points and 100 points, respectively, while changing the scale to 1:11,000,000 in order to make the map fit better on the page.

5. Click OK.
   - The map’s scale is changed and it is offset by the specified amount from the page origin.

Before and after views of the scale transformation of the EastUS map layer.
MAP LEGENDS

MAPublisher 5.0 includes tools for quickly, easily and accurately creating point, line and area legends from your map data. The MAPublisher legend Xtras are able to read and work with the data found in the map attribute tables and to apply strokes, fills and fonts to map elements according to user specified legend criteria.

MAPublisher 5.0 provides two methods for assigning values to your map legend. The manual method is discussed under Assign Legend Info and the automatic method is discussed under Auto Assign Legend Info.

ASSIGN LEGEND INFO

The Assign Legend Info Xtra allows you to create a custom legend for your map based on its attribute information using user defined parameters. This Xtra manually assigns the legend criteria to legend elements. Legend elements are drawn using Macromedia FreeHand’s drawing tools (circles/rectangles etc. for area features, lines for line features, text fonts for point features). Please refer to your Macromedia FreeHand User Guide for additional information about the drawing tools. All legend elements must be made MAPublisher-aware before they can be used in creating a legend. This means that they are recognized by MAPublisher as map elements rather than just FreeHand artwork. This may be accomplished using the Map Creation Xtras (see Assign Area/Line/Point/Text Defaults on page 78 for more information on these Xtras).

Please familiarize yourself with the layout of the Assign Legend Info dialog by reviewing the diagram below.

The Assign Legend Info dialog functions similarly to the Select by Attribute dialog.
Building a Legend Using Assign Legend Info

1. Import the income.mif file from the tutorial_data folder on your MAPublisher CD.

2. Draw three rectangles with the rectangle tool from the Macromedia FreeHand toolbar. These rectangles will represent the area colours for the different criteria in the map legend.

3. Define the fill and the stroke for each rectangle as desired using Macromedia FreeHand’s colour tools.

4. Select the three legend rectangles at the same time using the global select or the shift and select method.

5. Select Xtras ➔ 4. MAP Creation ➔ Assign Area Defaults.
   - The legend rectangles are converted to MAPublisher objects. The Assign Area Defaults Xtra functions invisibly when executed. As such you will not see any visible change to your document or workspace after this step. In this step of the procedure the three rectangles are invisibly converted from basic FreeHand graphics to intelligent MAPublisher areas and assigned a default set of area attributes.

6. Select the first rectangle.

7. Select Xtras ➔ 3. MAP Legend ➔ Assign Legend Info.
   - The MAPublisher Assign Legend Info dialog box appears.

8. Set the “Feature Type” dropdown list to Area, the “Column” dropdown list to Total_Households, “Comparison” dropdown list to Less Than and enter 1000 in the “Value A:” text field.
   - This will enter a value Total_Households<1000 in the “Current Expression” area of the dialog.

9. Click Insert to set the Expression.
   - The “Current Expression” will be placed into the “Expression” box.

10. Click OK.
    - The selected rectangle is assigned a legend value of Total_Households<1000 and is associated with corresponding map features that have values in that range.

11. Repeat steps 7 to 10 for the second rectangle but set the “Comparison” dropdown list to Between: >= a and <= b and enter 1000 in the “Value A:” field and 2000 in the “Value B:” field.

12. Repeat steps 7 to 10 for the third rectangle but set the “Comparison” dropdown list to Greater than and enter 2000 in the “Value A:” field.

   At this point, legend values have been assigned to all three of your legend rectangles although no visible change to your map can be seen yet.

13. Select all the legend rectangles.

    - The map is updated so that the map elements reflect the legend symbols.
Tip: Legend boxes can be quickly and easily labeled with their expressions by simply clicking on them using the MAP Tagger tool. See the section on Labeling - MAP Tagger Tool, page 69 for more information on using the MAP Tagger tool.

AUTO ASSIGN LEGEND INFO

The Auto Assign Legend Info Xtra allows you to automatically create a custom legend for your map based on its attribute information. It works similarly to the Assign Legend Info Xtra but does not require you to specify a criteria or expression for each legend element. Instead it automatically determines the best way to divide your data according to the number of legend elements you wish to use. The Draw Legend Layer Xtra must still be run after the legend information has been assigned.

There are two options available for auto assigning legends: Unique Occurrences and Value Range. With Unique Occurrences, every unique value in the selected column will be assigned to one of the selected legend elements. For example, if a column contains either an a, b, or c, three different legend elements will each be assigned a single value. This option is most often used with text and alpha-numeric type attributes (ie. Road Class = A41 or Zoning = Park).

Value Range works by splitting the selected column's values into sections. The number of sections depends on the number of legend elements. For example, if you have four legend elements drawn and the column had a value range of 0 - 100, the first element would be associated with all features where that column had a value between 0 and 25. The second element would be associated with all features where the column had a value between 26 and 50 and so on. This option can only be used with numeric attributes (ie. Population = 12,000,432 or Area = 6,666).
Please familiarize yourself with the layout of the Auto Assign Legend dialog by reviewing the following diagram.

Building a Legend Using Auto Assign Legend Info - Unique Occurrences

This option for legend creation is most often used with text attributes.

1. Import the burl_roads.lin file from the tutorial_data folder on your MAPublisher CD.

2. Draw three lines with the pen tool from the FreeHand toolbar. These lines will represent the line colours for the different values in the map legend.

3. Define the colour and stroke for each line.

4. Select the three legend lines.

5. Select Xtras ➔ 4. MAP Creation ➔ Assign Line Defaults.
   - The legend lines are converted to MAPublisher objects. The Assign Line Defaults Xtra functions invisibly when executed. No visible changes to your document or workspace will be seen after this step. In this step of the procedure the three lines are invisibly converted from basic FreeHand graphics to intelligent MAPublisher lines and assigned a default set of line attributes.

   - The Auto Assign Legend Info window appears.

7. Set the “Feature Type” dropdown list to “Line”

8. Set the “Column” dropdown list to “Code” to create a legend based on the three different line types in this file.
9. Click the “Unique Occurrences” radio button.

10. If your lines are ordered horizontally, click the “Sort: Horizontal” radio button. If they are ordered vertically, click the “Sort: Vertical” radio button.

11. Click **OK**.
   - *The selected lines are assigned legend values and are associated with the corresponding map features.*

12. Select the newly created legend lines and then select Xtras ➔ 3. MAP Legend ➔ Draw Legend Layer.
   - *The map is updated so that the map elements match the legend symbols.*

![Results of line legend creation using Auto Assign Legend Info (Unique Occurrences).](image)

**Tip:** *You may determine the values that have been assigned to each legend element using the Unique Occurrences method by using the MAP Tagger tool and clicking on each legend element. See the section on Labeling - MAP Tagger Tool, page 69 for more information on using the MAP Tagger tool.*

### Building a Legend Using Auto Assign Legend Info - Value Range

This option should be used with numeric attributes.

1. Import the income.mif file from the tutorial_data folder on your MAPublisher CD.

2. Draw three rectangles with the pen tool from the FreeHand toolbar. These rectangles will represent the area colours for the different criteria in the map legend.

3. Define the fill and stroke for each rectangle.

4. Select the three rectangle legend elements.
5. Select Xtras ➔ 4. MAP Creation ➔ Assign Area Defaults.
   - The legend areas are converted to MAPublisher objects. The Assign Area Defaults Xtra functions invisibly when executed. As such you will not see any visible change to your document or workspace after this step. In this step of the procedure the three areas are invisibly converted from basic FreeHand graphics to intelligent MAPublisher areas and assigned a default set of area attributes.

   - The Auto Assign Legend Info window appears.

7. Set the “Feature Type” dropdown list to “Area”

8. Set the “Column” dropdown list to “family_average_income” to create a legend based on the average income of the families in each region of the map.

9. Click the “Value Range” radio button and leave the range at the default settings.

11. If you laid out your areas horizontally, click the “Sort: Horizontal” radio button. If you laid them out vertically, click the “Sort: Vertical” radio button.

12. Click **OK**.
   - The selected rectangles are assigned legend values and are associated with corresponding map features.

   - The map is updated so that the map elements match the legend symbols.

   **Tip:** You may determine the values that have been assigned to each legend element using the Value Range method by using the MAP Tagger tool and clicking on each legend rectangle. See the section on Labeling - MAP Tagger Tool, page 69 for more information on using the MAP Tagger tool.

   **Tip:** If you are unsure of the number of legend elements to create when using the value range option, you can quickly open the Auto Assign Legend Info window and see how many unique value occurrences there are in the data column. You can then simply decide on a number of legend elements that is a factor of the total number of unique values.
POINT LEGENDS

MAPublisher imports point data as text when using either the Import MAP or Import Points Xtras. The default font and font size used to display imported points immediately after import is whichever font and size are currently selected when the import operation is performed. The default symbol used is the plus sign (+). Although the symbol can be changed prior to import when using the Import Points Xtra or Point Plotter, it is not possible when importing a GIS point file using the Import MAP Xtra. The symbols (fonts) particular to any set of points can be changed using the MAPublisher legend Xtras and the various text fonts that may be present on your system.

*Note: If the point size of the legend symbol is different from the existing symbol it may be necessary to adjust the location of your symbol(s) according to the procedure for Repositioning Point Symbols on page 33.*

Changing Point Symbols (Creating a Point Legend)

1. Import the hypoint.e00 file from the tutorial_data folder on your MAPublisher CD.

2. Using the Macromedia FreeHand text tools, create four text objects on the page to use as your new symbols. For example, #, @, $ and X.

3. Select the objects and select Xtras ➔ 4. MAP Creation ➔ Assign Point Defaults. 
   - *The selected text objects are now MAPublisher point objects.*

4. Keep the objects selected and select Xtras ➔ 3. MAP Legend ➔ Auto Assign Legend Info. 
   - *The MAPublisher Auto Assign Legend Info window appears.*

5. Set the “Feature Type” dropdown list to Point, the “Column” dropdown list to HYPTVAL (the elevation of the point) and click the “Value Range” radio button.

6. If you arranged the text objects vertically, click the “Sort: Vertical” radio button, If you arranged them horizontally, click the “Sort: Horizontal” radio button and then Click OK.

7. Select Xtras ➔ 3. MAP Legend ➔ Draw Legend Layer. 
   - *The text representing the points (“+”) will be replaced with the corresponding text from the point legend text objects.*

This is an example of a point legend created using four legend elements representing a range of land elevations for southwestern Alberta.
LEGEND MATCHING FEATURES

This Xtra may be used to quickly select all features of a map corresponding to a particular legend element.

Selecting Features Based on Legend Attributes

1. Create a map with a legend (see Assign Legend Info on page 57 or Auto Assign Legend Info on page 59).
2. Select one or more legend elements.
   - The map features associated with the selected legend elements are selected.

NORTH ARROW

MAPublisher contains eleven different north arrow styles that you may incorporate into your map. All MAPublisher north arrows are pieces of grouped vector art and can be edited as desired. The North Arrow dialog can be accessed by selecting Xtras → 3. MAP Legend → North Arrow.

Note: The north arrow will be placed on the currently selected layer. The selected layer must be unlocked. If you want the north arrow on its own layer you must create the layer and add map parameters to it before running the North Arrow Xtra.

Adding a North Arrow

1. Import any map file from the tutorial_data folder on your MAPublisher CD.
2. Select Xtras → 3. MAP Legend → North Arrow.
   - The MAPublisher North Arrows window appears.
3. Click the Next and Previous buttons to cycle through the various designs and choose one.
4. Click the OK button.
   - The north arrow appears, rotated according to the map’s parameters.
5. Position, resize and colour the north arrow as desired.

Note: A north arrow will NOT be rotated or projected when a scale or projection transformation is performed. You must reapply the north arrow when either or both of the Transform Scale and Projection Editor have been used on a layer that contains an already placed north arrow.
**SCALE BAR**

MAPublisher 5.0 includes a dedicated map scale bar creation tool. This tool automatically generates a scale bar for your map according to a series of preferences selected in the MAPublisher Scale Bar dialog. The MAPublisher Scale Bar dialog can be accessed by selecting Xtras ➔ 3. MAP Legend ➔ Scale Bar.

Please familiarize yourself with the MAPublisher Scale Bar dialog by reviewing the diagram below. After completing the example on the following page we encourage you to experiment with the various combinations of settings in order to become familiar with the many types of scale bars one can create with MAPublisher.

![MAPublisher Scale Bar Dialog](image)

**Note:** The MAPublisher Scale Bar Xtra can only be used on a projected map layer. Layers that are in lat/long must be projected before the MAPublisher Scale Bar Xtra can be used. See Projections & Transformations, page 49, for detailed instructions on projecting your FreeHand map layers.
Creating a Scale Bar

1. Open the USA.FH10 file from the tutorial_data folder on your MAPublisher 5.0 CD.

2. Create a new FreeHand layer and rename it “scale bar”.

3. Add MAP Parameters to the scale bar layer by following the steps on page 77, using the “same as” option and referencing the USA layer.

4. Set your desired font and font size using the FreeHand Text menu. For this example we used an 8 pt font.

5. Open the MAPublisher Scale Bar Xtra by selecting Xtras ➔ 3. MAP Legend ➔ Scale Bar.

6. Choose a desired scale bar style using the Previous and Next buttons. For this example we used the first style as per the diagram on the preceding page.

7. Set the Map Units dropdown list to Kilometer, the Page Units dropdown list to centimeter and the Bar Height to 0.2 cm.
   - These settings will create a scale bar that equates centimeters on the page to kilometers on the map and that is 0.2 cm high.

8. Set the Label Interval to 250 kilometers, the Number of Labeled Intervals to 4, the Number of Intervals to Subdivide to 1 and the Number of Sub-intervals to 5.
   - These settings will create a scale bar that represents a total distance of 1000 km, has 4 main cells each representing 250 km and where the first cell is further divided into 5 smaller cells.

9. Set the Caption Options by clicking the ‘Scale 1:20000000’ checkbox and the ‘Above’ radio button, the ‘1 Centimeter = 200 Kilometers’ checkbox and the ‘Below’ radio button, and the ‘Post kilometers right of labels’ checkbox.
   - These settings will create a scale bar with the labels placed accordingly.

10. Click OK to create the scale bar.
    - The scale bar will be placed on the page according to the settings defined in the previous steps.

Completed USA map with scale bar
LABELING

One of the most useful features of MAPublisher is the ability to create labels for map objects using values from the attribute tables. Manually entering and placing labels is not necessary provided that the labeling information is included in the map database of the layer being labeled.

MAPublisher provides two methods of adding labels to your map, both of which are very simple to use. One way to create feature labels is to first select all the features you want labeled and use the Feature Text Label Xtra to label all of them by a specified attribute value. An alternate method involves using the Map Tagger tool to apply labels individually. Both these methods are discussed in the following sections.

FEATURE TEXT LABEL

The Feature Text Label Xtra allows labels to be added to your map based on the attribute data of the feature (line, point or area) being labeled. Simply select the features that you want to label and then run the Feature Text Label Xtra. Select the feature type that applies to your map (Area, Line, Point or Text) and the attribute column that you want the labels to be drawn from.

If you are labeling Line features, you can choose to have the labels follow along the lines by selecting the “Follow Along Lines” option. The labels can then be dragged and positioned at any position along a line. A specific value for the label’s position can be entered in the “Percent Along Arc” box.

Please familiarize yourself with the Feature Text Label dialog by examining the diagram below.

Note: Labels applied using Feature Text Label will always appear initially in black stroke with no fill in the currently selected font and font size. The stroke, fill, font and size can be changed at any time thereafter using Macromedia FreeHand’s tools.

Note: If Follow lines is not selected and the feature type has been set to lines, the labels will appear horizontal to the page at the mid-point of the line.
Adding Labels to a Map Using Feature Text Label

1. Import the torontostreets_joined.mif file from the tutorial_data folder on your MAPublisher CD.

2. Select a font and text size for the labels you want to create.

3. Select the features you wish to label. In this example simply select one or more of the streets that were just imported.

4. Select Xtras ➔ 3. MAP Legend ➔ Feature Text Label.
   - The MAPublisher Feature Text window appears.

5. Set the “Feature” dropdown list to the type of feature you are going to label - Area, Line, Point or Text. In this case choose “Line”.

6. Set the “Column” dropdown list to whichever column you wish to draw the labels from. For this example, choose “Street”. This column contains the name of every street on the map.

7. Click the “Follow Lines” check box to make the street names align with the lines that they apply to.

8. Set the “Percent Along Arc” value to “40” so that the label text starts near the middle of the line.

9. Click **OK**.
   - The labels appear for the selected map features.

10. If necessary, adjust the text length and position by dragging on the end point handles so that the entire label is displayed and/or moved to a desired location along the line.

This image displays several lines that have been labeled using Feature Text Label
MAP TAGGER TOOL

The MAP Tagger Tool can be found towards the bottom of the Macromedia FreeHand Xtras toolbar. Simply click on the symbol in the toolbar to select it. This tool functions similarly to the Feature Text Label Xtra however instead of having to select the features beforehand, you can simply click on any feature you want labeled and the label will appear. You also have greater control over the initial placement of the label with this tool because the label is placed where you click rather than in the centre of the feature. The MAP Tagger Tool also provides the ability to create leader lines for labeling congested areas of the map. Labels placed using the MAP Tagger tool will appear in the stroke and fill defined in the Macromedia FreeHand colour panel.

Adding Labels to a Map Using the MAP Tagger Tool

1. Import the fsatoronto.mif file from the tutorial_data folder on your MAPublisher CD.

2. Double-click on the MAP Tagger tool in the Macromedia FreeHand Xtras toolbar. - The MAP Tagger Tool dialog appears.

3. Set the Layer to that of the file you just imported, the Feature to Area, and the Column to FSA.

4. Click on the “Enable Line” checkbox to enabled a leader line to be created by clicking on a feature and dragging the cursor to where you want the text to appear. When working with lines, you can select “Follow Lines” to have your text follow the direction of the associated path and/or “Keep text above lines” to ensure that all labels are placed rightside-up.

5. Click OK to exit the dialog and then click on map features to label them.

Note: In order to label an area by this method, you must click on the area’s boundary unless the area has a fill. If the area has been filled then a label may be placed by clicking anywhere inside the area.

Note: Features that have been grouped must be ungrouped prior to being labeled.

Tip: The MAP Tagger Tool may also be used to label or query legend elements. To label or query a legend element simply follow the procedure above, using values that pertain to your particular legend, and then click on the legend element you wish to label or query.
GRID GENERATOR

The MAPublisher Grid Generator is the principal Xtra used for creating a grid for your map. It is also the first step in creating a map index as the Make Index Xtra operates based on grid cells created using this Xtra. To access the MAPublisher Grid Generator Xtra select Xtras ➔ 3. MAP Legend ➔ Grid Generator.

There are several different options for making grids with the MAPublisher Grid Generator and it is therefore very important to become familiar with the various parameters of the Xtra’s operation and the Grid Generator dialog itself. Each grid has the following parameters:

- lower left X/Y co-ordinates.
- upper Right X/Y co-ordinates.
- number of columns and rows of the grid.
- size of each grid cell (X by Y).
- units that the grid cell sizes are to be based on.
- what the grid is made with (lines or rectangles).
- number of vertices to be used in the creation of grid lines.

The MAPublisher Grid Generator also contains options to generate index labels for your map. The “Generate Index Labels” checkbox must be checked in order for your grid to be used by the Make Index Xtra. Grid labels can only be placed on a grid made with rectangles – the option will be unavailable if Lines is selected. The Make Index Xtra and the steps for creating an index are covered in detail later in this section on pages 74-76.

Please familiarize yourself with the Grid Generator dialog by reviewing the following diagram.
Creating Grids

For the purpose of explaining the use of the MAPublisher Grid Generator two distinct examples are provided in the following sections. These are only two of the many possible configurations for creating grids using the Grid Generator. MAPublisher allows grids to be created in page units or map units. Use page units when you want to specify the grid corners and cell sizes in page units (ie. a corner at 8”, 11.5” with a cell size of 1 in²). Use map units when you want to specify the grid corners and cell sizes in map units (ie. a corner at 180°, 90° with a cell size of 100 km²). We encourage the experimentation with other configurations in order to better understand how the Xtra operates.

Generating a Grid - Ex. 1 (Map Units; Auto Calculate Grid Cell Numbers)

1. Import the world.mif file from the tutorial_data folder on your MAPublisher CD.
2. Create a new blank layer for the grid you are about to create.
3. Using the Add Map Parameters Xtra, assign geo-referencing information to the new layer (See Add Map Parameters, page 77). The referencing information should match that of the map, so use the “or same as” option and select the layer that has the world.mif file on it.
   - Geo-referencing information is invisibly added to the blank layer.
4. Define the visual parameters for the grid by setting the colour fill to “none” and choosing a stroke colour and line weight.
5. Using the MAP Location Tool, record the co-ordinates of the point where you want the upper right of your grid to be (See MAP Location Tool, page 34). The location should be (180,90).
6. Make sure that the layer you want to place the grid on is selected and unlocked and select Xtras ➔ 3. MAP Legend ➔ Grid Generator.
   - The MAPublisher Grid Generator dialog box appears.
7. Leave the “Units” type at the default of “Map Units”, “Lines/Rectangles” at the default of “rectangles” and increase the “Vertices” to 10.
   - If you plan to reproject your map later you may need to enter a higher number of vertices in order to achieve curved grid lines after the reprojection. (See Projection Editor, page 49) You can also add vertices later by using Xtras ➔ Distort ➔ Add Points.
8. Place the values you recorded in step 5 into the “Upper Right X/Y:” text boxes. Notice that the “Lower Left X/Y:” co-ordinates are already set to the lower left extent of your map.
9. Leave the “Cell Size” units at the default of “meters”.
   - Select alternative units from this dropdown only if your data is projected and you want to calculate cell sizes with real-world sizes. If your data is in lat/long, as in this example, leaving this dropdown at the default value will enable you to plot cells with distances in degrees.
10. Enter 15 for each of the “Cell Size X” and “Cell Size Y” values.
    - As the data is unprojected these values are in degrees and will result in a grid that has lines placed at 15° intervals.
11. Using the dropdown list, select “Grid Cell Numbers” and then click Calculate.
    - The number of grid cells is calculated based on the other parameters.
12. Click on the “Generate Index Labels” checkbox and click the “Place off grid” radio button.  
- The “Generate Index Labels” options are enabled. If this step is optional however if it is 
performed, index labels will appear along the X and Y axis of your map. The “Place off grid” 
button locates the labels outside the grid. For more on indexing see page 74.

13. Click **OK** to process the grid generation based on the entered parameters.  
- A grid is placed on the map based on your specifications. The grid lines are placed at 15 
degree intervals and each cell carries an alpha-numeric identifier.

**Generating a Grid – Ex. 2 (Page Units; Auto Calculate Grid Upper Right)**

1. Import the world.mif file from the tutorial_data folder on your MAPublisher CD.
2. Create a new blank layer for the grid you are about to create.
3. Make sure that the layer you are placing the grid on is selected and unlocked and select 
Xtras ➔ 3. MAP Legend ➔ Grid Generator.  
- The MAPublisher Grid Generator dialog box appears. Note that as this grid is being based 
on page units it is not necessary to run the Add Map Parameters Xtra on the grid layer 
before proceeding.
4. Click the “Page Units” radio button.  
- The grid will now be based on page units. The “Cell Size Units” dropdown list is disabled.
5. Enter 10 for the number of grid rows and 10 for the number of grid columns in the “columns” 
and “rows” text boxes.
6. Enter 60 for the width and 40 for the height of each grid cell in the “Cell Size X/Y:” text boxes.  
- This will create cells that are 60 pts wide & 40 pts high and assumes that your page is set 
up with points as the page units.
7. Using the dropdown list, select “Grid Upper Right” and then click **Calculate**.
- The grid’s upper right extent is calculated based on the other parameters.

8. Click the “Lines” radio button and enter 10 in the “Vertices” text box.

9. Click **OK**.
- The Grid Generator dialog box closes and a grid is placed on the map.

---

**Grid Generator dialog after all values have been entered**

(page units, auto calculate grid upper right)

---

The world.mif file after creating a line grid using page units and auto calculate grid upper right.
MAKE INDEX

The MAPublisher 5.0 Grid Generator Xtra contains an option to generate an index for your map. In order to facilitate the creation of a map index using this Xtra you must check the “Generate Index Labels” option before creating your grid. Doing so allows the grid structure to be used by the MAPublisher Make Index Xtra.

Several options are available for the index labels that will appear along the frame or in the cells of your grid. Grid cells may be referenced by row then column, or by column then row. As well, the columns can be set to be labeled numerically and rows alphabetically, or vice versa. Finally, there is an option to have the labels placed within each grid cell or simply have each row and column labeled outside of the grid. It is also possible to specify how far from the grid you want external labels to be placed.

Grid labels can only be placed on a grid made with rectangles. The index option will be unavailable if “Lines” is selected.

The MAPublisher Make Index Xtra allows an index to be created based on either a map’s text labels or its features.

Text label based indexing works by referencing the grid cells where each of the labels are found. For example, if the label “Toronto” was found in the grid cell “B-5” the entry in the index text file would appear as follows:

Toronto  B-5

Any other labels would appear in the file the same way.

Feature based indexing will produce a much larger index because instead of just referencing the grid cells where the labels have been placed, every grid cell that the feature being labeled passes through is referenced. For example, if the label “Toronto” was labeling an area, every cell that contained a part of that area would be referenced and entries in the index text file might appear as follows:

Toronto  A-4
Toronto  A-5
Toronto  B-4
Toronto  B-5
Toronto  B-6

Any other labels on the map would have their associated feature referenced in the same way.

The index must be based on an existing grid layer so that the text or map features can be referenced. After running the Make Index Xtra a text file is generated to store the index. This file can then be placed in a FreeHand text box on your map.

**Note:** In order to create an index using either of these options, your map must be labeled using either of MAPublisher’s labeling tools or by adding text defaults to text that you entered using FreeHand’s text tools (see Add Text Defaults, page 78). Normal FreeHand text and unlabeled features will not be indexed.

**Note:** When using the Make Index Xtra the map grid must be on a separate layer from all other map data.
Please familiarize yourself with the elements of the MAPublisher index functions by reviewing the diagrams below.

Creating an Index

1. Perform all of the steps from the first example for the Grid Generator on page 71.

2. Apply labels to several or all of the countries according to the steps outlined in the section on labeling (see Feature Text Label or Map Tagger Tool, pages 67-69).

3. Select Xtras ➔ 3. MAP Legend ➔ Make Index.
   - The Make Index dialog box appears.

4. Click the “Text Objects” or “Features” radio button and set the “Layer” dropdown list to the layer containing the labels you created earlier. Set the “Grid Layer” dropdown list to the layer containing your grid.

5. If desired, you can check the “Remove Duplicate Entries” and/or the “Include Layer Name” boxes. The “Remove duplicate entries” option removes any duplicate entries from the file (i.e. If a feature is labeled twice and each label is in the same grid cell, only one entry will be made). The “Include Layer Name” includes the name of the layer with every entry in the file.
6. Decide what kind of delimiter you wish to use as well as how you want the file to be sorted and check the appropriate radio buttons.  
   - The delimiter is what separates each field in the file. The file can be sorted by feature name (the file is sorted by the label itself, then the grid cell address, then the layer name (if present), by grid cell (the file is sorted by the grid cell addresses, then the labels, then the layer name or it can be sorted by layer name).

7. After all of the options have been set, click on the Save As button.  
   - The Save File dialog box appears.

8. Name your index and click the Save button.  
   - Both dialog boxes close and a text file is created based on the specifications entered in the Make Index dialog box.

![Index file in Notepad](image)

This is a sample index file being viewed in Notepad. The index was text-based, custom-delimited and sorted by feature label.

9. The index you have just created may be inserted into your map document by creating a FreeHand text box and using the Import command. Please refer to your Macromedia FreeHand user guide for more information on importing and inserting text.

![World map with grid layer and index](image)

The world.mif file with a grid layer and a placed index.

**Note:** When using featured-based indexing you cannot freely edit the feature labels once they have been placed. Labels that have been edited will not appear in the index text file created by the MAPublisher Make Index Xtra when feature-based indexing is used.
MAP CREATION

The Add Map Parameters and Assign Area/Line/Point/Text Defaults Xtras are used to create FreeHand layers and graphic elements with geo-referencing information and/or attribute data from non-GIS vector data. These Xtras essentially apply MAPublisher intelligence to normal FreeHand artwork and layers. The Add Map Parameters Xtra is used to give ungeo-referenced FreeHand layers geo-referencing data similarly to the way in which geographic parameters are automatically assigned when a GIS file is imported. The Assign Area/Line/Point/Text Defaults Xtras are used to make objects that are not MAPublisher-aware or recognized by MAPublisher into MAPublisher objects. Once an object has become a MAPublisher object, it can be given attributes using the MAP Columns and MAP Attributes Xtras.

These Xtras are also necessary to perform other MAPublisher operations such as index generation and legend creation.

ADD MAP PARAMETERS

The Add Map Parameters Xtra allows you to add geo-referencing information (map anchors, scale etc.) to any FreeHand layer. An ungeo-referenced map can be given proper referencing information very easily so that it can be manipulated as a normal map file.

Please familiarize yourself with the elements of the MAPublisher Add MAP Parameters dialog by reviewing the diagram below.

Adding Geo-Referencing Information to an Ungeo-Referenced Map

1. Open the toronto.FH10 file from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras ➔ 4. MAP Creation ➔ Add MAP Parameters.
   - The MAPublisher Add MAP Parameters window appears.

3. Enter the map anchors in the “Map Anchor X/Y” fields. For this example, use -79.411893 and 43.611883, which are the lat/long co-ordinates for that portion of Toronto.

4. Select your the units of your map from the “Units” dropdown list. Select “meters” for this example.
5. Enter the scale of the map in the “Scale” field. For this example, use 0.235123.

6. Click the “Apply to all layers” checkbox so that the geo-referencing information is assigned to all layers in the document.

7. Click OK.
   - The map now has geo-referencing information.

If you wish to create a new FreeHand layer within a map document that has pre-existing geo-referenced layers, use the “same as” function to apply scale and page values to the new layer based upon the pre-existing layer.

ASSIGN AREA, LINE, POINT OR TEXT DEFAULTS

MAPublisher will not automatically recognize newly created (not imported) graphics as MAPublisher map objects. Graphics such as these need to be made MAPublisher-aware for object management (editing or updating) and use with the MAPublisher Xtras. This is done by assigning feature defaults to such elements. These Xtras can be used in many different situations, such as:

- For a layer that has no existing attribute information, attribute tables can be created and attribute values added.
- For a layer that has attributes associated with it, new features can be added to the layer and matching attribute fields can be applied to each of the newly created graphics.
- In the creation of legend elements, areas, lines, points, or text may be made MAPublisher-aware and thus able to be used in the creation of a legend (see The Assign Legend Info Xtra and the Auto Assign Legend Info Xtra, pages 57-59).
- For the creation of an index for a map that was not created with MAPublisher, labels can be made MAPublisher-aware and thus able to be used by the Make Index Xtra.
- For digitizing a scanned map and converting it to a geo-referenced map file.

Assigning Area, Line, Point or Text Defaults

1. Select the artwork that you want to become MAPublisher objects - area, line, point or text.

2. Select Xtras ➔ 4. MAP Creation ➔ Assign Defaults (Area, Line, Point or Text).
   - MAPublisher now recognizes these objects for performing MAPublisher operations. You can now add new columns and attribute data to the features or use them in the creation of a legend or index.

Note: MAPublisher Defaults can be assigned to only one feature type at a time. For example, you cannot assign line defaults and area defaults to a group of lines and areas at the same time. You must first select one feature type and assign defaults to that group of art objects and then proceed to the next one(s).

The Assign Area/Line/Point/Text Defaults Xtras function invisibly when executed. As such you will not see any visible change to your document or workspace after executing either of these Xtras. However, if you open the MAP Attributes window you will see that the features to which Assign Defaults have been applied now have attributes associated with them.
SELSTATS

The MAPublisher SelStats window (Xtras ➔ 8. MAP Windows ➔ Show/Hide SelStats) keeps track of the total number of each type of map feature there are on a given layer, as well as how many of each feature type are selected at any given moment. It can be used to select all of a particular feature type or to reverse a particular selection. A selection of features can also be saved and recalled at a later time.

The MAPublisher SelStats function only counts MAPublisher objects. Objects that have been imported using MAPublisher will be automatically recognized by the SelStats function. You will have to use the Assign Area/Line/Point/Text defaults functions (see page 78) to make a non-MAPublisher object into a MAPublisher object in order to have it appear and be counted in the SelStats window.

Tip: The MAPublisher SelStats function is an excellent way to determine if all your drawn objects have been properly converted to MAPublisher objects using the Assign Area/Line/Point/Text defaults functions.

Please familiarize yourself with the elements of the MAPublisher SelStats dialog by reviewing the diagram below.

Using the SelStats Window

1. Import any map file from the tutorial_data folder on your MAPublisher CD.

2. Select a portion of the map’s features.

3. Select Xtras ➔ 8. MAP Windows ➔ Show/Hide SelStats.
   - The SelStats window appears. The total number of features and the number of features that are selected are displayed.

4. Click the R button beside the feature type that you have selected.
   - The selections made in step 2 are reversed.

5. Click the A button beside any of the feature types that exist on the layer in your document.
   - All the features of that type (line, point, area or text) are now selected.
ARC FUNCTIONS

MAPublisher contains two tools and Xtras for working with map line segments, also known as arcs. The MAPublisher Arcs Xtras can be found under the Xtras → 6. MAP Arcs menu.

JOIN ARCS

The Join Arcs Xtra lets you join a set of linear features based on a common value within an attribute column. For example, it may be desirable to join all segments of a particular street by the common attribute of street name in order to create a single line element representing that street. When the Join Arcs Xtra is run a new layer is created containing the joined lines in order to avoid deleting other attributes within the original street layer. The new layer contains the joined lines with an attribute column representing the joined column. All other attributes that were present in the pre-joined layer will not be present in the new layer. The Join Arcs Xtra is very useful for reducing the size of a data file by joining related lines and thus reducing the number of segments and associated data present in the file. It is also very useful to run the Join Arcs Xtra prior to running the Feature Text Label Xtra in order to eliminate the occurrence of duplicate labels.

Joining Arcs

1. Import the torontostreets.mif file from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras → 6. MAP Arcs → Join Arcs.
   - The MAPublisher Join Arcs window appears.

3. Set the “Column” dropdown list to Street in order to join the lines by their street name value.

4. Enter “joined streets” in the “Output Layer” text box. This will be the name of the new layer containing the joined lines.

5. Enter .0001 in the “Proximity” text box.

   *Note: When working with data in lat/long the proximity factor is a very small number.*

6. Check the All Arcs radio button to choose to join all the arcs on the layer.

7. Click OK.
   - A new layer is created wherein all the specified arcs are joined based on the specifications set in the dialog.

   *Tip: A proximity factor of 0 will only join arcs that are touching.*
SIMPLIFY ARCS

The MAPublisher Simplify Arcs Xtra allows for the simplification or generalization of imported vector data based upon map or page units. The MAPublisher Simplify Arcs function uses the popular Douglas-Peucker algorithm for removing nodes and vertices during the simplification process. For more information on the Douglas-Peucker algorithm please see Appendix 1, page A1-28.

Simplify Arcs is used to reduce the number of points required to represent a vector-encoded digitized line where the lines are approximated by a stream of X-Y co-ordinates. The MAPublisher Simplify Arcs function can be used on line or area features and removes nodes based upon a proximity value in either map or page units.

The simplify tolerance (proximity value) is based on the vertical difference between the begin-end line and points off a line, NOT the distance between anchor points on the line. This is where the Simplify Arcs function differs from the Grain function found within the MAPublisher Import Map Xtra. The Douglas-Peucker algorithm takes the proximity value you give it and iterates through the line vertices to determine the points which fall within the specified tolerance distance off the line and removes those vertices. Once all vertices are determined to be greater than the proximity value off the line the processing ends. A smaller proximity value will result in a fewer number of nodes being removed.

Tip: It is always a good idea to experiment with different proximity values in order to achieve the desired results particular to your scale and coverage area.

The MAPublisher Simplify Arcs Xtra can be found under Xtras → 6. MAP Arcs. Please familiarize yourself with the MAPublisher Simplify Arc dialog by reviewing the diagram below before trying the example on the following page.

![The MAPublisher Simplify Arcs dialog.](image)

Note: Bezier curves will not export as curved lines to any of the GIS data formats supported by MAPublisher.
Simplifying Arcs

1. Import the riverskm.shp file from the tutorial_data folder on your MAPublisher CD with the Map Units set to kilometers.

2. Select all of the arcs in the “riverskm” layer and select Xtras ➔ 6. MAP Arcs ➔ Simplify Arcs.
   - The MAPublisher Simplify Arcs dialog appears.

3. Set the “Feature Type” radio buttons to “Line” as the artwork in this layer consists of arcs or lines. The MAPublisher Simplify function can also be performed on area or polygon features.

4. Check the “Selected Arcs” radio button to indicate that the simplify function is to be performed on the selected features only.

5. Check the “Map Units” radio button in the “Proximity” section of the dialog, set the “Units” to “kilometer” and specify a “Proximity” value of 25.
   - This will set the simplification parameters to remove nodes that are less than 25 kilometers apart in map units.

6. Check the “Use Bezier Curves” option if you want the simplification process to incorporate Bezier curves.

7. Click OK to start the simplification process.
   - The selected arcs are now simplified based on a proximity value of 25 kilometers. Data can also be simplified using a proximity value in page units.

Section of the riverskm.shp file in Macromedia FreeHand both before (left) and after executing the MAPublisher Simplify Arcs function with a proximity value of 25 km. Notice the significant reduction in the number of vertices and resulting loss of detail. These screenshots were taken at more than a 300% zoom level. At 100% the reduction in detail is not as noticeable.
WORKING WITH TABLES

MAPublisher includes several Xtras and tools for importing and viewing external data tables and for joining external tables with pre-existing map attribute tables. If, for example, you had a map of areas representing postal zones and an external data file containing sales or population figures by postal zone, the MAPublisher table Xtras would be used to import the external file and join it with the pre-existing postal zone map so that the sales or population figures would form part of the map attributes table for that layer.

IMPORT A TABLE

The MAPublisher Import a Table Xtra lets you import external data tables to merge with existing map data attribute tables in order to create a single extended table comprised of the elements of both tables. The MAPublisher Import a Table Xtra provides support for three of the most common table formats as follows:

- DBase files (.dbf)
- USGS SDTS files (.ddf)
- ASCII Comma Delimited files (.csv, .dat, .txt, etc.)

Familiarize yourself with the Import a Table dialog by reviewing the diagram below.

File Type - Select the type of file you are going to import. The options are DBase, .ddf (SDTS), and ASCII comma delimited.

File Name - This is where the name of the file that you have selected will be displayed.

Table Name - Enter the name you wish to use for your table here. Note that it can not have spaces in it.

Process field header on 1st Line - In an ASCII comma delimited file, you may or may not have field headers in the first line of the file. If you do, checking this box will allow the headers to be used.

Note: With the ASCII Comma delimited import option all columns are named “Column 1”, “Column 2” ...... etc. unless a header is present in the file containing actual column names and the “Process field header on 1st line” box is checked.

Note: Table names may not have spaces in them. Use the underscore (_) instead. For example, use “population_counts” rather than “population counts”.
Importing a Table

1. Select Xtras ➔ 7. MAP Tables ➔ Import a Table.
   - *Import Table screen appears.*

2. Set the “File Type” dropdown list to ASCII comma delimited.

3. Click the Select button and select the avg_inc.csv file from the tutorial_data folder on your MAPublisher CD.

4. The default table name will be the same as the file’s name. You may change this by typing a new name into the Table Name field. The table name cannot include spaces. Everything after the first space will be left out.

5. Click the “Process field header on 1st line” checkbox so that the column headings contained in the first line of this file are used as column headers in the MAPublisher table.

6. Click OK.
   - *The table is imported to a layer called “MPTables”. The table may be accessed using the Table Columns and Table Records Xtras (see Table Columns and Table Records, pages 88-89)*

![Layers panels before and after adding MPTables layer]

The contents of the imported table are stored in a layer called MPTables.

*Note: The first time a table is created or imported a new layer is created in the FreeHand layers panel with the default name “MPTables”. This is where MAPublisher stores all tables that have been imported or created by the user. Deleting the MPTables layer will result in the deletion of all currently stored tables.*
CREATE A TABLE

MAPublisher lets you create your own custom tables to merge with existing map data attributes. New tables can have new columns/records added by using the Table Columns and Table Records Xtras.

Creating a New Table

1. Select Xtras ➔ 7. MAP Tables ➔ Create a Table. - The New Table window appears.
2. Enter a name for the table into the “Name” field.
3. Click OK. - The new table is created on the “MPTables” layer.
4. After creating the new table use the Table Columns Xtra (page 89) to add new columns to the table. Use the Table Records Xtra (page 88) to add, edit and view the table’s records.

DELETE A TABLE

MAPublisher lets you easily delete any previously imported or created tables.

Deleting an Existing Table

1. Perform all of the steps from the “Create a Table” or “Import a Table” examples.
2. Select Xtras ➔ 7. MAP Tables ➔ Delete a Table. - The Delete Table window appears.
3. Select the table that you created in step 1 from the “Table” dropdown list.
4. Click OK. - The selected table is deleted from the “MPTables” layer.

Note: The “MPTables” layer will not be deleted by MAPublisher even if all the tables have been deleted. If desired, the “MPTables” layer may be removed manually using the FreeHand remove layer function.
JOIN A TABLE

The MAPublisher Join a Table Xtra joins an imported or created data table to a selected target layer based upon common or matching fields/columns. The matching columns are not required to have matching names.

Please familiarize yourself with the elements of the MAPublisher Join Table dialog by reviewing the diagram below.

Linear Match vs Ordered Match - Setting the match radio button to "Linear Match" will result in a slower matching process than setting it to "Ordered Match" but the table and layer do not have to be sorted first. Ordered Match is faster but requires that the records in both the source table and target table are pre-sorted on the Match Columns so that like (matching) values are in the same position.

Joining an External or Created Table to a Map Attribute Table

In this example you will be joining an imported comma-delimited file containing average income information with an existing GIS file containing residence and business counts. The attribute common to both files is postal zone (FSA).

1. Import the fsatoronto.mif file from the tutorial_data folder on your MAPublisher CD.

2. Import the avg_inc.csv table from your MAPublisher CD (see Import a Table, page 83).

3. Select Xtras ➔ 7. MAP Tables ➔ Join a Table. 
   - The MAPublisher Join a Table Window appears.

4. Set the “Source Table” dropdown list to the “avg_inc” table.

5. Set the “Match Column” dropdown list to “FSA”. This is the imported table's data column that is common to a column in the map layers's attribute table.

6. Click on the “Linear Match” or “Ordered Match” radio button as desired. Linear match is slower but does not require that the match column be sorted. Ordered Match is faster but the match column must be sorted the same way in the imported table as in the map attribute table.
7. Set the “Target Layer” dropdown list to “fsatoronto”.

8. Set the “Target Feature” dropdown list to “Area”.

9. Set the second “Match Column” dropdown list to “FSA”. This is the attribute column that is common to a column from the table.

10. Click OK.
- The imported table will be joined with the attribute table. To view the changes, open the MAP Attributes window and select some or all of the map’s features (see MAP Attributes, page 35).

```
<table>
<thead>
<tr>
<th>FSA</th>
<th>Area</th>
<th>FSA</th>
<th>Agri</th>
<th>MFA</th>
<th>78</th>
<th>0</th>
<th>0.06403</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Before joining tables.

```
<table>
<thead>
<tr>
<th>FSA</th>
<th>Area</th>
<th>FSA</th>
<th>Agri</th>
<th>MFA</th>
<th>78</th>
<th>0</th>
<th>0.06403</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

After joining tables.

Notice how the new FSA column name has a “J” appended to it. This differentiates the column from the original FSA column in the map attribute table.

New columns.

Your map layer attribute table should look similar to the one above after the join has been completed.

### Joining SDTS Tables

When working with United States Geological Survey SDTS files it is necessary to join tables frequently in order to obtain the map attribute table you require to make the map you want. This is due to the fact that SDTS data is constructed such that the primary vector data is held separately from the various attribute tables that one might want to use for a particular mapping purpose. The attribute table that comes as part of the vector file usually contains a unique identifier (RCID) for each map element that is used to join it with the other data tables. For example, a particular vector file containing the geography of rivers would contain a data column called RCID. Various data tables containing information such as vegetation, fish counts or flow rates might be available each also with an RCID column. The desired tables are then joined to the initial map attribute table by RCID value using the techniques described in the previous pages.

To find the SDTS tables to join with the vector map file look for the files which have names that start with the same character string as the name of the vector file. MAPublisher imports SDTS files that have the characters “LE” in the fifth and sixth positions of the file name (ex.HY01LE01.ddf). The LE stands for line entities and it is files of this nomenclature that contain the actual vectors. A typical table to import and join with this file might be called HY01ACOI.ddf. Use the MAPublisher table importer with SDTS file type chosen to import these files. When you join layer and table, you do the join based on the column from the layer matched to the RCID column of the table. Several SDTS sample files can be found on your MAPublisher CD in the SDTS_samples folder.

**Note:** The CATD catalog file found amongst the SDTS files explains what each table is.
TABLE RECORDS

The Table Records window displays the records for an imported or created table and lets you change them as desired. You can add new records and switch between viewing all records and viewing only the selected records.

Please familiarize yourself with the elements of the MAPublisher Table Records dialog by reviewing the diagram below.

Viewing, Editing and Deleting Table Records

1. Import the avg_inc.csv table from the tutorial_data folder on your MAPublisher CD (see Import a Table, page 83).

2. Select Xtras ➔ 8. MAP Windows ➔ Show/Hide Table Records.
   - The Table Records window appears.

3. To change the value of a field, double click (option-click on Mac) on it and enter the new value. Keep in mind that you must enter values that correspond with a column's type (ie. only type numbers into a column of type "Real" etc.). Randomly change some field values.

4. Click **Add**.
   - A new blank record is created.

5. Select a row by clicking on the row number and click **Del**.
   - The selected record is deleted.

6. Click **Apply** to commit the changes. Closing the window without clicking apply will discard any changes you made.

7. Using the Select Table Records Xtra, select a set of records to view (see Select Table Records, page 91).

8. Return to the Table Records window and click **Sel**.
   - Now only the selected records will be displayed in the window. The **Sel** button will become the **All** button. Click it to return to viewing all the records in the table.
TABLE COLUMNS

The Table Columns Xtra allows you to view, edit, and create new columns for an imported or created table.

Please familiarize yourself with the elements of the MAPublisher Table Columns dialog by reviewing the diagram below.

Adding a New Column to an Imported or Created Table

1. Import the avg_inc.csv table from the tutorial_data folder on your MAPublisher CD (see Importing a Table, page 83).

2. Select Xtras ➔ 8. MAP Windows ➔ Show/Hide Table Columns.
   - The Table Columns window appears displaying the columns associated with your table records.

3. Select Options ➔ New Column.
   - The Table Column window appears.

4. Enter a name for your column, as well as a type and a maximum length.

5. Click OK.
   - The new column is created and can be given values using the Table Records Xtra (see Table Records, page 88).

Deleting / Editing a Column of an Imported or Created Table

The functions to delete or edit a table column operate in the same way as do the same functions for MAP Attribute columns. Please see the section on deleting and editing MAP Attribute columns on pages 37-39. These functions may be accessed in the Table Columns dialog by selecting the Options button.
SELECT TABLE RECORDS

This Xtra is used to select a particular set of records from an imported or created table. It functions very similarly to the Select Map Attributes Xtra. Select Table Records contains the following options: Initial Selection, Add to Selection, Remove from Selection and Select from Selection and Reverse Selection.

Please familiarize yourself with the elements of the MAPublisher Select Table Records dialog by reviewing the diagram below.

Selecting Records From an Imported or Created Table

1. Import the avg_inc.csv table from the tutorial_data folder on your MAPublisher CD (see Importing a Table, page 83).
2. Select Xtras ➔ 7. MAP Tables ➔ Select Table Records.
   - The MAPublisher Select Table Record window appears.
3. Click on the “Initial Selection” radio button.
4. Set the “Table” dropdown list to “avg_inc” and set the “Column” dropdown list to “Average_Income”.
5. Set the “Comparison” and “Value A” dropdown lists to “Greater than” and “50729”, respectively.
6. Click Insert, then OK.
   - The records matching your criteria are selected. They can be viewed using the Table Records Xtra (see page 88).
OTHER TOOLS

MAP AREA TOOLS

MAPublisher 5.0 includes two tools for drawing rectangular and elliptical areas of specified dimensions in map units. By using the MAP Area tools, areas of exact map dimensions can be quickly added to any map document. This tool can also be useful for measuring distances from a specific location. The area and perimeter values for shapes created with the area tools will be displayed in the MAP Attributes table and will be highlighted in blue to differentiate them from other map objects. The reported units and size values will be directly related to the scale and units of the layer on which the area has been drawn. Whenever an area is created using the MAP Area tools, any objects that fall inside the area (in whole or part) will be automatically selected. Areas created using the MAP Area tools are special and will not be automatically recognized as MAPublisher areas. They can be converted to MAPublisher areas using the Assign Area Defaults Xtra (see page 78).

Note: In order for the area tools to draw properly and return real world value for the area and perimeter caption figures the layer must be projected (ie. not in lat/lon). See Projections & Transformations (pages 49-56).

Using the MAP Area Tools

There are two methods of using the MAP Area tools as follows.

1. Select the desired MAP Area tool from the FreeHand Xtras toolbar. Click and drag over the map document while holding down the left mouse button until the desired area has been outlined, as is done with the standard FreeHand area drawing tools. Use the Alt key (Windows) or the Option key (Mac) to draw from the centre and/or the Shift key to constrain the proportions. When you release the mouse button the area will be created.

2. Select the desired MAP Area tool from the FreeHand Xtras toolbar. Then click on a single spot in your document. The MAPublisher Add Area dialog will appear into which you can enter specific dimensions for the area to be drawn. When you click OK to accept the entered values an area will be drawn accordingly with its lower left corner at the spot where you initially clicked. If instead you wish to have the area centered over the click point simply check the “Draw From Center” box in the MAPublisher Add Area dialog.

Note: When using Area Tool method 2 the area and perimeter values displayed in the MAP Attributes table may be inconsistent with the values entered in the dialog due to floating-point rounding.

Note: Objects created by the MAP Area tools are not modifiable as art objects other than resizing.

The MAP Area tools are located on the FreeHand Xtras toolbar.

The MAPublisher Add Area dialog.
The MAPublisher MAP Copy/Paste Object function is designed to safely copy and paste MAPublisher objects between FreeHand layers while retaining the geographic and attribute characteristics of the objects. In order to perform a MAPublisher copy/paste operation one must use the MAP Copy/Paste Object functions which can be found under Xtras \rightarrow 11. MAP Copy Object in the main FreeHand menu bar. Copying and pasting MAPublisher objects using the native FreeHand copy and paste functions may result in the loss of attribute and geographic data for the objects involved. MAP Copy/Paste Object(s) will also allow for non-MAPublisher objects to be copied and pasted independently or in conjunction with MAPublisher objects.

Using MAP Copy/Paste

To select an object or group of objects for copying simply select the desired objects using any of the Macromedia FreeHand or MAPublisher selection tools and then select Xtras \rightarrow 11. MAP Copy Object \rightarrow Copy MAP Object(s). The objects will then be placed on the clipboard.

To paste the chosen object(s) to another layer select the destination layer from the FreeHand layers panel and then select Xtras \rightarrow 11. MAP Copy Object \rightarrow Paste MAP Object(s). The objects will then be placed on the destination layer. Pasted objects are placed in the same location on the document from where they were copied.

If the destination layer does not have any geographic parameters (scale, anchors, projection etc.) MAPublisher will automatically assign the same parameters as the layer from which the objects were copied.

Note: Objects may NOT be copied and pasted between documents using the MAP Copy/Paste Object(s) tools.

Note: MAPublisher objects may only be copied and pasted between layers that contain other MAPublisher objects if the attribute tables match (ie. all attribute columns must be the same on both layers).

Note: Objects that have been deleted prior to having been pasted on a new layer will not be copied to the new layer. If you wish to remove objects from the initial layer you must delete them AFTER pasting them to the new layer.

Note: Due to an internal Macromedia FreeHand limit, a maximum of 8192 items may be copied and pasted in one execution of the MAP Copy/Paste Xtras.
EXPORTING

EXPORT AS SHAPEFILE, MID/MIF OR ARCINFO EXPORT FORMAT

To view your map data files within a GIS environment, MAPublisher provides for the export to several popular geographic software formats, MapInfo and ESRI shapefiles as well as text only export to ArcInfo .e00 format. Exporting all or part of your FreeHand map document in a GIS format is an excellent way of getting your edited vectors back to the GIS format from where the original data came. All available export options are located under Xtras ➔ 9. MAP Export wherein each available export format has its own submenu item.

ArcView Shapefiles are binary files used to export data with attributes from both ArcInfo and ArcView. MAPublisher creates three files for every map layer exported: .SHP, .DBF and .SHX. MAPublisher 5.0 can export area, line and point data to ArcView Shapefile format.

MapInfo Interchange Format (mif) is an ASCII file format that fully describes a MapInfo database. MAPublisher 5.0 can export area, line, point and text data to MapInfo Interchange Format. Colours, strokes and projections are not supported in MAPublisher mid/mif export.

ArcInfo Export format (.e00) is also an ASCII file format. MAPublisher 5.0 only exports text to ArcInfo Export format.

Exporting Data into GIS File Formats

1. Import any of the GIS files from the tutorial_data folder on your MAPublisher CD.

2. Select Xtras ➔ 9. MAP Export ➔ Export as MapInfo mid/mif to activate the mid/mif exporter. 
   - The operating system “save as” window appears.

3. Set the save location and enter a desired file name.

4. Click Save.

5. Specify the document layer and feature type to be exported and click OK.
   - The Export window closes and the file is saved to the specified location as a mid/mif file. This file is now ready to be used in MapInfo or any other application that supports mid/mif import.

   - The operating system “save as” window appears.

7. Set the save location and enter a desired file name.

8. Click Save.

9. Specify the document layer and feature type to be exported and click OK.
   - The Export window closes and the file is saved to the specified location as a shapefile. This file is now ready to be used in Arcview or any other application that supports shapefile import.

10. Using the MAP Tagger Tool, label some of the features in your map document.
11. Select Xtras ➔ 9. MAP Export ➔ Export as e00 text.
   - The operating system “save as” window appears.

10. Set the save location and enter a desired file name.

11. Click **Save**.

12. Specify the document layer to be exported (the feature type will be defaulted to text and greyed out) and click **OK**.
   - The Export window closes and the text portion of the file is saved to the specified location as an e00 file. This text from your map document file is now ready to be used in Arcinfo or any other application that supports e00 import.

   **Note:** Not all FreeHand objects will be exported properly to every GIS application, especially curves, circles and ellipses. Additional vertices may be added to objects of this nature in order to maintain the integrity of the shape when exported. Use the FreeHand Xtras ➔ Distort ➔ Add Points command to add points to any selected path.

   **Note:** Only single individual layers can be export at a time to any of the supported GIS formats. If you have a multi-layer FreeHand file you must select the layer first and then select the desired export option.

   **Note:** Only a single feature type (area, line, point or text) may be exported at any given time. If you have a layer with multiple feature types you must export each type separately.
FILE FORMATS

GRAPHIC FILE FORMATS

DOQ

Digital Orthophoto Quadrangle (DOQ) geographic images from the United States Geological Survey (USGS) are stored in the JPG format. They can be imported by Macromedia FreeHand and registered by the MAPublisher Register Image Xtra. DOQ’s are usually very large files (30-40 MB or more) and will require extremely large amounts of RAM.

DRG

Digital Raster Graphics (DRG) are scanned images of published topographic maps from the USGS stored in TIF format. They can be imported by Macromedia FreeHand and registered by the MAPublisher Register Image Xtra. DRG’s are also usually very large files (30-40 MB or more) and will require extremely large amounts of RAM for any manipulation within FreeHand.

EPS

The Encapsulated Post Script (EPS) file is used to transfer PostScript language artwork between applications (also see PostScript in the glossary section of the User Guide). EPS files are easily opened by Macromedia FreeHand because the format is widely supported by most graphics programs. It is the preferred format for export to most illustration and page-layout programs. EPS files are by their nature vector based, but can contain embedded raster graphics and fonts.

FHxx

The Macromedia FreeHand (FH) native file format where xx is the version number. FreeHand MX files are denoted as fh11. Please refer to the Macromedia FreeHand User Guide for more information.

GIF

Graphic Interchange Format (GIF) is a colour-indexed graphics format, commonly used for web pages and image file transfer. Macromedia FreeHand can also export 8-bit indexed-colour or grayscale gif files.

JPEG, JPG

Joint Photographic Experts Group (JPEG or JPG) is a compression technique for raster file formats. The Digital Orthophoto Quadrangle geographic images from the USGS are stored in this format, which can be imported by Macromedia FreeHand and registered by the MAPublisher Register Image Xtra. DOQ’s are usually very large files (30-40 MB or more) and will require extremely large amounts of RAM.
Portable Document Format (PDF) is a standardized format developed by Adobe Systems Inc. for use across Macintosh, Windows, DOS, and UNIX platforms. Based on the PostScript Level 2 language, PDF supports both raster and vector graphics.

Tagged Image File Format (TIFF or TIF) is a common raster graphic file format that can be imported by Macromedia FreeHand. Many raster geographic images from GIS systems are stored in this format, which can be imported by FreeHand and registered by the MAPublisher Register Image Xtra. A GeoTIFF is a TIFF file with embedded geographic information identifying its position and scale in world co-ordinates.

Please refer to the Macromedia FreeHand User Guide for other graphics file formats supported by Macromedia FreeHand.

This section contains brief descriptions of the GIS formats supported for import by MAPublisher. You can also refer to the Frequently Asked Questions section in this guide for information on any issues associated with the various file formats. Following this section you will find a segment on other GIS Software with the formats that they export that are compatible with MAPublisher. As well, there is a reference on our web site at http://www.avenza.com/support.links.html where we have compiled a listing of some available GIS data format translators. Also see File Formats on pages 15 to 17.

ArcInfo Export Files

ArcInfo Export (e00) is a transfer format, either ASCII or compressed into binary, which is used to transfer files between different versions of ArcInfo. It is a commonly found format for freely distributed data such as that found at the GIS Data Depot (http://www.gisdatadepot.com). Also see page 15 for more information on this format.

ArcInfo Ungenerate Files

ArcInfo Ungenerate files are ASCII co-ordinate files created from ArcInfo coverages through the use of the ArcInfo Ungenerate command. Ungenerate is a useful mechanism that allows you to transfer ArcInfo GIS data to MAPublisher. These files contain the user/cover–ids for line, point or polygon features. If you have a unique numeric value or feature code that you wish to use in MAPublisher, simply calculate the user/cover–id to that value or code. For example, if the cover is called lakes, use the ArcInfo command: Calculate Lakes–id = ‘your feature code’. Remember to do this before running the Ungenerate command. If any of the cover–ids are equal to zero, the Ungenerate function ignores the associated graphics and excludes them from the Ungenerate file. Also see page 15 for more information on this format.
ArcView Shapefiles

ArcView shapefiles are binary files used to export data with attributes from both ArcInfo and ArcView. From ArcInfo the command at the ARC level to create a shape file is ‘arcshape’. MAPublisher requires three files for every map layer to be imported:

xxxx.shp - this file contains the vector information
xxxx.dbf - this file contains the attribute information
xxxx.shx - this file is a cross reference file for the .shp and .dbf files

If any of the three files are missing the file will not import properly. To export annotation/text out of ArcInfo for import into MAPublisher use the ArcInfo export to DXF format or ArcInfo export format (e00). Also see page 16 for more information on this format.

AutoCAD DXF

AutoCAD DXF is an ASCII file format exported by many CAD programs including AutoCAD. MAPublisher currently supports the AutoCad DXF format up to Rev 14. Not all DXF formats are the same. See the Frequently Asked Questions section in this guide for some of the issues that you may encounter with work-arounds where available. Also see page 16 for more information on this format.

MapInfo MID/MIF

According to the MapInfo Professional Reference manual, “MapInfo Interchange Format (MIF) is an ASCII file format that fully describes a MapInfo database. Both graphic and tabular data are exported into mif files. The graphic data is in a file with a “.mif” extension, and the tabular data is in a file with a “.mid” extension.” When exporting from MapInfo, you (or your data provider) should specify the type of file export to perform as being MapInfo Interchange Format MIF (default). The export facility will generate both the “.mif” and “.mid” files.

Mif files contain all the vector data and mid files contain all the attribute data. When you select a mif file, the associated mid file is automatically added to the appropriate entry in the MAPublisher Import dialog. Selecting a mid file instead of a mif file causes the import process to fail. With MapInfo, users often work with latitude and longitude (lat/long) map co-ordinates. Also see page 16 for more information on this format.

MicroStation DGN

MicroStation Design Files or DGN (.dgn) are the native files created by Bentley Systems Inc.’s MicroStation product. MAPublisher 5.0 supports the import of MicroStation J, SE and 95 version DGN files. For more information on DGN format files as they relate to use with MAPublisher see page 17 of this user guide.

USGS DLG - Optional

Digital Line Graph (DLG) is a USGS standard file format which consists of feature information in digital vector form. These files include information on planimetric base categories such as transportation, hydrography, and boundaries. MAPublisher currently imports the Optional distribution format, which is usually in meters in the UTM co-ordinate system. This file format will have the extension “.opt” or “.do”. Also see page 17 for more information on this format.
USGS DLG - SDTS

Spatial Data Transfer Standard (SDTS) is a standardized format used by the USGS for transferring earth-referenced spatial data between dissimilar computer systems that includes support for the inclusion of spatial data, attribute, geo-referencing, data quality report, data dictionary, and other supporting meta-data within a single file transfer format. Files in the SDTS format will have the extension .ddf. See the body of this manual for procedures on how to handle and work with this complex format. Also see page 17 for more information on this format.

For more information on USGS data formats visit the USGS website at http://www.usgs.gov

MAPUBLISHER COMPATIBLE EXPORT FORMATS

The list below provides a quick reference guide for transferring data between various GIS programs and Macromedia FreeHand via MAPublisher. The bold items list several of the most common GIS software products and the unbold items list the corresponding export format that is supported by the MAPublisher Import Map Xtra. There are also a number of file format translators available including FME from Safe Software (www.safe.com).

**ArcInfo**: Ungenerate, Shapefile, ArcInfo Export

**Arcview**: Shapefiles

**Atlas**: AGF output with translator to shape (PC only) on the ESRI website at www.esri.com

**AutoCAD/AutoCAD Map**: MapInfo Interchange Format (mid/mif), DXF

**ESRI Business Map**: Shapefiles

**Geomedia**: DGN, DXF, mid/mif, shapefile

**Intergraph**: DXF

**MapInfo**: MapInfo Interchange Format (mid/mif)

**TIGER**: Tiger2Mif or Tiger2Shape (www.gistools.com)

**TransCAD**: MapInfo Interchange Format (mid/mif), shapefile

**Manifold**: DXF, e00, mid/mif, shapefile

**Maptitude**: DXF, mid/mif, shapefile

**MicroStation**: DGN
FREQUENTLY ASKED QUESTIONS (FAQS)

This section presents a number of frequently asked questions (FAQs) regarding the use of MAPublisher. If the answer to your particular question is not included here please consult the online FAQs at http://www.avenza.com/freezone/freezone.faq.html or the online MAPublisher Knowledge Base at http://www.avenza.com/support.kb.html. In addition, there is a valuable GIS FAQ database put out by the US Census Bureau at: www.census.gov/geo/www/faq-index.html

INSTALLATION ISSUES

I have installed MAPublisher but nothing shows up in the FreeHand Xtras menu.

You have likely installed MAPublisher to an incorrect location. Do a search on your hard drive for the MAPublisher Xtras in order to determine where you have actually installed them and then simply move the MAPublisher 50 folder into your Macromedia FreeHand 10 or MX Xtras folder. You can also rerun the MAPublisher installer and this time direct it to the correct location of your FreeHand 10 or MX Xtras folder.

All the MAPublisher Xtras are in the Xtras folder but they do not all show up in Macromedia FreeHand.

Try exiting out of Macromedia FreeHand, deleting the Macromedia FreeHand preferences file and then restarting Macromedia FreeHand:

- In Windows the preferences file is most often found as follows:
  - FreeHand 10: C:\Program Files\Macromedia\FreeHand 10\English
  - Freehand 10.01: C:\Documents and Settings\username\Application Data\Macromedia\FreeHand\11\English\Settings
  - FreeHand MX: C:\Documents and Settings\username\Application Data\Macromedia\FreeHand MX\11\English\Settings
  Depending upon your version of Windows it may also appear in C:\Windows\Application Data\Macromedia\FreeHand MX\11\English\Settings folder. In all cases it is named fhprefs.txt.
- On the Macintosh platform the preferences file is most often found as follows:
  - FreeHand 10.x: Applications\Macromedia FreeHand 10\English
  - FreeHand MX/OSX: Users\username\Library\Application Support\Macromedia\FreeHand MX\11\English\Settings
  - FreeHand MX/OS9: System Folder\Application Support\Macromedia\FreeHand MX\11\English\Settings

The MAPublisher Enter Security Code Xtra does not accept my keycode.

When you purchase MAPublisher, you will receive a keycode for each license. These keycodes have the following format: MPxxyz-*************. In total there are 23 alpha-numeric characters and a dash (-). When entering the code please note that the keycode is case sensitive and that the dash (-) must be included.
MEMORY & SPEED ISSUES

Why do I need so much more memory (RAM) than I do with my GIS?
The graphics environment of Macromedia FreeHand loads the entire file into memory rather than just reading it from disk, thus more memory is required. MAPublisher builds a mini-GIS application inside FreeHand so that it can geo-code information and attach data to objects. This also has some overhead. When you are importing a lot of files with MAPublisher into FreeHand, you’ll notice that the amount of available memory will decrease rapidly and your computer loses speed. This is due to the memory management. MAPublisher reserves a fairly large amount of memory for each import-action, which is not always returned when the import is done. The solution is simple: save your file, close it and open it again. It’s not even necessary to close FreeHand itself. By closing the file the reserved memory is properly returned.

How can I improve the speed of my data import?
Many GIS data files are large and when a series of such files is imported, you may find that the import Xtra starts to run more slowly. This is because scratch and memory allocations are being used up. Try the following suggestions:

- Periodically save your work then close and reopen the file. This will free up the available scratch memory.
- Reduce the maximum number of undos in FreeHand, since they all reside in memory.
- Set a grain value on import to drop redundant data points.
- See the Memory Considerations section for other suggestions, pages A1-15 & A1-16.

DATA IMPORT ISSUES

Why do my files appear squashed after import?
They are probably stored in geographic or lat/long co-ordinates. Data in lat/long often looks “squashed”. You can project them into an alternate map projection using the MAPublisher Projection Editor (see pages 49-53).

What alternatives are there for importing a file format not supported by MAPublisher?
We provide a web page that has links to freeware, shareware and commercial GIS data translators at http://www.avenza.com/support.links.html If you cannot find the translator that you need give us a call, we may have other suggestions.

Why do my shapefiles crash on import?
There are a couple of possible common causes of this. The two items to check for are:

1. Make sure that you have all 3 required files. There should be a “triplet” for each layer/coverage with the extensions *.dbf, *.shp & *.shx. If you are missing any of these files you will not be able to import your files successfully.

2. If you have transferred these files from one operating system to another then you must always use binary ftp transfer, or the files will be corrupted. We have found that you cannot rely on the automatic transfer with all ftp utilities. Some do not recognize the files as being binary and will transfer them as ASCII.
I am having trouble getting my layers to overlay correctly. Both files import correctly when they are imported alone, but when I import the second file, the two files do not line up as expected.

Probably they are in from different projections or co-ordinate systems. It is very important that you ensure that data used within a single mapped area have the same map projection. If different data sets for a geographic location have differing projections, the chances are high that they will not overlay on import. If the files are of differing projections/co-ordinate systems, any software will give you the same results. When you import them and choose Defaults, compare co-ordinate values of the map anchors between the two files, you will probably see an obvious difference. Did you get the data from a single source? Can you check with the source as to the projection(s)? If you can find out the projections or co-ordinate systems of the two files you should be able to project them to a common system. If the projections are known, you can use the projection editor Xtra to change all data to a common projection. For more information about map projections see the British Columbia Government Ministry of Environment tutorial on map projections at http://srmwww.gov.bc.ca/gis/projectiontutorial.html.

Why do my MapInfo files crash on import or do not import properly?
There are a couple of possible common causes of this. A couple of possibilities may be:

1. How did you transfer the file to the machine where it is being imported? If you have transferred these files from one operating system to another then you must always use ASCII ftp transfer, or the files may be corrupted. We have found that you can not rely on the automatic transfer with all ftp utilities. Some do not recognize specifically the .MID files as being text. The .mid files may be inadvertently interpreted as binary music files, which often carry the same file extension. If they are transferred as binary you will have trouble importing them.

2. Were the files compressed? If the files are compressed using a windows ZIP format, you must be careful when decompressing them. If this is the case and the utility you used was Stuffit, you need to make sure that it was set for a DOS zip file or the file can be corrupted. The shareware utility ZIPIT found at http://maczipit.com has been found to be quite good for decompressing windows zip files.

I am having trouble with importing SDTS files. Where am I going wrong?
Be very careful how you receive a xxx.tar.gz file off the USGS website and decompress it. These files are in a binary format and if you use Smart TAR CR/LF translation it will not import and will probably crash MAPublisher. Make sure that you do all FTP transfers as binary. If you do not have the tar decompression utility there are versions available in the utilities folder on your MAPublisher 5.0 CD. After you receive it, use gzip to decompress it and TAR to further decompress it. You should have about 20 separate files, look for the ones that end in xxxxLE01.DDF. The LE stands for Line Entities and it is this file that actually contains the vector lines and vertices. It is usually the biggest file of the set. Select the xxxxLE01 or xxxxLE02, etc. files, click Defaults and the lower left X,Y co-ordinates and the scale will be calculated.

Map sheets or tiles that should be adjacent, but are not.
When importing adjacent map sheets or tiles, use the Defaults button on the tile that is most south and west (lower left) to find the map anchor and then do not run Defaults again. Use the “same as” function instead. If you reset the map anchor, the tiles will very likely display on top of one another or won’t line up. If the adjacent sheets are in adjacent UTM zones, you will need to make sure that they have all been "re–projected" into a common zone to display properly as adjacent tiles.
I am having trouble with importing DXF files. Where am I going wrong?

The MAPublisher Import Xtra currently supports AutoCAD R14 files. There are many CAD programs that use DXF or export to DXF. The DXF output may vary depending on the source program. We cannot compensate for these variations. If you are using AutoCAD you must run the EXPLODE BLOCKS command in AutoCAD before saving as DXF R14. Some DXF files are formatted in ASCII text, therefore care must be taken when transferring them on a mixed platform network. If you use ftp then be sure to transfer the files with the text option to avoid problems. Also make sure that the DXF files in question are in ASCII format, not binary.

Is there a restriction on the number of points in a path and how do I determine how to set the grain value in order to thin a file on import?

Macromedia FreeHand has a limitation of approximately 32,000 points on a single path. To compensate for this use the grain option in the MAPublisher Import Xtra. You may have to experiment with a few values. Picking a grain is not an exact science. Your data’s source scale and co-ordinate system are the major influences on determining the optimal grain value. A good rule of thumb is to think about the size of the map units. A map that is in UTM (Universal Transverse Mercator) usually has map units in meters. These are units that encompass a relatively small area, so you will want your grain to be in multiples of that unit - try starting with a grain of anywhere from 1 to 100. This is where the scale of the source data may come into play as well if it is a larger scale, with more detail a smaller grain may be wise to avoid too much loss of detail. If it is a smaller scale, with less detail, then you can use a larger grain value. See Importing Map Files with a Grain, page 26.

Why do some of my imported polygons have missing points?

Macromedia FreeHand has a limit of 32,000 points/vertices per path. The reason that you get the straight line is that some points must be dropped from the path in order to stay within the limit. The solution is to use the grain option on import to reduce the frequency and number of points in the path. You can then retain the desired shape. It may take some experimentation with a new data set to find the optimal grain value. If the data set is in lat/long (geographic) you will want to make the number quite small. A grain of .01 on Lat/long data stops the “cutting” while retaining the desired detail. With other projections such as UTM you can use larger grain values.

Why do my point symbols import so large?

MAPublisher creates point features using the font size which is currently selected at the time the function (import, point plot etc.) is run. It is generally a good practice to always set your font size prior to importing or plotting points.

Why does my data sometimes vanish?

If you imported some data and it appeared when selected, but when you deselected the data it seemed to vanish, here are a few things to check:

- You may have inadvertently pressed cut or the delete key. Check under Edit in the top menu bar, if the “Undo Delete” task is available this means that you just deleted something. Select “Undo Clear,” and the data should return.
- Check the order of your layers. Try moving the layer in question to the top of the list of layers in the Layers panel so that it is drawn on top of the other layers.
- Make sure that current layer is available for viewing in the Layers panel, by having a dot in the left-hand column under the eye (visualization) and beside the layer name.
- Check that you have colours for the fill and stroke set in the paint panel.
- Check the setting for the stroke width and increase if necessary.
EXPORTING ISSUES

How do I strip all the attributes from a MAPublisher file?
Simply save to a new file as an EPS file and then exit and re-open. It is not recommended that you save as earlier versions or you will also lose the layers. Alternatively you can use the MAP Columns Xtra to remove all data columns from the MAP Attributes table.

What causes missing features when exporting to mid/mif or shapefiles?
If you are using an pre-existing Macromedia FreeHand file which was not created with MAPublisher you must first add map parameters and feature defaults to each layer that you wish to export. If you have added any graphic objects to a MAPublisher map, you must make sure that they are MAPublisher objects to export them. You can test for this by using the SelStats window. If a selected object does not show as a selected feature in the SelStats panel it will not export. You need to run the appropriate Assign Feature Defaults Xtra to make the objects MAPublisher-aware.

LABELLING ISSUES

I am having trouble with the MAP Tagger tool? Where am I going wrong?
This can happen either when the layer or object to be labeled is not available for editing. Check to make sure that the desired layer is available for editing and that the features in question are not locked. In addition, if there is no fill to an area or polygon object the label tool (much like the FreeHand selection tool) can only find the paths defining the unfilled area. Therefore in such cases it cannot “find” the unfilled area and thus cannot label the unfilled area unless you click on the path itself.

PROJECTION ISSUES

How do I know what projection my files are in?
First ask your data provider. There are a couple of strong hints that may indicate that a file is in latitude/longitude (lat/long). Both ArcView and MapInfo tend to store files in lat/long for rapid projection “on the fly”. This is why most files that come from MapInfo or ArcView are stored in lat/long. A good test to see if a file is in lat/long is to look at the anchor values. Look at either the map anchor on import or use the location tool. Typical Lat/Long values will be X between -180 and 180 & Y between -90 and 90.

Why can’t I get my file to project properly?
You have to know what projection you are coming from and what projection you are going to, to get your file to project properly. Check with your data provider for this information. The most common cause of the projection editor not performing as expected is that the user has not entered the input or output projection information correctly. Furthermore, it is important to realize that many projections are not suitable for all areas of the world. Make sure to use a projection appropriate for your map.
TABLE ISSUES

What can cause Join Tables not to work?
When using the Join Tables Xtra you should first ensure that the linking columns have similar attribute structures (i.e., the join columns should be of matching type). If your join does not work when you are joining on character columns, you should check for trailing blanks in your character values/fields.

OTHER ISSUES

Where can I find version updates for MAPublisher?
Updaters will always be found in the Avenza FreeZone at http://www.avenza.com/freezone.

How accurate is MAPublisher geo-referencing?
At this point in time we are restricted to 32 bit storage for numbers, which allows for 7 digits of precision. The 32 bit storage restriction is controlled by the graphics environment software and not the MAPublisher software. We have asked for this storage restriction to be increased to 64 bit without success. We can and do all our internal calculations in 64 bit for accuracy, but the results still must be stored as 32 bit.

Are there any sources for free GIS data?
There are a multitude of web sites which offer free GIS data in several different forms. Please see pages A1-17 to A1-19 of this user guide for a list of several free download sites.

Why do some art objects fail to display completely?
Sometimes drawing with FreeHand's shape creation tools results in the object not being displayed completely by FreeHand. The object's geometry is complete because if you set the View to keyline (View ➔ Keyline) as opposed to Preview you can see that the object is there in its entirety (you can also zoom in and out) however, once you restore the zoom level to the original extents at which the object was created it will no longer appear as a complete shape. The solution to this is to disable the anti-aliasing option in the FreeHand preferences dialog. In the event that raster data fails to appear after import or a MAPublisher Register Image execution simply toggle the view mode to Keyline and then back to Preview to refresh the screen.

What can cause attribute corruption?
The most likely cause of attribute corruption (other than the files being corrupted before you got them) is that you have put layers with differing attribute structures into a single layer. As a rule of thumb you should use one layer for each external file that you are importing.

Why do I have missing data in an ArcInfo Ungenerate file?
If any of the cover–ids are equal to zero, the ArcInfo Ungenerate function ignores the associated graphics and does not include them in the Ungenerate file.
What can I do when an Xtra does not appear to work?

- Make sure that you have highlighted the desired Layer in the Layers panel and that it is unlocked and visible.
- Make sure that what you have asked the Xtra to do makes sense.
- Check your available and assigned RAM (Mac users).
- Try closing FreeHand and deleting your FreeHand preferences file.

GIS BACKGROUNDER

WHAT IS GIS?

A Geographic Information System (GIS) captures, stores, checks, analyzes, and displays georeferenced data about the earth. A GIS uses a database management system (DBMS) to store and link data that relates to the same geographic area. This facilitates the following types of queries:

- what if…?
- what is it?
- where is it?
- what patterns exist?
- what has changed since…?

Analytical Tool

GIS systems are used by all levels of governments, academia and business for such diverse purposes as monitoring environmental changes, sales planning, census reporting, municipal zoning, land records, mineral resource management, and mapping telecommunications and cable television utilities. In short, a GIS serves many needs and can be thought of as an analytical tool since it can be used to determine spatial relationships between geographic areas. A GIS contains a database linking spatial data with geographic information and lets you associate information with map features and to create new relationships based on those associations.

Areas

An area is a closed, bounded object, which encompasses a homogeneous area (e.g., a park).

Attributes

Attributes store descriptive information and are stored as sets of characters (including numbers). Attributes are usually considered tabular data.

Geographic Data

Since a GIS is a digital map database storing both spatial (graphic) and descriptive (tabular) information, the integration of this information provides an opportunity for analysis and communication. Data is stored using the Cartesian system (X,Y co-ordinates) as follows:

- points are stored as a single X,Y location
- lines are stored as a series of ordered X,Y co-ordinates
- areas are stored as a string of X,Y co-ordinates defining the lines that bound the area.
Labels, Symbols, and Colour
Map attributes can be represented by labels, symbols, and colour to make them easy to interpret (e.g. rivers may be represented with blue lines of varying widths depending upon their size).

Layers
Map features can be logically grouped into layers of related information. For example, a map could be layered by rivers, soils, mineral deposits, and municipality. This layering makes it easy to perform analysis that overlay geographic features and combine adjacent areas with similar characteristics.

Lines
A line represents the linear shape of a map element, which is too narrow to be an area (e.g., a contour line or road).

Map Features
A GIS stores two types of map information: spatial information (which describes the location and shape of geographic features) and descriptive information about those features. A GIS links these two types of data and maintains the spatial relationships between the map features. Features are portrayed on two-dimensional maps as points, lines, and areas. For example, a map may contain points representing location information (such as telephone poles), lines representing linear features (such as roads), and areas representing geographic features (such as lakes).

Points
Usually represented by a symbol or label, a point is a discrete location which is usually too small to be identified as an area or line (e.g., an oil wellhead or manhole).

Spatial Relationships
A map allows you to identify spatial relationships (e.g., a fire tower located inside a park) but it relies on you to derive this information from it.

Topology
Topology is a mathematical process for determining spatial relationships. It does this by expressing different spatial relationships as lists of features (i.e. an area is defined by the boundary lines). The primary advantage of this type of data storage is that it is more efficient and permits faster processing of larger data sets.
GRAPHICS BACKGROUNDER

WHY IS THE GRAPHICS ENVIRONMENT GOOD FOR MAPPING?

Avenza supports the fact that performing map-related graphics tasks is best done in the right environment - a powerful graphics program like Macromedia FreeHand. This environment offers practicality, freedom and easy maneuverability for fast, cost-efficient and professional graphic output results. The MAPublisher environment focuses on the map graphics first with the right GIS data management tools to facilitate the map production process in the easiest and most efficient way. This is in direct contrast to traditional GIS software that are designed and written, for the analysis of geographic data, with the graphic map production coming second, almost as an afterthought. This means that as powerful as most GIS’s are for analysis, they were never designed for cartographic or publication quality mapping. Cartographers have long been doing their mapping within graphics environments because they provide tools such as Bezier curves and true CMYK colour separation for publication quality mapping.

Features of the Graphics Environment

Accurate Colour
Colours displayed on screen accurately reflect the colours as they will be printed.

Proportional Symbology
Symbology is accurately proportional to the map area you have “zoomed” into.

Views
You can display your document on–screen in a variety of ways using the View menu commands. For example, you can see a preview of the illustration as you edit, you can view only the outlines of your artwork, or you can preview selected parts of your artwork while displaying the rest as outlines. You can also create custom views of your document, retaining a particular magnification level, layering, and other viewing features for later retrieval. You can even display multiple views of a document at several different magnification levels simultaneously.

Update Portions of a Layer or Legend
MAPublisher gives you the ability to update portions of a layer or legend by selecting one or more individual map objects based on attribute or colour/pattern/symbol and then applying a new colour/pattern/symbol. There is no deleting and then re-adding of the relevant map elements or layers. In practical terms this means that if you added a roads layer/element to your map and then realized that one of your roads line symbols didn’t look right, all you need to do is select for that class of road and change the symbol with the panels. There is no need to delete, re-code and re-drape your roads. It is even easier if you use the MAPublisher legend Xtras, in which case you only need to modify the legend for your roads and then draw to update the roads as desired.

Redrawing is Automatic
Redrawing of the affected map objects is clean and automatic and impacts only the redrawn portion and possibly some immediately adjacent portions of the map. This eliminates the need to wait while the entire map is re-drawn or refreshed. This applies to text as well as to vector data.
Broad Selection of Fonts
A broad and flexible selection of text fonts, styles, sizes and enhancement features (e.g., haloing) is available.

Viewing “Generalization” Parameters
Viewing “generalization” parameters can be set at any size so that your text will be automatically symbolized by grayed areas for layout (or any other) purposes. This facilitates design and layout and speeds the drawing of highly detailed maps.

Paste in Front or Behind
When pasting map objects/elements, you have the option of deciding to paste the new object “in front” or “behind” the copied elements at the time of pasting.

PostScript Pattern Fills
You can use PostScript pattern fills and complex vector strokes. You can sample colours from images and apply them precisely to vector data.

Complex Colour Treatments
Even with complex colours you can quickly and accurately create colour ramps with differing depths/intensity of 10%, 20%, etc. These can be set as individual colours on a panel or as a gradient across mapped features.

Improved Symbology
Improved symbology (e.g., road treatments and cartographic symbols) than is available from traditional GIS software.

Speed Drawing
You can easily turn on and off selected layers of a map to speed drawing. This can be done by turning off specified layers, and/or limiting the display of selected layers to simple vectors with all symbology removed. Not only will this speed the handling of the map, it lets you easily use underlying vectors for reference with no distraction or distortion caused by mapping symbology.

Actual Size Viewing
In addition to standard zooming and panning capabilities, you can view the details on a map at the actual size at which they will be plotted/printed.

Saving Views
You have the option of saving individual “views” to facilitate editing or viewing defined portions of the map. No more searching around for a particular area that you want to display.

Rulers, Guidelines and Alignment Tools
Border rulers with adjustable guidelines and multi-combination alignment tools are available for use in aligning map objects.

Grouping and Ungrouping
There is grouping and ungrouping functionality. When items are grouped you still retain the option of separately accessing, querying and otherwise working with the individual components of a map group.
Store Related Objects
Individual but related map objects can be “stored” together by groups or by layers or both within the graphic file. This provides additional control and support in handling and organizing the map components.

Text Placement
The graphics environment offers a truly hands-on text placement environment and goes well beyond that of a GIS. For example text can be easily placed along any path or outside the map extents and is fully editable.

MEMORY CONSIDERATIONS

RAM RECOMMENDATIONS

Casual User: 256 MB of RAM is recommended.
One who works with MAPublisher with small, polylined data sets with minimal attribute data, a small number of layers and no raster images.

Power User: 512 MB of RAM or greater is recommended.
A professional cartographer who uses MAPublisher daily and works with large urban data sets (including large transportation layers) with 20 or more layers, raster based air photographs, large numbers of text labels, complex fill patterns, etc.

RAM USAGE HINTS
We are often asked why is so much RAM needed to operate MAPublisher. First of all, Macromedia FreeHand requires a significant amount of RAM itself in order to run smoothly. Secondly, map data sets are often large which increases the need for RAM even further. Map data sets contain both vector and attribute data which must be stored in memory. Since we are adding a database to FreeHand this increases the file size, which increases the RAM requirements. MAPublisher builds a mini-GIS application inside FreeHand so that it can geo-code information and attach data to objects. This also has some overhead.

GIS users also often ask why so much more memory is needed with MAPublisher than is with GIS software. The graphics environment software of Macromedia FreeHand loads the entire file into memory rather than just reading it from disk, thus more RAM memory is required.

When you are importing a large number of files into FreeHand using MAPublisher, you’ll notice that the amount of available memory will decrease rapidly and your computer loses speed. This is due to the memory management. MAPublisher reserves a fairly large amount of memory for each import-action, which is not properly returned when the import is done. The solution is simple: save your file, close it and open it again. It’s not even necessary to close FreeHand itself. By closing the file, the reserved memory is properly returned.
Some RAM saving tips:

- Since a percentage of the memory is taken for attribute storage, drop any redundant or otherwise unnecessary attribute fields from the map attributes table.

- If files become too large to work with you can strip out all of the attributes by saving the file as an EPS document. Close the file and then open the new file.

- Many sources of street data include paths/vectors that are segmented based on street addressing information. You can use the MAPublisher Join Arcs Xtra to join these into single linear features based on a selected attribute field. Reducing the number of objects (and data records) in the map file will free up memory.

- Use polylined or pre-joined linear feature data sets where available.

- Use the grain feature on import of files to reduce size.

- Do not use more than 3 different fonts for labeling.

- Many GIS data files are large and when a series of such files is imported, you may find that the import Xtra starts to run more slowly. This is because scratch and memory allocations are being used up. The best solution is to periodically save your work, quit out of Macromedia FreeHand and then restart. This will free up the available scratch memory.

- The minimum number of undos can be reduced (since they ALL reside in memory).

- In your GIS application strip out the attributes you won’t be using for queries or labeling before importing the data into FreeHand.

- Increase your RAM allocation to Macromedia FreeHand (Mac OS 9.x only) and be sure that it is the only application open.
ONLINE LINKS

Since the Internet is always changing, refer to our web page (www.avenza.com) for the most recent list of relevant Internet sites or do a Google or Yahoo search. As of the writing of this manual all the following links were active and functional.

For Geographic Information System (GIS) users, the appeal of graphics is strong and the increasing ability to discover and share GIS across the Internet is fascinating. The Internet offers a large number of free-access GIS-related websites from which you can access map and information data sets.

For the general public, there’s general information about countries, states, and places; simple maps of areas (e.g., GIF, PS format); lists and maps of Internet resources in an area.

For cartographers and geography researchers, there are cartographic/GIS base map files (e.g., USGS Demos, DLGs, TIGER); thematic data of a geographic nature (e.g., census data); and complete GIS data sets (e.g., ArcInfo export files).

These lists are readily available, and there is a comprehensive list of free data sites accessible from the MAPublisher Internet home page at: http://www.avenza.com/support.links.html.

FREE MAP DATA

The following are just some of the many sites on the Internet that offer free download of GIS data. Data is available from these and other Internet sites in a wide variety of formats. Please consult the sections in this manual on file formats (pages 15 to 17 & A1-1 to A1-4) to ensure that you obtain usable data.

AUSLIG
Australian national mapping agency offering digital map data, satellite imagery and elevation data. Data obtained here can be used for commercial purposes with permission.
  • http://www.auslig.gov.au/mapping/index/

CAST
The Centre for Advanced Spatial Technologies (CAST), University of Arkansas. Planned free access on the ARKNet statewide network. Among its high-tech offerings, CAST maintains a catalog of Arkansas, U.S. national and global data — e.g., GIS data in areas of archaeology, agriculture and population are downloadable as GIF files across the Internet. Obtain a map of historical land coverage data. Obtain data sets including Environment, Prehistoric and Historic Climate Reconstruction, Historic Census, and Tabular databases.
  • http://www.cast.uark.edu

Directions Magazine Data Center
Directions magazine is an internet-centred publication that provides news, analysis, commentary product information and free map data.
  • http://www.directionsmag.com/datacenter
EROS Data Center
The Eros Data Center will be providing FTP access to a variety of USGS digital data sets.
• http://edcwww.cr.usgs.gov

Freedata.ca
This site is dedicated to the issue of access to government geospatial data across Canada.
• http://www.freedata.ca

GeoCommunity & GIS Data Depot
The GeoCommunity and GIS Data Depot are an excellent sources of free GIS data, geographic software (including data viewers, translators and compression utilities) and industry news. This site also has several GIS-related discussion forums. The data found on this site covers most areas of the world.
• http://www.geocomm.com

GeoConnections/GeoConnexions
This site from Canada’s Ministry of Natural Resources offers many links to GIS data and other informational resources.
• http://www.cgdi.gc.ca

Geography Network
The Geography Network is an online resource for finding and sharing world-wide geographic content, including maps and data from many of the world’s leading providers.
• http://www.geographynetwork.com

GEOGRATIS
Geogratis is a Natural Resources Canada site offering maps, satellite imagery and tabular data.
• http://geogratis.cgdi.gc.ca

GISLINX
This site, which has been compiled to provide GIS users with a quick and easy source of information on a variety of issues, has over 1,700 links including many offering GIS data.
• http://www.gislinx.com

MAPCRUZIN
MAPCRUZIN has data resources for environmental and socio-demographic research.
• http://www.mapcruzin.com

National Atlas of the United States
This site is a great source of a wide variety of data files for the United States.
• http://www.nationalatlas.gov/atlasftp.html

Doug Price’s List of Free Digital GIS Data
This site based at the Tennessee Geographic Information Council and the University of Tennessee offers an extensive list of data download links from around the world.
• http://www.lib.utk.edu/~tngic/price.html
California Polytechnic State University has various links to US-based map inventories.

- http://www.lib.calpoly.edu/research/all_databases/gis/gis5.html

**USGS**

Department of the Interior – US Geological Survey home page. This is the primary source for Digital Line Graph (DLG) files. A must–have resource is the US Geological Survey Digital Format Standards manual published by the USGS.


**U.S. Fish and Wildlife Service**

The FWS carries the National Wetlands Inventory map data in the USGS DLG format.

- http://www.nwi.fws.gov

**OTHER VALUABLE MAPPING LINKS**

The following are some additional places on the Internet where you can find news, reviews, tips and general GIS, cartographic and geographic information.

**GIS Cafe**

- http://www.giscafe.com

**GIS Dictionary**

- http://www.geo.ed.ac.uk/agridict/

**GIS Lounge**

- http://www.gislounge.com

**GIS@Development**

- http://www.gisdevelopment.net

**University of California, Berkeley - Guide to GIS Resources on the Internet**

- http://sunsite.berkeley.edu/GIS

**University of Edinburgh**

- http://www.geo.ed.ac.uk/home/gishome.html

**University of Florida - GeoPlan Center**

- http://www.geoplan.ufl.edu

**US Census Bureau - The Geographic Information Systems FAQ**

- http://www.census.gov/geo/www/faq-index.html
RELATED SOFTWARE AND UTILITIES

All utilities provided listed in this section are either freeware or shareware products that may be from the listed websites. In some cases versions may be found on the MAPublisher 5.0 CD in the Mac or Windows utilities folder. All files included on the CD have been done so with the permission of their respective developers.

MACINTOSH UTILITIES

BBEdit
http://www.barebones.com
BBEdit is a popular and critically acclaimed text and HTML editor for Web authors, programmers, on-line-service users, and anyone else who needs to edit plain-text files.

GraphicConverter
http://www.lemkesoft.de/
GraphicConverter is an image editing program that will open and save images in many common graphics formats. It includes editing tools for graphic manipulation and support for Adobe Photoshop plug-ins. GraphicConverter is capable of importing 160 file formats and exporting 45 file formats. Non-English versions are also available.

MacGzip 1.1.3 (included on CD)
http://persephone.cps.unizar.es/general/gente/spd/gzip/home.html
MacGzip is a gzip compressor (GNU zip) for the Macintosh, created by Jean-loup Gailly, ported to Mac by SPDsoft.

MAPublisherTexts (included on CD)
ftp://ftp.avenza.com/pub/misc/MAPublisherTexts.hqx
Microsoft Excel file for calculating the offset values for point data imported using MAPublisher.

StuffIt
http://www.aladdinsys.com
StuffIt is designed to be the simplest, most efficient way to expand compressed files and encoded files that you may have received from various sources. StuffIt 7.03 includes all 4 of Aladdin’s award-winning drag-and-drop compression and access utilities: StuffIt Expander, DropStuff, DropZip and DropTar.

ZipIt (included on CD)
http://www.maczipit.com
ZipIt is a Macintosh program that zips and unzips archives in a format fully compatible with PKZip for the IBM and zip implementations on other systems. ZipIt is compatible with Mac OS 9.x and OS X.
WINDOWS UTILITIES

Aladdin StuffIt Expander
http://www.aladdinsys.com
StuffIt for Windows expands files from the most popular archiving and compression formats found online, including StuffIt (.sit) and ZIP (.zip). StuffIt will also expand files in uuencoded (.uue), BinHex (.hqx), and MacBinary (.bin) formats, such as those commonly found on the Internet. Other archive formats supported include ARC (.arc), Arj (.arj), and gzip (.gz) as well as self-extracting archives created by StuffIt, ZIP, and Arj.

DLGV32 Pro (included on CD)
http://www.usgs.gov/
Viewer for SDTS DLG, DLG-O and DRG images allowing opening of multiple overlays of multiple types simultaneously. It provides zoom and pan functionality, the ability to find the distance between two points, the ability to pick DLG components and view their attribute codes, and the ability to select an arbitrary polygonal region to clip the overlays to.

HSB Converter 1.2 (included on CD)
Courtesy of Ketil Krumm (krumm@online.no).
This is a freeware utility that calculates equivalent RGB values for HSB colour values. It is particularly useful when trying to match colours between ArcView and FreeHand.

MAPublisherTexts (included on CD)
ftp://ftp.avenza.com/pub/misc/MAPublisherTexts.zip
Microsoft Excel file for calculating the offset values for point data imported using MAPublisher.

ShapeChecker (included on CD)
http://www.geocities.com/SiliconValley/Haven/2295
Utility for checking and repairing ArcView Shapefiles.

UltraEdit 32 10.00c (included on CD)
http://www.ultraedit.com
UltraEdit is a replacement for Microsoft Notepad with support for unlimited file sizes, a 100,000-word spelling checker, full HEX editing capabilities, configurable syntax highlighting for programmers and column editing. UltraEdit handles multiple files at once, even if they are multi-megabyte files. It is disk-based and only requires a small amount of memory, even for very large files.

Winzip 8.1 (included on CD)
http://www.winzip.com
WinZip makes it easy for Windows users to work with archives. WinZip features an intuitive point-and-click drag-and-drop interface for viewing, running, extracting, adding, deleting, and testing files in archives with a standard Windows interface. WinZip provides the same “friendly face” for many archival formats. WinZip can handle Zip, TAR, gzip, and Unix compress format files by itself. External programs are required for the less frequently used ARJ, ARC, and LZH formats.
TIPS, HINTS & SUPPORT

In this section you will find some tips and hints for performing additional MAPublisher-related tasks as well as a detailed listing of your technical support options.

TECHNICAL SUPPORT

Please consult the FAQs on pages A1-5 to A1-11, the additional how-to’s on the following pages as well as the following online options before contacting Avenza technical support as your situation may be easily addressed by one of the answers contained therein.

MAPublisher Online Knowledge Base

The MAPublisher Online Knowledge Base is a searchable online archive that offers a variety of MAPublisher information including newsgroup items, specific solutions and other contributions from Avenza, MAPublisher resellers and other MAPublisher users. The MAPublisher Online Knowledge Base is located at http://www.avenza.com/support.kb.html.

Internet Mailing Lists

There are two very popular Internet mailing lists that are populated by experienced MAPublisher users worldwide and offer an open forum for discussing problems, solutions, tips and other general issues relating to MAPublisher and cartography. These lists are also monitored by Avenza technical support staff who often participate with a solution or useful discussion item.

- **mapublisher-l** - This is the main MAPublisher list. Subscribe by sending an email to majordomo@avenza.com with the statement “subscribe mapublisher-l <emailaddress>” in the body of the message. Do not include the quotation marks and substitute your actual email address for <emailaddress>, without the “<” and “>”.

- **map-mac** - This is a very popular mapping list to which many MAPublisher users belong. It is not limited to mac-related discussions. Subscribe by sending an email to majordomo@avenza.com with the statement “subscribe map-mac <emailaddress>” in the body of the message. Do not include the quotation marks and substitute your actual email address for <emailaddress>, without the “<” and “>”.

Online FAQs

There is an ever-growing list of Frequently Asked Questions and answers on the Avenza website at http://www.avenza.com/freezone/freezone.faq.html which provides an additional source of tips, tricks and general MAPublisher information.

Contacting Avenza Technical Support

Avenza offers a number of methods for direct communication with our qualified and experienced technical experts. **Please have your MAPublisher keycode number handy to get prompt attention and include it in any email correspondence.** Support issues are handled on a first-come, first-served basis. Avenza does not guarantee a response within any specified time. For priority support consider joining the MAPublisher Maintenance Program (see page A1-23).

- **email:** support@avenza.com  
- **online form:** http://www.avenza.com/support.form.html  
- **phone:** MAPublisher Maintenance Program Subscribers Only
MAPublisher Maintenance Program (MMP)

The MAPublisher Maintenance Program (MMP) is a subscription-based service plan that guarantees its members:

- unlimited priority technical support - guaranteed same business day (9-4 EST) or next business day response
- MMP only telephone support (+1-905-567-4469)
- free MAPublisher updates
- free MAPublisher version upgrades
- additional discounts and offers available to MMP members only

If you purchased a maintenance subscription with your MAPublisher 5.0 purchase then you are well on the way to worry-free use of the MAPublisher and will be able to enjoy all the benefits of the MMP immediately.

If you did not purchase an MMP subscription at the time you ordered your copy of MAPublisher 5.0 please be encouraged to do so within 60 days in order to take advantage of the reduced price available. If you wish to purchase an MMP subscription after 60 days from the date of your MAPublisher purchase you will be required to pay the full MMP subscription price.

All MAPublisher Maintenance Program subscriptions begin 10 days after the date of the associated MAPublisher full version or upgrade purchase and run for 1 calendar year. MAPublisher Maintenance Program subscriptions purchased after the date of the associated MAPublisher full version or upgrade purchase become retro-active to the date 10 days after the date of the associated MAPublisher full version or upgrade purchase and run for 1 calendar year from that date.

Please direct all MMP questions and purchase inquiries to info@avenza.com.

To renew an expired or expiring MMP subscription, please go to https://www.avenza.com/renew.mmp.html and complete the online renewal form.

Wishlist

As either a new or experienced MAPublisher user we value your thoughts and opinions on how we can improve our product. Please let us know what you think and what Xtras or functions you would like to see incorporated into future upgrades of MAPublisher.

- email us at wishlist@avenza.com
- fill out the form at http://www.avenza.com/products.wishlist.html

ROTATING OBJECTS INDIVIDUALLY IN FREEHAND

On some occasions you may wish to rotate selected objects about their own centres rather than as a group about a common origin. This can be accomplished using the native Macromedia FreeHand Rotation function. To use the Transform Each function, first select the objects you wish to rotate. Then go to Edit ➤ Find and Replace ➤ Graphics. Set the Attribute to “Rotate” and Change In to “Selection”. Enter a desired rotation value and click Change. Each of the selected objects will be rotated individually about their own centres.
FREE FONTS

On your MAPublisher 5.0 CD you may find a special US National Parks Service font set that contains some very useful cartographic symbols. The font set is also available on our website at http://www.avenza.com/freefonts.html.

There are also other cartographic fonts available from Adobe Systems Inc. which supplies at least three in their Adobe Type Library, Carta, Bundesbahn Pi & Linotype Holiday Pi. Many GIS package also ship with mapping fonts and symbol sets.

Additional TrueType cartographic font sets are available from the British Society of Cartographers web site at http://www.soc.org.uk/software/software.html.

Through the standard Windows or Mac system fonts Dingbat and/or Symbols, you should be able to access some simple boxes and shapes that may be enough for your immediate symbolization needs.

BUILDING COLOUR-RAMP LEGENDS

You can enhance the look of your maps by using colour ramps, rather than random colours, for your legends.

1. Build a vertical set of filled legend elements.

2. Colour the first (top) and last (bottom) elements with the two extreme end colours for the colour ramp.

3. Marquee select the complete set of legend elements.

4. Select Xtras ➔ Create ➔ Blend and the legend set colours will be blended between the two end extreme colours. Now select the blend and using the Object panel enter the desired number of steps for your colour ramp in the Steps box. You must ungroup the elements before using them further.

5. You can then select Xtras ➔ 3.MAP Legend ➔ Draw Legend Layer to update your map.

Note: You must use one of the Assign Legend Xtras (pages 57-61) to assign values for the elements in your colour ramp legend prior to running Draw Legend Layer.

IRREGULAR TEXT ALONG LINES AND HOW TO FIX IT

Sometimes when text is applied along lines the results are less than optimal, with text elements falling off the line. This happens because there are two or more nodes in one place. The following steps should help fix this in your document. The solution is to run the FreeHand Simplify function (Modify ➔ Alter Path ➔ Simplify) on the lines to quickly eliminate the redundant nodes before applying text. If there is a concern about modifying the source, you can run the Join Arcs Xtra on the layer (with the label field as the join field) to make a second joined layer that can then can then be simplified. The first layer is for unmodified linear feature symbolization and the second layer is used only for the text labeling. Remove the simplified vectors after you apply the text, and before adjusting positioning of your text.
GEO-REFERENCING A MACROMEDIA FREEHAND MAP FILE

If you are using an existing FreeHand file that was created without the use of MAPublisher and as such does not contain any geographic parameters or attribute data, the following steps will enable you to geo-reference your FreeHand file and ultimately create an attribute-rich and accurate scale and world grid structure for your map. Please note that the steps that follow refer to functions that are outlined in more detail in the body of this user guide. Please familiarize yourself with the main MAPublisher functions and in particular those under Map Creation (pages 77-78) before proceeding.

These guidelines are for georeferencing data with MAPublisher in Macromedia FreeHand.

1. Go to View ➔ Page Rulers. Set the page size to the final page size of the map.

2. If you have a completed FreeHand vector file (ie. no image to trace) go to step 3. Otherwise, place and digitize your raster image.

3. Identify a registration or ‘tie-in’ point in your document. This should be a specific location in your document for which a real-world co-ordinate location is known or can be easily determined. Record the location of this point in real world co-ordinates (lat/long or UTM) on a piece of paper.

4. Locate the same tie-in point on the FreeHand document page and determine its X,Y co-ordinates in page units, using Window ➔ Toolbars ➔ Info. Record this number as well.

5. You should now have the location of your tie-in point in both map and page units (eg. –79.5, 43.5 in lat/long is located at 4 cm, 2 cm in the document).

6. Select the layer on which the vector data resides that contains the tie-in point and go to the 4. MAP Creation ➔ Add MAP Parameters Xtra.

7. Set the Map Anchors to the value of the tie-in location in map units using the values determined in step 3 (eg. –79.5, 43.5).

8. Set the Page Anchors to the value of the tie-in location in page units using the values determined in step 4 (eg. 4, 2).

9. Set the scale to the proper scale of the map (ie. a set distance in document units divided by a set distance in ground units) and set the units in the Add MAP Parameters dialog to the ground distance units (eg. metres). If your data is in lat/long and you do not know the lat/long (non-earth) scale, leave the scale field at the default value, and see the additional notes below. Click OK.

Note: The following additional steps are only required if the map is being created in lat/long, and you are unaware of what value to enter for a lat/long scale. Lat/long scales are not real world scales. If you have already entered correct anchor and scale values, please skip the following section and continue with step 10.

A. In steps 3 and 4 you determined your first point for geo-referencing your data file (eg. –79.5, 43.5 at 4 cm, 2 cm). Now using any symbolisation place a small point here. We will call this POINT 1.
B. To determine a scale in lat/long you will be required to determine and place a second known lat/long reference point within your map document preferably as far from POINT 1 as possible but still within the document extents (e.g. −71.5, 46.0). Use a known co-ordinate in the world, either from the raster image you digitized or from an atlas, to place a second point. This will be POINT 2.

C. Now with the pen tool, draw a straight line connecting both points.

D. Select this line and go to 4. MAP Creation ➔ Assign Line Defaults.

E. While this line is still selected open the Map Attributes window and write down the value displayed in the “MPLength” column. This line will be called L1.

F. Now using the Point Plot window place a third point, POINT 3, at the lat/long co-ordinates used in step B. This will NOT place a point at the same location as POINT 2 because the scale is still incorrect at this time in the process.

G. Repeat steps C to E using POINT 1 and POINT 3. This line will be called L2.

H. Using your the “MPLength” value for L1, the MP“Length” value for L2 and the current default scale as indicated in the Map Location window, perform the following calculation:

\[
\text{True map scale} = \frac{\text{Current Scale}}{\text{L1}} \times \text{L2}
\]

J. Now re-open the Add Map Parameters dialog box and enter the true map scale from step H in the appropriate portion of the dialog and proceed to step 10, below.

10. Repeat Add MAP Parameters for each layer using the Repeat command and the “or same as” option referencing the initial tie-in layer.

11. Once each layer is geo-referenced, you must geo-reference each object on each layer.

12. Select all lines on the current layer. Select the 4. MAP Creation ➔ Assign Line Defaults. This will make MAPublisher recognize every line on the current layer.

13. Select all areas on the current layer. Select the 4. MAP Creation ➔ Assign Area Defaults. This will make MAPublisher recognize every Area on the current layer.

14. Select all points on the current layer. Select the 4. MAP Creation ➔ Assign Point Defaults. This will make MAPublisher recognize every point on the current layer.

15. Select all text on the current layer. Select the 4. MAP Creation ➔ Assign Text Defaults. This will make MAPublisher recognize every piece of text on the current layer.

16. Deselect all objects and click on the next layer to make it current.

17. Repeat steps 12-15 for this next layer and every other layer until you have assigned defaults to each feature on all layers within your file.

18. Your document is now a geo-referenced map wherein each feature is also geo-referenced and capable of accepting attributes using the MAP Attributes functions (pages 35-42). If you know the projection of the map you can store the projection information using the steps outlined on page 52. You can also use the MAPublisher Export functions to create a GIS file from this newly geo-referenced FreeHand map.
TIPS ON EXPORTING TO OTHER GIS SOFTWARE

These strategies do not focus on how to do the procedures, as they are straightforward, but more on what you need to know and understand for successful export results.

Exporting Strategies for Vector GIS Files

First and most importantly you need to understand that the MAPublisher export was designed to export MAPublisher imported or created data one layer and one feature at a time. Why is it important to know this? MAPublisher only recognizes objects that have been imported by or created with its Xtras. If an object was not imported or created by MAPublisher, then MAPublisher does not “know” that it exists. However making the object “MAPublisher-aware” is simple and will solve this problem. All you have to do is use the MAPublisher Assign feature defaults Xtras to make your non-MAPublisher objects “MAPublisher-aware”.

If you have an entire layer that was not created by MAPublisher then:
1. Select the layer in the layer panel.
2. Select Xtras → 4. MAP Creation → Add Map Parameters.
3. Select “same as” and choose a valid geo-referenced MAPublisher layer.
4. Click OK.

This process “MAPublisher-izes” and geo-references the layer. It is also necessary to follow the next set of steps to make the objects on the layer “MAPublisher-aware”.

**Note:** If the entire drawing is ungeo-referenced with no MAPublisher layers you will need to repeat the Add Map Parameters steps for all layers and the Assign Defaults steps for all objects on all the layers unless you check the “Apply to all Layers” box in the Add Map Parameters dialog.

If you have objects that were not created by MAPublisher then:

1. Optionally you may want to confirm that MAPublisher is not aware of these objects. Select Xtras → 8. MAP Windows → Show/Hide SelStats. If they are not MAPublisher objects the SelStats panel will show nothing as being selected.
2. Assign the feature defaults:
   a) Select Xtras → 4. MAP Creation → Assign Area Defaults, for areas.
   b) Select Xtras → 4. MAP Creation → Assign Line Defaults, for lines.
   c) Select Xtras → 4. MAP Creation → Assign Point Defaults, for points.
   d) Select Xtras → 4. MAP Creation → Assign Text Defaults, for text.

Having “MAPublisher-aware” objects is the absolute minimum requirement for a successful export, however there are a couple of additional things to watch for. Since the current exported vector formats are GIS formats that do not support the concept of Bezier curves you need to compensate for this. If you have Bezier curves in your Macromedia FreeHand file they will not be recognized in the GIS software. In order for these features may be represented correctly you will need to add points to these lines in FreeHand first. Simply identify and select any objects
that use Bezier curves and then select Xtras ➔ Distort ➔ Add Points. Repeat this command until the line has a sufficient number of anchor points that the shape of your curves will not be lost on export.

Macromedia FreeHand stores the origin of text that has been applied along paths differently from other text objects. We have found the following steps to be the most successful way to get such “text” exported to GIS files:

1. Select any text that has been created along paths.
2. Select Text ➔ Convert to Paths. The text will be converted to vector objects.
3. With the text outline selected, select Xtras ➔ 4. MAP Creation ➔ Assign Area Defaults.

You can now export your “text” as area objects. Since the text is no longer text, you can no longer modify the fonts. We recommend that you make a copy of the original text objects before you do this process. These hints on how to transfer FreeHand files are necessary because the graphics environment handles text and curves differently and they need some modification in order for the GIS software to represent these accurately.

DOUGLAS-PEUCKER LINE SIMPLIFICATION

The Douglas-Peucker algorithm was primarily designed to reduce the number of points required to represent a vector line. A common problem in digital cartography and geographic information systems can occur when lines are generated automatically from a mathematical function, which records points at a fixed interval regardless if they are all lying along a straight line. A reduction of the number of points makes for a cleaner and more readable cartographic line. As well in cartographic work within Macromedia FreeHand the removal of points along a path can significantly improve the speed of file redraws and reduce the overall file size.

The Douglas-Peucker Algorithm was created in Fortran 66 by David H. Douglas and Thomas K. Peucker at the University of Ottawa in 1970-71. It was extensively tested in 1972 and was publically communicated in the following article:


There are a number of online resources where more information may be found on the Douglas-Peucker algorithm including http://citeseer.nj.nec.com/hershberger92speeding.html and http://www.cs.unc.edu/~mantler/safesimp/safeset/sld004.html.

TIPS ON EXPORTING DATA TABLES

You can export any data tables that are linked to physical features in MAPublisher.

a) To export as a comma-delimited data table, export the desired features as MapInfo mid/mif format. The export file with the extension .mid will contain your attribute data in comma delimited form.

b) To export as a DBF data table, export the desired features as Arcview shape files format. The export file with the extension .dbf will contain your attribute data in standard DBF format.
BEZIER CURVES AND OTHER MAPUBLISHER OPERATIONS

Bezier curves are defined using four control points. Two of these are the end points of the curve, while the other two effectively define the gradient at the end points. These two points control the shape of the curve. The curve is actually a blend of the control points. This is a recurring theme of approximation curves; defining a curve as a blend of the values of several control points.

Most GIS formats do not usually support bezier curves as used in general graphics packages such as Macromedia FreeHand. As such you will typically find that curved sections of GIS data (ex. highway ramps) will be composed of a series of small line segments rather than an actual curve. This is also how such features will first appear in FreeHand when imported with MAPublisher. The MAPublisher Simplify Arcs Xtra can be used to convert this type of feature into a Bezier curve (see page 81).

If Bezier curves are exported from FreeHand using any of the MAPublisher Export Xtras they will be converted to link and node topology (ie. the end points of the curve will simply be joined as straight lines). It is therefore necessary to create additional points to curves to retain their true shape. This can be done globally by using the add points command within FreeHand (Xtras ➔ Distort ➔ Add Points).

This version of MAPublisher supports Bezier curve features during the following operations:
- Transform Scale
- Projection Transformation
- Area and length calculations

CREATING A LEGEND TEMPLATE

You can create template files with legends to automate the production of a series of similar maps. The procedure is as follows:

1. Create a prototype map using the MAPublisher legend Xtras to create the desired “look”.

2. Make a copy of your prototype map file. Delete all the map objects except the legend elements from the file and save it to a new template file. Each set of legend elements should remain in its original layer.

3. Use this template file as a base for future maps as follows:
   a) Make a copy of the template file.
   b) Import all map layers into the template file and do any needed processing such as projection and arc-joining.
   c) Drag the legend elements from each original layer to the newly imported layer that has the same features. (ie. road legends would be dragged to the newly imported roads layer).
   d) With the appropriate legend elements selected, select Xtras ➔ 3. MAP Legends ➔ Draw Legend Layer for each layer. Your new layer will be symbolized by the previously defined legend elements.
   e) Repeat for each new map.
USGS DATA BACKGROUNDER

The U.S. Geological Survey offers many different types of map products including the following.

- Antarctic
- Geologic
- Hydrologic
- Land Use
- National Atlas
- Photo-image
- Planets and Moons
- Satellite Image
- Special Maps
- Topographic
- Topographic-Bathymetric

ANTARCTIC

Antarctic maps are available in four different scales.

1:250,000
A topographic reconnaissance and a geologic reconnaissance series at this scale has contour
intervals of 200 meters and show Bathymetric information for coastal areas. The topographic
series is the primary map source for the planning, logistic support, and multi-disciplinary investiga-
tions of the U.S. Antarctic Research Program.

1:500,000
Three series of maps - topographic reconnaissance shaded-relief, satellite image, and sketch -
are published at this scale. The satellite imagery was recorded by NASA’s Landsat.

1:1,000,000
Topographic maps and Landsat maps are published at this scale. Topographic maps in the
International Map of the World (IMW) format have contours at 100, 300, or 500 meters.

1:2,188,800
A reconnaissance sketch and topographic map of the Ross Ice Shelf at this scale was made in
support of the Ross Ice Shelf Geo-physical and Glaciological Program.

GEOLOGIC

The USGS makes many kinds of geologic maps as a part of a continuing program to fulfill one of
its missions: to examine the geological structure, mineral resources, and products of the national
domain. USGS maps that portray the geology of regions or local areas are available for over
50% of the United States.

HYDROLOGIC

Hydrologic Investigations Atlases (HA Series) are either black-and-white or multicoloured maps
showing a wide range of water-resources information, such as depth to ground water, floods,
irrigated acreage, producing aquifers, availability of water on Indian lands, surface-water dis-
charge to the oceans, chemical or mineral content of water, surface impoundments, and water
temperature. Flood-prone area maps (scale of 1:24,000) are available by quadrangle name, from
the Water Resources Division District Office in the State of interest.
LAND USE

Land use refers to human uses of the land (for example, for housing and industry). Land cover describes the vegetation, water, natural surfaces, and construction on the land surface. Standard base map features include boundaries, cities and towns, railroads, roads and highways, rivers and lakes — but no contours. Land use and land cover maps are available for most of the United States. Land use and land cover data are shown on USGS base maps at a scale of 1:100,000 for a few maps in Western States or at 1:250,000 (most maps).

NATIONAL ATLAS

The National Atlas of the United States of America (1970) contains 765 maps and charts on 335 pages. This Atlas is now out of print, but can be found in many libraries. Separate sheets of selected reference maps and thematic maps from the Atlas are available from the USGS. Some of the sheets have been updated.

PHOTO-IMAGES

Orthophoto Maps
Orthophoto maps are multicoloured, distortion-free, photographic image maps. They show subtle topographic detail in areas of very low relief, such as marshlands and coastal zones. They are produced in standard 7.5 minute quadrangle format from aerial photographs. Scale of 1:24,000 or 1:25,000.

Orthophotos Quads
Orthophoto quads are multicoloured, distortion-free, photographic image maps. They have no contours, minimal cartographic treatment, and only a few names and symbols. Orthophoto quads are available for selected areas along the east coast of the United States.

Border Maps
The border maps are natural colour photoimage maps. They are available for the U.S.-Mexico border and the U.S.-Canada border.

PLANETS AND MOONS

In 1960, the USGS established an astro-geology program on behalf of NASA to support lunar and planetary exploration. A prime activity of the program is the systematic mapping of the stratigraphy and structure of the Moon, Mars, Venus, Mercury, and the moons of the outer planets. Many USGS maps of the Moon, Mars, Venus, Mercury, and the moons of Jupiter and Saturn are now available for purchase by the public. The maps include geologic, topographic, photomosaic, and shaded-relief maps. The scales, projections and sheet sizes vary widely.

SATELLITE IMAGE

Satellite image maps are multicolour or black-and-white photograph-like maps made from data collected by Earth resources satellites. They are a diverse group of experimental maps printed in a standard edition and in a variety of scales and sizes. Many standard editions have topographic maps printed on the reverse side. Most image maps are printed to simulate colour-infrared photography by combining imagery that was scanned in red, green, and infrared wave lengths of light.
On colour-infrared imagery, healthy vegetation appears in shades of red. Unhealthy vegetation appears in shades of pink, blue, or white. Clear water appears dark blue or black. Sediment laden water takes on a light-blue tone. Most cultural features appear as a steely blue-gray. Satellite images are available for selected areas in about half of the States and such areas as Antarctica, the Bahamas, and Iceland.

**SPECIAL MAPS**

A wide variety of special maps are available for purchase from the USGS:

- Geologic Map of the United States
- Basement Rock Map of the United States - Exclusive of Alaska and Hawaii
- Coal Fields of the United States
- World Seismicity Map
- Generalized Tectonic Map of North America
- Surface Water and Related Land Resources Development in the United States and Puerto Rico

Many other special USGS maps are published from time to time. The USGS has also published several planimetric maps of the United States, North America, and the World. Most of these maps show political boundaries, major cities and capitals, and many rivers and lakes.

**TOPOGRAPHIC**

Most USGS topographic maps use brown contours to show the shape and elevation of the terrain. Elevations are usually shown in feet, but on some maps they are in meters. Contour intervals vary, depending mainly on the scale of the map and type of terrain. The maps show and name prominent natural and cultural (man-made) features.

**7.5-Minute Maps**

The best known USGS maps are those of the 7.5-minute, 1:24,000-scale quadrangle series. On such maps, 1 inch = 2,000 feet. The scale of these maps is used for areas where much detail must be shown.

**15-Minute Maps**

From 1910 to about 1950, maps showing an area within 15 minutes of latitude and longitude were the USGS standard for topographic coverage of the United States. These maps were at a scale of 1:62,500 (1 inch = about 1 mile) and are still available. Features shown on these maps are similar to those on 7.5-minute maps, but some detail is omitted or generalized at the smaller scale.

**U.S. 1:100,000-Scale Series**

Much of the United States is covered by 30- by 60-minute quadrangle maps at a scale of 1:100,000. Most of these maps are derived from 1:24,000-scale maps, but they show distances and contour intervals in meters. Contours are at intervals of 5, 10, 20, or 50 meters depending on terrain relief.

**County Map Series**

A county map may consist of one or more sheets, depending on the size of the county. County maps are available in scales of 1:50,000 and 1:100,000.
U.S. 1:250,000 - Scale Series
Maps in the 1:250,000-scale (1 inch = about 4 miles) series are available for the entire United States. They were originated by the U.S. Army Map Service during the 1950s, but are now maintained by the USGS. This series serves as base maps for aeronautical charts and geologic maps, for geographic reference, and in planning regional land use, transportation, and utility systems.

State Map Series
The state maps in this series are usually published in three separate editions: base map, highway and contour map, and shaded-relief map. Most are at a scale of 1:500,000. The features shown are limited to areas within the State. No areas adjoining States are shown except for shorelines and other water areas that form State boundaries.

U.S. 1:1,000,000 - Scale Series
This series of topographic maps has been discontinued by the USGS and will not be reprinted when the existing stock is depleted. The ground area shown ranges from 73,734 to 122,066 square miles (123,000 to 204,000 square kilometers). The maps show principal cities and towns, railroads, and political boundaries in black, roads in red, water features in blue, topography in brown, contour lines and gradient tints.

National Park Map Series
Each of these topographic maps, some of them with shaded relief, feature a national park, national monument, or national historic site at a range of scales. The maps are much like the standard quadrangle maps at the same scale, but they highlight recreational features.

Shaded-relief Maps
USGS publishes shaded-relief editions of certain topographic maps to accentuate physiographic features of special interest, and for some state, Antarctic, and national park maps. These maps use shaded relief, as well as contour lines, to represent the shape of the terrain.

TOPOGRAPHIC-BATHYMETRIC
These USGS maps show in one format and one edition the data for a land-water area previously shown separately as a topographic map and a bathymetric map. On topographic-bathymetric maps, contour lines show elevations of the land areas above sea level, and isobaths (depth contours) show the form of the land below the water surface. Some bathymetric maps show magnetic and gravitational data in addition to water depths. Because coastal zones include both land and water, maps of such areas must include both topographic and bathymetric data. To produce these coastal maps, the National Ocean Service provides bathymetric data to be added to USGS topographic maps. The combined map serves the needs of oceanographers, marine geologists, land use planners, physical scientists, conservationists, and others having an interest in management of the coastal zone, the wetlands, and the offshore environment.
APPENDIX 2 - UTM ZONES
APPENDIX 3 - DATA LIST

The following is a list of all the files used in the example exercises in this manual.

**avg_inc.csv** (pages 84, 86, 88, 89 & 90)
ASCII comma-delimited table containing FSA codes and income statistics for downtown Toronto.

**az.deci(partial).txt** (page 28)
ASCII comma-delimited file containing point data for part of Arizona.

**borneo.tfw** (page 44)
World file containing registration information for the borneo.tif image.

**borneo.tif** (pages 44 & 45)
Tiff file of a relief map of Borneo.

**burl_roads.lin** (pages 41 & 60)
ArcInfo ungenerate file of a few of the major roads, highways and railways of Burlington, Ontario.

**canada.shp** (page 52)
A shapefile of Canada in Albers Equal Area projection.

**eastUS.shp** (page 56)
A shapefile of the Eastern United States.

**fsatoronto.mif** (pages 22, 24, 50, 69 & 86)
A MapInfo file displaying the forward sortation areas (postal zones) of downtown Toronto.

**greenland.mif** (page 26)
A MapInfo file of Greenland.

**hypoint.e00** (page 63)
ArcInfo export file of Alberta containing a series of points and their elevations above sea level.

**income.mif** (pages 58 & 61)
A MapInfo file of downtown Toronto divided into regions and containing various income statistics.

**italy.mif** (page 46)
A Mapinfo file of Italy.

**regional_south_china_sea.shp** (pages 44, & 45)
A shapefile containing a map of the South China Sea and surrounding area.

**riverskm.shp** (page 82)
A shapefile of major Canadian rivers neighbouring the Great Lakes.

**sicily.tif** (page 47)
An image of the island of Sicily in tif format.

**states.mif** (page 51)
A MapInfo file of the United States displayed in a Robinson projection.

**toronto.fh10** (page 77)
A Macromedia FreeHand file composed of the torontostreets.mif and fsatoronto.mif data files.

**torontostreets.mif** (pages 22, 24 & 80)
A MapInfo file containing road data for downtown Toronto.

**torontostreets_joined.mif** (pages 68)
A version of the torontostreets.mif file containing road lines that have been joined by street name.

**USA.fh10** (pages 31, 53 & 66)
A Macromedia FreeHand file of the United States in Albers Equal Area projection.

**world.mif** (pages 21, 36, 39, 71, 72, & 75)
A MapInfo file containing a political map of the world with statistical information for each country.

**world_east.mif / world_west.mif** (page 25)
Two MapInfo files that together form the entire world.mif coverage area.
APPENDIX 4 - UTILITIES LIST

The following utility programs and files are included on the MAPublisher 5.0 CD for your reference and convenience. They can all be found in the utilities folder.

Windows

**DLGV32 Pro (dlgv32_pro.exe)**
Program that allows viewing of DLG (SDTS & Optional) as well as DRG images.

**e00 Decompression Utility (e00decompress.exe)**
Used to decompress ArcInfo Export (e00) files before they can be used in MAPublisher.

**GeoTIFF Examiner 1.02 (geotiffe.exe)**
This utility is used to create GeoTiff files.

**HSB Converter 1.2 (HSBConv.exe)**
Utility to convert HSB colour values into RGB colour values.

**MAPublisher Texts (MAPublisherTexts.xls)**
Microsoft Excel file for computing offset values for point data in MAPublisher.

**Mid/Mif Batch Export Script (BulkLayerExport.mbx & BulkLayerExport.str)**
A script for MapInfo Professional for batch exporting of mid/mif files.

**Mid/Mif Brush Template (brush_template.fh10)**
Brush patterns which, when loaded into FreeHand, allow for mid/mif stroke and line styles to be maintained.

**MrSID Stand Alone Viewer 2.0.0.50 (MrSIDViewerSetup.exe)**
Stand alone viewer for files compressed using LizardTech's MrSID format.

**Shapechecker (shapecheck.exe)**
Utility for checking the validity of shapefiles.

**UltraEdit 32 10.00c (uesetup.zip)**
Text editor with features such as spell check, HEX editing capabilities and syntax highlighting for a number of programming languages.

**Winzip (winzip81.exe)**
This utility is a popular compression and decompression program.

Macintosh

**e00 Decompression Utility (AvzDecompress)**
Used to decompress ArcInfo Export (e00) files before they can be used in MAPublisher.

**MacGzip 1.1.3 (MacGzip.1.13)**
Another compression utility that can create gzip (.gz) file archives.

**MAPublisher Texts (MAPublisherTexts.xls)**
Microsoft Excel file for computing offset values for point data in MAPublisher.

**Mid/Mif Brush Template (brush_template.fh10)**
Brush patterns which, when loaded into FreeHand, allow for mid/mif stroke and line styles to be maintained.

**MrSID Stand Alone Viewer 2.0 (MrSID_StandAlone_Viewer_2.0)**
Stand alone viewer for files compressed using LizardTech's MrSID format.

**Zipit 2.2.2 (ZipIt.app)**
Compresses and decompresses files in the PKZIP format and is fully compatible with imple- mentsations of this format on both Macintosh and PC platforms.
Avenza Systems Inc. would like to acknowledge and thank the following companies and individuals for their contributions to MAPublisher 5.0 for Macromedia FreeHand and for data and other files that may appear on the MAPublisher 5.0 for Macromedia FreeHand CD. In addition to those mentioned below we wish to thank the many beta-testers who helped us design and test this product.

Adobe Systems Inc.
345 Park Ave.
San Jose, CA 95110-2704
phone: (408) 536-6000
fax: (408) 537-6000
email: info@adobe.com
web: www.adobe.com

Aladdin Systems, Inc.
165 Westridge Drive
Watsonville, CA 95076
phone: (831) 761-6200
fax: (831) 761-6206
email: info@aladdinsys.com
web: www.aladdinsys.com

Alain Olivier, Geomatique
Le Buisson
Albiez le Jeune, 73300
Saint Jean de Maurienne, France
phone: +33-(0)4-79643435
fax: +33-(0)4-79643435
email: alain.olivier@geomatique.fr
web: www.geomatique.fr

Bare Bones Software Inc.
P.O. Box 1048
Bedford, MA 01730-1048
phone: (781) 687-0700
fax: (781) 687-0711
email: sales@barebones.com
web: www.barebones.com

Bentley Systems, Inc.
685 Stockton Drive
Exton, PA 19341
phone: (610) 458-5000
website: www.bentley.com

Bridgis / Michael Cappendijk
Sint Walburgerkpad 3
4001 MG Tiel
The Netherlands
phone: +31-(0)344-636242
fax: +31-(0)344-636246
email: info@bridgis.nl
web: www.bridgis.nl

Tom Brown
5325 Elkhorn Blvd., PMB 8091
Sacramento, CA 95842
phone: (877) 597-7271
email: help@maczipit.com
web: www.maczipit.com

ESRI Inc.
380 New York St.
Redlands, CA 92373-8100
phone: (909) 793-2853
fax: (909) 307-3025
email: info@esri.com
web: www.esri.com

Adobe Systems Inc.
345 Park Ave.
San Jose, CA 95110-2704
phone: (408) 536-6000
fax: (408) 537-6000
email: info@adobe.com
web: www.adobe.com

Aladdin Systems, Inc.
165 Westridge Drive
Watsonville, CA 95076
phone: (831) 761-6200
fax: (831) 761-6206
email: info@aladdinsys.com
web: www.aladdinsys.com

eXqe
Sint Janspad 1
4791 HJ Klundert
The Netherlands
phone: +33-(0)168-405932
fax: +33-(0)168-405935
email: info@exqe.nl
web: www.exqe.nl

Franklin Graphic Services, Inc.
3620 Baldwin Avenue
Makawao, HI 96768
phone: (808) 573-1555
fax: (808) 453-0502
email: franklin@hawaiian.net
web: www.infographicdesign.com

Gemeente Apeldoorn
Stationstraat 176
Apeldoorn, The Netherlands 7300ES
phone: +31-(0)55-580-1142
email: hessint@apeldoorn.nl
web: www.apeldoorn.nl

GeoCommunity
4588 East Highway 20, Suite A
Niceville, FL 32578
phone: (850) 897-6778
fax: (850) 897-1001
email: info@geocomm.com
web: www.geocomm.com

Ketil Krumm
email: krumm@online.no

Lemke Software
Erich-Heckel-Ring 8a
31228 Peine, Germany
Phone: +49-5171-72200
Fax: +49-5171-72201
email: lemklesoft@aol.com
web: www.lemklesoft.de

LizardTech Inc.
1008 Western Ave.
Seattle, WA 98104
phone: (206) 652-5211
fax: (206) 652-0880
email: info@lizardtech.com
web: www.lizardtech.com

Macromedia Inc.
600 Townsend Street
San Francisco, CA 94103
phone: (415) 252-2000
fax: (415) 626-0554
email: info@macromedia.com
web: www.macromedia.com

MapInfo Corp.
One Global View
Troy, NY 12180
phone: (518) 285-6000
fax: (518) 285-6070
email: custserv@mapinfo.com
web: www.mapinfo.com

Mentor Software Inc.
2221 East Street, Suite 203
Golden, CO 80401
phone: 303-278-3534
fax: 303-278-4099
email: alex@rockware.com
web: www.mentorsoftwareinc.com

NASA Visible Earth
email: vemail@eodomo.gsfc.nasa.gov
web: www.visibleearth.nasa.gov

National Parks Service
1849 C St. NW
Washington, DC 20240
phone: (202) 208-6843
web: http://www.nps.gov

Patrick Dunlavey Cartographics
40 Oblong Road
Williamstown, MA 01267
phone: (413) 458-9273
fax: (413) 458-9812
email: pat@pdcarto.com
web: www.pdcarto.com

screen & paper Werbeagentur GmbH
Biernerstraße 32
D-85354 Freising, Germany
phone: +49-(0)8161-97 94-94
email: info@screen-paper.de
web: www.screen-paper.de

SPDsoft
Jose A Gutierrez
Centro Politecnico Superior
Universidad de Zaragoza
Maria de Luna 3
50015 Zaragoza, Spain
email: macspd@ivo.cps.unizar.es
web: http://persephone.cps.unizar.es/
general/gente/spd/spd.html

United States Geological Survey
12201 Sunrise Valley Dr.
Reston, VA 20192
phone: (703) 648-4000
web: www.usgs.gov

Andrew Williamson
e-mail: andrew_webby@bigfoot.com
web: www.geocities.com/SiliconValley/Haven/2295

Plus…..

The many providers of sample maps created with MAPublisher (who number too many to mention here) as found in the Goodies folder on the MAPublisher CD. Please see the readme in each folder for the specific credit information.
APPENDIX 6 - GLOSSARY

If you have difficulty with some of the GIS terminology used, you can also access the following for more information:

http://srmmwww.gov.bc.ca/gis/glosstxt.html
http://www.geo.ed.ac.uk/agidict/welcome.html
http://www.avenza.com/glossary.html

A

Accuracy
The closeness of results of observations, computations or estimates to the true values or the values accepted as being true. Accuracy relates to the exactness of the result, and is distinguished from precision, which relates to the exactness of the operation by which the result is obtained.

AGI
Association for Geographic Information.

Algorithm
A set of rules for solving a problem.

ASCII
American Standard Code for Information Interchange, a widely used industry standard code for exchanging alphanumeric codes in terms of bit-signatures.

ANSI
American National Standards Institute, an association formed by the American Government and industry to produce and disseminate widely used industrial standards.

Analog (or analogue)
A continuously varying electronic signal. Also refers to traditional paper mapping products and aerial photographs.

Annotation
The explanatory or descriptive alphanumeric text or labels on a map (or artwork), such as street or place names.

Application
A set of computer programs designed for a specific task.

Arc
A line/vector/path defined by a series of points (a string of X,Y co-ordinates).

ArcInfo Export
File format with the extension .e00 for files exported from ArcInfo.

Area
A bounded continuous two-dimensional object, which may or may not include its boundary. Usually defined in terms of an external polygon or in terms of a set of grid cells. A fundamental unit of geographical information. See polygon.

Aspect
Individual azimuthal map projections are divided into three aspects: the polar aspect which is tangent at the pole, the equatorial aspect which is tangent at the Equator, and the oblique aspect which is tangent anywhere else. (The word ‘aspect’ has replaced the word ‘case’ in modern cartographic literature).
**Attribute**
Non-graphic alphanumeric textual information associated with a point, line, or area element in a GIS data set; tabular data associated with geographic features.

**Azimuth**
The angle measured in degrees between a base line radiating from a center point and another line radiating from the same point. Normally, the base line points North, and degrees are measured clockwise from the base line.

**B**

**Bezier Curve**
A Bezier curve consists of two anchor points connected by a curved segment, with at least one direction point and direction line attached to each anchor point.

**Binary**
A number system of base 2. Numbers are represented simply as a series of 0’s or 1’s in contrast to base 10 number systems that represent numbers using the characters 0-9. For example, the base 10 number 65535 translates to the base 2 number 1111111111111111. Binary numbers are the fundamental basis of computing.

**Bitmap**
A grid of small squares, cells or pixels stored in memory and used to generate an image.

**Boolean**
There are two types of values: true and false. True/false or yes/no usually represent these.

**C**

**CAD(D)**
Computer-Aided Drafting (Design).

**Cadastre**
A public register or survey that defines or re-establishes boundaries of public and/or private land for purposes of ownership and taxation.

**Cartography**
The organization and communication of geographically related information in either graphic or digital form. It can include all stages from data acquisition to presentation and use.

**CAST**
Centre for Advanced Spatial Technologies, University of Arkansas.

**Cell**
The basic element of spatial information in a raster image.

**Clipping**
A graphic process of cutting lines and symbols off the edge of a display area.

**Colour Ramp**
A graduated range of colours between two extreme colour selections.

**Conformal**
A map projection is conformal when at any point the scale is the same in every direction. Therefore, meridians and parallels intersect at right angles and the shapes of very small areas and angles with very short sides are preserved. The size of most areas, however, is distorted.

**Contour**
A line connecting points of equal elevation.
Curvature
The amount of curve in line as defined by a series of points.

D

Data model
An abstraction of the real world, which incorporates only those properties, thought to be relevant to the application at hand. The data model would normally define specific groups of entities, and their attributes and the relationships between these entities. A data model is independent of a computer system and its associated data structures.

Database
A collection of data organized according to a conceptual structure describing the characteristics of the data and the relationships among their corresponding entities.

Database management system (DBMS)
A set of computer programs for organizing the information in a database usually containing routines for data input, verification, storage, and retrieval.

Defaults
The values or actions that would normally be expected to occur.

DEM
Digital Elevation Model. DEM is a raster format used by the USGS to record elevation information. Unlike other raster file formats, DEM cells do not represent colour brightness values but rather the elevation of points on the earth's surface.

Demographics
Statistics of birth, death, population, etc.

Developable surface
A developable surface is a simple geometric form capable of being flattened without stretching. Many map projections can then be grouped by a particular developable surface: cylinder, cone, or plane.

DGN
Native file format of MicroStation from Bentley Systems Inc.

Digital
The ability to represent data in discrete units or digits.

Digital Line Graph, a USGS standard output file format.
These can be in either Optional (.opt, .do) or SDTS (.ddf) form.

Douglas-Peucker Line Simplification Algorithm
A method of simplifying line data by removing unnecessary vertices.

Drag
To hold down the mouse button while you move the mouse cursor on the screen.

Drag and drop
The act of dragging a file with the mouse over another executable file to cause some action on the first file.

DTP
Desktop Publishing.

DWG
AutoCAD Drawing file.

DXF
AutoCAD Drawing Exchange Format.
**E**

**Element**  
A fundamental geographical unit of information, such as a point, line, area, or pixel.

**EPS**  
Encapsulated Post Script file format  The EPS format is used to transfer PostScript language artwork between applications - also see PostScript.

**Equal areas**  
A map projection is equal area if every part, as well as the whole, has the same area as the corresponding part on the Earth, at the same reduced scale. No flat map can be both equal area and conformal.

**Equidistant**  
Equidistant maps show true distances only from the center of the projection or along a special set of lines. For example, an Azimuthal Equidistant map centered at Washington shows the correct distance between Washington and any other point on the projection. It shows the correct distance between Washington and San Diego and between Washington and Seattle. But, it does not show the correct distance between San Diego and Seattle. No flat map can be both equidistant and equal area.

**F**

**FAQ**  
Frequently Asked Questions.

**Feature**  
A set of points, lines or polygons in a spatial database that represent a real-world entity. The terms feature and object are often used synonymously.

**Feature code**  
A set of characters (alpha, alphanumeric or numeric) within the GIS, which uniquely identifies a feature class or group of features.

**File**  
A collection of related information that can be accessed by an assigned name.

**Folder**  
A storage area for files within the Macintosh OS, the equivalent of a DOS or UNIX directory.

**Format**  
The way in which data is arranged for storage and for transmission between software and computers.

**FTP**  
File Transfer Protocol.

**G**

**Geographic features**  
Points, lines, and areas that comprise a map.

**Geographic Information System (GIS)**  
Any system designed for the capturing, storing, checking, integrating, analyzing and displaying of spatially referenced data about the earth.
**Geo-reference**
To establish the relationship between page co-ordinates on a planar map and known real-world co-ordinates.

**GeoTIFF**
An industry-wide standard for specifying information in TIFF tags which was developed by several organizations within the GIS community. GeoTIFF files are raster images that contain geo-referencing information as well as image information in a single file.

**GIR**
Geographic Information Retrieval.

**GIS**
Geographic Information Systems.

**GPS**
Global Positioning Systems.

**Grain**
The frequency of vertices or points forming a line.

**Graticule**
The spherical co-ordinate system based on lines of latitude and longitude.

**Great Circle**
A circle formed on the surface of a sphere by a plane that passes through the center of the sphere. The Equator, each meridian, and each other full circumference of the Earth forms a great circle. The arc of a great circle shows the shortest distance between points on the surface of the Earth.

**Grid**
A set of regularly spaced sample points or an exact set of reference lines over the earth’s surface.

**H**

**Header File**
A file associated with an image that contains geo-referencing information for the image. File extensions may be TFW or JPW (tiff, jpeg World Files), IRP (Image Report Files) or TAB (Table files).

**Hydrography**
In its most general definition, hydrography is the description and study of seas, lakes, rivers, and other bodies of water with regard to: the measurement of flow and investigation of the behavior of streams; the measurement of tides and currents, and the surveying, sounding, and charting of those bodies of water (Webster's Third New International Dictionary, 1993).

**Hypsography**
Lines or points which depict the relief of the land or contours or spot elevations.

**I**

**Icon**
An image representing a software function or tool.

**Image**
A graphic representation or description of a scene, typically produced by an optical or electronic device. Examples include remotely sensed or satellite data, scanned data, and photographs.
Import sequence
The order of steps required to import data.

Integer
A number without a decimal. Integer values can be less than, equal to, or greater than zero.

Isoline
A line on a surface connecting points of equal value for any of the characteristics used in the representation of the surface.

Join Arcs
A function in MAPublisher for joining a set of linear features based on a common value such as street name.

JPEG
Joint Photographic Experts Group, is a lossy compression technique for raster file formats.

Label
Text used to identify a map feature.

LANDSAT
The generic name for a series of earth resource scanning satellites launched by the United States of America.

Latitude
Angular distance, expressed in degrees and minutes, along a meridian north or south of the equator.

Lat/Long
Latitude/Longitude. Unprojected.

Layer
A designated level in artwork used for storing, organizing and editing graphic or mapping data.

Legend
The section of the map that explains the meaning of the symbols used to depict graphic or geographic elements.

Legend element
A legend key combined with its associated text.

Legend key
The graphic symbol used to illustrate attributes in a legend.

Longitude
The angular distance east or west from a standard meridian to another meridian on the earth’s surface; expressed in degrees and minutes.

Line
One of the basic geographical elements, defined by at least two pairs of X,Y co-ordinates; usually too narrow to be an area. See also arc, path and vector.

Linear scale
The relation between a distance on a map and the corresponding distance on the Earth. Scale varies from place to place on every map. The degree of variation depends on the projection used in making the map.
**Lossless/Lossy**
Lossless techniques compress image data without removing detail; lossy techniques compress images by removing detail.

**M**

**MacOS**
Apple Macintosh operating system.

**Map**
A graphic representation of features of the earth’s surface or other geographically distributed phenomena.

**Map Anchor**
The minimum X and Y co-ordinates of the data files.

**Map Co-ordinates**
The X,Y representations of ellipsoidal earth locations on a mapping plane.

**Map Extent**
The geographic extent of a geographic data set specified by the minimum bounding rectangle.

**Map Projection**
A map projection is a systematic representation of a round body such as the Earth on a flat (plane) surface. Each map projection has specific properties that make it useful for specific purposes. Also see Projection

**Marquee**
A dashed rectangle drawn with a selection tool used to select multiple objects.

**Meridian**
A line of longitude running vertically from the north pole to the south pole.

**Meta-Data**
Data about data typically including information such as currency, accuracy, and extent. Meta-data is typically stored in data models or data dictionaries.

**MIF**
The MapInfo Map Interchange Format

**Mid/Mif**
An ASCII file format pair exported from MapInfo GIS software. The .mif file contains the vector data and the .mid file contains the attribute data

**MrSID**
MrSID is a file format developed by LizardTech that reduces the size of large, high-resolution images to a fraction of their original size while maintaining the original image quality and integrity.

**N**

**NAD**
North American Datum.

**Network**
Two or more interconnected computer systems for implementation of specific functions or a set of interconnected graphic lines defining some spatial features.

**Node**
The point or intersection at which areas or lines are joined; endpoints of an arc.

**NSDI**
National Spatial Data Infrastructure.
**OS**
Operating System.

**Orthophoto**
A modified copy of a perspective photograph of the earth’s surface with distortions due to tilt and relief removed.

**Overlay**
A set of graphical data that can be superimposed on another set of graphical data through registration to a common co-ordinate system. The process of laying one set of digital spatial data over another for analysis purposes.

**Page Anchor**
The location on the page where the map anchor is placed.

**Page Extent**
Defines a rectangular portion of the graphics page to be displayed.

**Page Size**
The size of the drawing page.

**Parameters**
Variable options or choices; boundaries of operations or of an object.

**Path**
A line/vector/arc defined by a series of points (a string of X,Y co-ordinates).

**PDF**
Portable Document Format. Developed by Adobe Systems Inc., a PDF is a file type, which can be used to cross Macintosh, Windows, DOS, and UNIX platforms.

**Pixel**
The smallest unit of information in a grid cell map or raster image.

**PMS**
Pantone™ Matching System.

**Point**
A discrete location represented by a symbol or label; usually too small to be displayed as an area or line.

**Polygon**
Any area bounded by a straight or irregular closed line representing a map component or any other graphic feature.

**Polyline**
A line made up of a sequence of line segments.

**Positional**
Accuracy The degree to which a position is measured or depicted, relative to its correct position as established by either other features or by other accurate processes.

**Postscript**
A page description language built into many desktop printers and virtually all high-end printing systems.

**PPC**
Power PC (e.g., Macintosh PowerPC processor).
**Precision**
That which relates to the exactness of the operation by which the result is obtained. The exactness with which a value is expressed, whether the value be right or wrong.

**Projection**
The representation on a plane surface of any part of the surface of the earth. Also see Map Projection.

**R**

**Raster**
A method for the storage, processing and display of spatial data. Each given area is divided into rows and columns, which form a regular grid structure. Each cell must be rectangular in shape, although not necessarily square. Each cell within this matrix contains an attribute value as well as location co-ordinates. The spatial location of each cell is implicitly contained within the ordering of the matrix, unlike a vector structure which stores topology explicitly. Areas containing the same attribute value are recognised as such, however, raster structures cannot identify the boundaries of such areas as polygons. Also raster structures may lead to increased storage in certain situations, since they store each cell in the matrix regardless of whether it is a feature or simply ‘empty’ space.

**Record**
A set of attributes relating to any entity; a set of related, contiguous data.

**Redundancy**
The duplication of data in a database.

**Remote Sensing**
The technique of obtaining data about the environment and the surface of the earth from a distance, for example, from aircraft or satellite.

**Render**
To cause to be or to become, to draw.

**Resolution**
The number of dots per inch displayed on screen or printed to an output device.

**Rhumb line**
A line on the surface of the Earth cutting all meridians at the same angle. A rhumb line shows true direction. Parallels and meridians, which also maintain constant true directions, may be considered special cases of the rhumb line. A rhumb line is a straight line on a Mercator projection. A straight rhumb line does not show the shortest distance between points unless the points are on the Equator or on the same meridian.

**RS**
Remote Sensing.

**Rubber sheeting**
A procedure to adjust the co-ordinates all of the data points in a dataset to allow a more accurate match between known locations and a few data points within the dataset. Rubber sheeting, also known as rubber banding, preserves the interconnectivity or topology, between points and objects through stretching, shrinking or re-orienting their interconnecting lines.

**S**

**Scale**
The relation between the size of an object on a map and its size in the real world.
Scanner
A device for converting images from maps or photographs of part of the real world into digital form automatically.

SDTS
Spatial Data Transfer Standard - a standardized format used by the USGS for transferring earth-referenced spatial data between dissimilar computer systems that includes support for the inclusion of spatial data, attribute, geo-referencing, data quality report, data dictionary, and other supporting meta-data within a single file transfer format.

SEA
Self-Extracting Archive, a file compression format for reducing the size of large files for archival or transfers.

Shapefile
The shape file format is a public format that is the native file format for ESRI’s ArcView product. This format can be used to export data with attributes from both ArcInfo and ArcView. From ArcInfo the command at the ARC level to create a shape file is arcshape

Sliver
A gap formed when two lines, which should be contiguous, are slightly separated in a graphical representation or map.

Spaghetti Data
Vector data composed of line segments which are not topologically structured or organised into objects and which may not even be geometrically clean. Spaghetti data can be useful however, if all that is required is a visual image or plot of a map and no spatial analysis is to be performed.

Spatial
Of space, a two or three-dimensional position in space.

Spatial Data
Any information about the location and shape of, and relationships among, geographic features. This includes remotely sensed data as well as map data.

Sphere Co-ordinates
X,Y locations on the ellipsoidal earth, usually expressed in degrees and minutes.

Spline
A function in MAPublisher that improves the smoothness of curved lines, drops redundant points from paths (lines, arcs) and changes the anchor points on paths to direction points for further manual modifications.

SPOT
An earth resource satellite with high-resolution sensors launched by France in January 1986.

Static Graphic Files
Unchanging and uneditable graphic files.

T

Thematic Map
A map displaying selected kinds of information relating to specific themes, such as soil, land-use etc.

Theme
A user-defined perspective on a geographic dataset specified, if applicable, by a name and feature class or dataset name, attributes of interest, or data classification scheme.
Thiessen Polygon
A polygon bounding the region closer to a point than to any adjacent point. The polygons are drawn so that the lines are of equal distance between two adjacent points. Thiessen polygons, also known as Voronoi diagrams and Dirichlet tessellations, are sometimes used as a crude form of interpolation, particularly within the geosciences.

Thinning
Reducing the number of points defining a line while preserving the essential shape of the line. Common weeding algorithms include: distance traversed algorithm, Nth point selection algorithm, angle selection algorithm, William’s point relaxation algorithm and Douglas-Peucker algorithm.

TIFF
Tagged Image File Format, a common raster graphic file format.

Tile
A discrete part of the earth’s surface. By splitting a study area into tiles, considerable savings in access times and improvements in system performance can be achieved.

Topographic map
A map showing natural and man-made features as well as relief, often in the form of contours.

Topography
The study of the relief of a given area on the Earth’s surface, usually on a large scale, including both natural and man-made features.

Topology
The way in which geographic features relate to each other.

Toponym
The place names of a region or map feature.

Transform
The process of changing the scale, projection, or orientation of a mapped image.

TRIM
A GIS data file format from the Terrain Resource Information Management of the Province of British Columbia, Canada.

U

Ungenerate
The file format created by the ArcInfo Ungenerate function.

UNIX
A general-purpose, multi-user computer operating system.

URL
Universal Resource Locator or Internet address.

USGS
United States Geological Survey.

UTM
Universal Transverse Mercator, a common map projection.

UTM Grid
A grid system based upon the Transverse Mercator projection. The UTM grid extends North-South from 80°N to 80°S latitude and, starting at the 180° Meridian, is divided eastwards into 60, 6 degree zones with a half degree overlap with zone one beginning at 180 degrees longitude. The UTM grid is used for topographic maps and georeferencing satellite images.
Vector
Linework or artwork. One method of data type, used to store spatial data. Vector data is comprised of lines or arcs, defined by beginning and end points, which meet at nodes. The locations of these nodes and the topological structure are usually stored explicitly. Features are defined by their boundaries only and curved lines are represented as a series of connecting arcs. Vector storage involves the storage of explicit topology, which raises overheads, however it only stores those points which define a feature and all space outside these features is ‘non-existent’.

Vector Data
An abstraction of the real world where positional data is represented in the form of co-ordinates. In vector data, the basic units of spatial information are points, lines and polygons. Each of these units is composed simply as a series of one or more co-ordinate points, for example, a line is a collection of related points, and a polygon is a collection of related lines.

Vertex
One of a set of ordered X,Y co-ordinates that constitute a line. A points representing spatial X,Y co-ordinates that occur along an arc between the nodes and help define the shape of the arc.

VPF
Vector Product Format. A binary format used by the US Defense Mapping Agency. It is well documented and can be sued as an internal format and as a transfer format. It carries geographic and attribute information but no display data. VPF files are sometimes referred to as VMAP products. MAPublisher 5.0 does not support VPF files.

World file
A file associated with an image that contains geo-referencing information for the image. File extensions may be TFW or JPW (tiff, jpeg World Files), IRP (Image Report Files) or TAB (Table files).

WWW
World Wide Web.

Xtra
A program module the extends the capabilities of Macromedia FreeHand such as MAPublisher.

Zone
Any well-defined region of more or less belt-like form.

Zoom
To magnify or reduce the current view of a document.
INDEX

A

Add Map Parameters 13, 64, 71, 72, 77, 78, A1-25, A1-27
Add to Selection 40, 42
Albers Equal Area Projection 51
Anchors
  Map (see Map Anchors)
  Page (see Page Anchors)
Angle 20-22, 27, 55, 56
Arcs 13, 80-82
  Joining (see Join Arcs)
  Labeling (see Labeling)
  Simplifying (see Simplify Arcs)
  Export Format 13, 15, 25, 93, A1-2 - A1-4
ArcView 13, 15, 93, A1-3, A1-4
ASCII 16, 27-29, 83
  Comma Delimited Files 27-29, 83
  Creating 29
  Importing 28, 83
Area A1-11, A6-1
Area Defaults (see Assign Area Defaults)
Area Tools 14, 91
Assign
  Legend Info 13, 57-63, A1-24
  Point Defaults 13, 63, 77-79, A1-26, A1-27
Atlas A1-4
Attributes 13, 24, 27, 29-42, A1-10, A1-11, A6-2 (see also Map Attributes)
  Corruption A1-10
  Editing 36-39
  Selecting by 13, 40-42
  Stripping A1-9
  Viewing 13, 35, 36

  DXF Format (see DXF Format)

B

Basic Import 21

C

Calculate 45, 46, 70-73
Cell Size 70-72
Central Meridian 49-52
Changing
  Anchors 55, 56
  Angle 55, 56
  Projection 51
  Scale 55, 56
  Units 55, 56
Colour Mode 46
Columns 13, 37
  Attribute 13, 37
  Creating 37, 89
  Deleting 38, 89
  Editing 38, 39, 89
  Table 13, 89
Contents v
Copy
  Map Objects 13, 92
  Projection 53
Create
  Attribute Columns 37
  a Comma-delimited ASCII File 29
  an Index 70, 74-76
  Labels (see Labeling)
  a North Arrow 64
  a Scalebar 65, 66
  a Table 13, 85
  Table Columns 89

153
D

Data 19, A1-10, A1-17 - A1-19, A3-1
DBase files 83
DDF File (see SDTS Format)
Decompression 15, 18, A1-20, A1-21, A4-1
  e00 format 15
  Utilities A1-20, A1-21, A4-1
Defaults
  Assign Area/Line/Point/Text (see Assign Defaults)
  Button 20-22, 50, 51
Delete
  Attribute Column 38
  a Table 13, 85
  Table Column 89
Digital Line Graph (see DLG)
DLG Format 15, 17, 18, 26, A1-3, A1-4
DOQ File A1-1
DRG File A1-1
Document Set Up 12
Douglas-Peucker 81, A1-28, A6-3
Draw Legend Layer 13, 58-63

E

e00 Format 15, 25, 93, A1-2 - A1-4
Edit
  Map Column 13, 38, 39
Ellipsoid 19, 49
Enter Security Code 10-11, 13
EPS A1-1, A6-4
Existing Layer (see Import to Existing Layer)
  Formats 13, A1-4
  Image 13, 46-48

F

Feature Text Label 13, 67, 68, 74

G

Geomedia A1-4
GIF A1-1
Grain 26, 81, A1-8, A6-5
Grid Generator 13, 70-75

I

Images 43-48
Import 13, 18, 20-29, A1-6 - A1-8
  to Existing Layer 24
  Xtra 13, 20
  with Grain 26
  Map 13, 20-26
  to Match Layer 24
  Multiple Files 22
  Points 13, 27-29, 63, A1-8
  Single File 21
  Table 13, 83, 84
Index 70-72, 74-76
  Creating 70, 74-76
  Make 13, 70, 74-76
Initial Selection 40, 41
Installation 10, 11, A1-5
Intergraph A1-4
IRP File 43

J

JFW 43
Join
  Arcs 13, 80, A6-6
  Table 86, 87, A1-10
JPEG A1-1, A6-6

L

Labeling 67-69, 75, 93, A1-9
  Feature Text Label 13, 67, 68
  Map Tagger Tool (see Map Tagger Tool)
Layer 23, A1-12, A1-13, A6-6
  Naming 23
Assign Legend Info (see Assign Legend Info)
Auto Assign Legend Info (see Auto Assign Legend Info)
Draw Legend Layer (see Draw Legend Layer)
Matching Features 13, 64
Point 27, 63
Template A1-29
Linear Match 86
LGO File 43
Line Defaults (see Assign Line Defaults)
Location Tool (see Map Location Tool)

M

Maintenance Program A1-23
Make Index 13, 70, 74-76
Map Anchors 20-23, 26-28, 55, 56, 77, A6-7
    Changing 55, 56
Map Area Tools 14, 91
Map Copy/Paste Objects 13, 92
Map Attributes 13, 27, 29-42
    Editing 36-39
    Selecting by 40-42
    Viewing 13, 35, 36
Map Columns 13, 23, 24, 37-39
    Exporting to 13, 93

Map Location Tool 14, 34, 71
Map Parameters (see Add Map Parameters)
MAPublisher Maintenance Program A1-23
Match
    Layer (see Import to Match Layer)
    Legend Features 64
    Linear (see Liner Match)
    Ordered (see Ordered Match)
Memory 9, A1-6, A1-15, A1-16
Meridian (see Central Meridian)
MicroStation 15, 16, 17, A1-3, A1-4
MID/MIF (see MapInfo Interchange Format)
MPTables 84-85
MrSID Viewer A4-1, A6-7
Multiple File Import (see Import Multiple Files)

N

Nodes 81, 82, A1-8
North Arrow 13, 64

O

Ordered Match 86
Optional Format (see USGS)

P

Page Anchors 20-22, 27, 55-56, A6-8
Parallel 19, 49
Parameters (see Add Map Parameters)
Paste Map Objects 14, 92
PDF A1-2, A6-8
Placing Images 45, 46
Point Defaults (see Assign Point Defaults)
Point Legends 63
Point Plot 13, 30-33
Points 27-33, 49, A1-8, A1-12
    Importing (see Import Points)
    Legend 63
    Plotting (see Point Plot)
    Repositioning 33
    Copying 53
    Editor 13, 49-53
    Storing 52

R

Reference Info Files 43, 44, 46
Register Image 13, 43-45
Remove from Selection 13, 43-45
Robinson Projection 51

S

Same as 20, 24
    Bar 13, 65, 66
    Conversion 13, 54
    Transform 13, 55, 56
Select
   by Attribute  13, 40-42
   from Selection  40-42
   Table Records  13, 88
Selection
   Add to  40, 42
   Initial  40, 41
   Remove from  40, 42
   Select from  40, 42
SelStats  13, 41, 42, 79, A1-9
Simplify Arcs  13, 81-82
Single File Import  21
Sort  35, 61
Spatial Data Transfer Standard (see SDTS)
System Requirements  9

T

Table  13, 83-90, A1-10, A1-28
   Columns  13, 89
   Create  13, 85
   Delete  13, 85
   Export  A1-28
   Import  13, 83, 84
   Join  13, 86, 87, A1-10
   Records  13, 88, 90
Tagger Tool (see Map Tagger Tool)
Text  A1-24
   Defaults (see Assign Text Defaults)
TAB File  43
TFW File  43, 44, 46, A6-12
TIF File  43-46, A1-2, A6-11
TIGER  A1-4, A1-17
TransCAD  A1-4
Transform Scale  13, 55, 56, A1-29

U

Ungenerate File  15, A1-2, A6-11
Unique Occurrences Legend  59-62
Units  20, 21, 43, 49, 54, 55, 65, 70, 77, 80, 81
Universal Transverse Mercator (see UTM)